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Chapter 1 Frontline Hardware & Software

Frontline Test Equipment family of protocol analyzers work with the following technologies.
« Classic Bluetooth

e Bluetooth low energy

o Dual Mode Bluetooth (simultaneous Classic and low energy)

o Bluetooth Coexistence: Bluetooth with 802.11 Wi-Fi

« Bluetooth HCI (USB, SD, High Speed UART)

e« NFC

o 802.11 (Wi-Fi)

« SD

o HSU (High Speed UART)

The Frontline hardware interfaces with your computer that is running our robust software engine called the
ComProbe Protocol Analysis System or Frontline software. Whether you are sniffing the air or connecting directly
to the chip Frontline analyzers use the same powerful Frontline software to help you test, troubleshoot, and
debug communications faster.

Frontline software is an easy to use and powerful protocol analysis platform. Simply use the appropriate Frontline
hardware or write your own proprietary code to pump communication streams directly into the Frontline
software where they are decoded, decrypted, and analyzed. Within the Frontline software you see packets,
frames, events, coexistence, binary, hex, radix, statistics, errors, and much more.

This manual is a user guide that takes you from connecting and setting up the hardware through all of the
Frontline software functions for your Frontline hardware. Should you have any questions contact the Frontline
Technical Support Team.

Frontline 802.11 Hardware & Software User Manual 1
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1.1 What is in this manual

The Frontline User Manual comprises the following seven chapters. The chapters are organized in the sequence
you would normally follow to capture and analyze data: set up, configure, capture, analyze, save. You can read
them from beginning to end to gain a complete understanding of how to use the Frontline hardware and software
or you can skip around if you only need a refresher on a particular topic. Use the Contents, Index, and Glossary to
find the location of particular topics.

« Chapter 1 Frontline Hardware and Software. This chapter will describe the minimum computer
requirements and how to install the software.

o Chapter 2 Getting Started. Here we describe how to set up and connect the hardware, and how to apply
power. This chapter also describes how to start the Frontline software in Data Capture Methods. You will be
introduced to the Control window that is the primary operating dialog in the Frontline software.

« Chapter 3 Configuration Settings. The software and hardware is configured to capture data. Configuration
settings may vary for a particular Frontline analyzer depending on the technology and network being sniffed.
There are topics on configuring protocol decoders used to disassemble packets into frames and events.

« Chapter 4 Capturing and Analyzing Data. This Chapter describes how to start a capture session and how to
observe the captured packets, frames, layers and events.

o Chapter 5 Navigating and Searching the Data. Here you will find how to move through the data and how to
isolate the data to specific events, often used for troubleshooting device design problems.

« Chapter 6 Saving and Importing Data. When a live capture is completed you may want to save the captured
data for future analysis, or you may want to import a captured data set from another developer or for use in
interoperability testing. This chapter will explain how to do this for various data file formats.

« Chapter 7 General Information. This chapter provides advanced system set up and configuration information,
timestamping information, and general reference information such as ASCII, baudot, and EBCDIC codes. This
chapter also provides information on how to contact Frontline's Technical Support team should you need
assistance.

1.2 Computer Minimum System Requirements
Frontline supports the following computer systems configurations:
o Operating System: Windows 7/8/10
o USB Port: USB 2.0 High-Speed or or later
The Frontline software must operate on a computer with the following minimum characteristics.
e Processor: Core i5 processor at 2.7 GHz
« RAM: 4 GB

o Free Hard Disk Space on C: drive: 20 GB
1.3 Software Installation

Download the installation software from FTE.com. Once downloaded, double-click the installer and follow the
directions.

Use this link: http://www.fte.com/80211-soft.

2 Frontline 802.11 Hardware & Software User Manual
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Chapter 2 Getting Started

In this chapter we introduce you to the Frontline hardware and show how to start the Frontline analyzer software
and explain the basic software controls and features for conducting the protocol analysis.

2.1 802.11 Hardware
2.1.1 Attaching Antennas

When you remove the Frontline 802.11 from the box, the first step is to attach the antennas (Figure 2.1).

© savenaee :B D 2 -1 .I

B802.11 a/b/g/n PrRoToOcOL ANALYZER

Figure 2.1 - Front Panel

1. Attach an antenna to each front panel connector.
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Figure 2.2 - Frontline 802.11 with both antennas attached

2.1.2 Connecting/Powering the Frontline 802.11

Once you have attached the antennas, the next step is to power up and connect the Frontline 802.11 to the
computer.

1. Insertthe power cable (DC connector) from the 12 volt AC adapter into the Power port on the Frontline
802.11 back panel (Figure 2.3).

Qe 8O 2.1 1

BOZ.11 &/b/Q'N PROTOCOL AMALYIER

F‘l-:.lbum

Figure 2.3 - Back Panel - Power
2. Plugthe 12 volt AC adapter into the AC power source. The front panel Power light illuminate (Figure 2.1).

3. Insert the USB cable into the USB port on the Frontline 802.11 back panel (Figure 2.4).

4 Frontline 802.11 Hardware & Software User Manual
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Cuee 8O 2.1 1

BOZ.11 &/b/4/n ProTocow AMALYIER

Prot x

Figure 2.4 - Back Panel - USB

4. Insertthe other end of the USB cable into the PC.

5. It may take as long as thirty seconds for Windows to recognize that the Frontline 802.11 hardware is
connected to the PC. The Activity light on the Frontline 802.11 front panel (Figure 2.1 will blink during this
period, when the light is steady, the Frontline 802.11 hardware is ready to communicate with the

Frontline software.

2.1.3 Setting Up for ProbeSync™

The Frontline 802.11 hardware has ProbeSync™ which allows for synchronization of Frontline hardware clocks
and timestamping. One Frontline device will act as the master device by providing the clock to the slave device
receiving the clock. Do not confuse "master" and "slave" with the Bluetooth device master and slave relationships.

Refer to the following tables.
Table 2.1 - 802.114 Synced to 802.11,

802.11, | 802.11,
OUT[IN [OUT[IN

Master | Slave | X X

802.11,| 802.11,

Slave | Master X | X

Table 2.2 - BPA 600 Synced to
802.11
BPA 600| 802.11

OUT| IN |OUT|IN
Master | Slave | X X

BPA 600| 802.11

Note: The Frontline BPA 600 device must always be the master node in ProbeSync mode.

Table 2.3 - HSU Synced to 802.11

802.11 [ HSU
R = OUT/|IN |OUT/|IN
Master | Slave | X X

Frontline 802.11 Hardware & Software User Manual
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Note: The Frontline HSU device must always be the slave node in ProbeSync mode, must
always be the last device in the ProbeSync daisy-chain configuration.

ProbeSync allows a Frontline Sodera and a 802.11 hardware to be connected together to run off of acommon
clock, ensuring precise timestamp synchronization while capturing multiple wireless technologies such as
Bluetooth and 802.11. One device will act as the master device by providing the clock to the slave device

receiving the clock. The devices are connected in a daisy-chain configuration. Refer to the following table, to Rear
Panel Connectors, on page 1, and to Connecting/Powering the Frontline 802.11 on page 4.

Table 2.4 - Sodera Synced to 802.11

Sodera 802.11
Sodera|802.11 5 R OBESYNC OUT|PROBESYNG INJOUT|IN
Master | Slave X X

1. Usinga CATS5 Ethernet cable (less than 1.5 meters (4.9 feet)) insert one end to the master Frontline device
OUT jack.

2. Insertthe other end of the cable into the slave Frontline device IN jack.

TRIGGER USB AUX POWER

802.11 a/b/g/n PRoTOCOL ANALYZER

DIGITAL I/0 usB

Probe I

SLAVE

Figure 2.5 - Back Panel - ProbeSync with BPA 600
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2.2 Data Capture Methods

TELEDYNE LECROY

This section describes how to load TELEDYNE LECROY Frontline Protocol Analysis System software, and how to

select the data capture method for your specific application.

2.2.1 Opening Data Capture Method

On product installation, the installer creates a folder on the windows desktop labeled "Frontline <version #>".

1. Double-click the " Frontline <version #>" desktop folder

This opens a standard Windows file folder window.

, » Frontline ComProbe Protocol Analysis Systern 12.11.662.0 »

- Include in library - Share with = Burn
ites it Name .
sktop = ., Development Tools
wnloads . Documentation

cent Places , Maintenance Tools

ogle Drive [2# Capture File Viewer

@ ComProbe 80211 with Wireshark
Ires @ Frontline ComProbe Protocol Analysis System

cuments

Ay NMocuments

Figure 2.6 - Desktop Folder Link

Select to open
Capture Methods

2. Double-click on Frontline ComProbe Protocol Analysis System and the system displays the Select Data

Capture Method... dialog.

Note: You can also access this dialog by selecting Start > All Programs > Frontline

(Version #) > Frontline ComProbe Protocol Analysis System

Frontline 802.11 Hardware & Software User Manual
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Select Data Capture Method.... PS
=53 Blustooth Air Sniffing Fequires one ComProbe BPA B00 hardware.
0 BIueth.th [Blassiedoulereay[BRAIEN0] Used for typical applications to capture combined Bluetooth Classic and
BB \{lrtual Sniffing low energy data.
{:’ CPAS Side

&3 IEEE11073+

Connected Devices

L~ j
( [ Run ] [ Cancel ] [ Help ] Create Shortcut When Fun

Figure 2.7 - Example: Select Data Capture Method..., BPA 600

Three buttons appear at the bottom of the dialog; Run, Cancel, and Help.

Select Data Capture Method dialog buttons
Button Description

Fun Becomes active when a capture method is selected. Starts the selected capture method.

Cancel Closes the dialog and exits the user back to the computer desktop.

Opens Frontline Help. Keyboard shortcut: F1.

Help

3. Expand the folder and select the data capture method that matches your configuration.

4. Click on the Run button and the Frontline Control Window will open configured to the selected capture
method.

Note: If you don't need to identify a capture method, then click the Run button to start the
analyzer.

Creating a Shortcut

A checkbox labeled Create Shortcut When Run is located near the bottom
[ Create Shortcut “When Fun of the dialog. This box is un-checked by default. Select this checkbox, and the

8 Frontline 802.11 Hardware & Software User Manual
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system creates a shortcut for the selected method, and places it in the "Frontline ComProbe Protocol Analysis
System <version#>" desktop folder and in the start menu when you click the Run button. This function allows you
the option to create a shortcut icon that can be placed on the desktop. In the future, simply double-click the
shortcut to start the analyzer in the associated protocol.

Supporting Documentation

The Frontline <version #>directory contains supporting documentation for development (Automation,
DecoderScript™, application notes), user documentation (Quick Start Guides and the Frontline User Manual), and
maintenance tools.

2.2.2 Frontline® 802.11 Data Capture Method

Select Data Capture Method.... by

= £3 80211 Ai Sniffing 80211 A Srifing.
O sen

=23 Virtual Sniffing
€ FTS Side
& IEEE11073+

Connected Devices

« 802.11
o Requires one Frontline 802.11 hardware.

o Captures 802.11 data on the selected channel.

Frontline 802.11 Hardware & Software User Manual
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e 802.11 Double

o Requires two Frontline 802.11 hardware with ProbeSync™.

=>802.11

o 802.11 Triple

o Requires three Frontline 802.11 hardware with ProbeSync™.

e 802.11 with USB

o Requires one Frontline 802.11 and one Frontline USB hardware.

e 802.11 with USB and SD

o Requires one Frontline 802.11, one Frontline USB, and one Frontline SD hardware.

2.2.3 Virtual Sniffing

The Virtual Sniffer is a live import facility within Frontline® software that makes it possible to access any layer in a
stack that the programmer has access to and feed this data into the Virtual Sniffer. Please refer to the “Show Live
Import Information” button on the Virtual Sniffer Datasource window in Frontline software. More information is
available in the Live Import Developer's Kit located in the Development Tools folder in Frontline Protocol Analysis
System desktop folder, and a white paper is available at Bluetooth Virtual Sniffing

o FTS Side
o No hardware required.

o Frontline software acquires data via user-developed software.

o |EEE 11073+

o No hardware required

o for sniffing data virtually from the continua Enabling Software Library (CESL) IEEE 11073 tester.
2.3 Control Window

The analyzer displays information in multiple windows, with each window presenting a different type of
information. The Control window opens when the Run button is clicked in the Select Data Capture Method
window. The Control window provides access to each Frontline analyzer functions and settings as well as a brief
overview of the data in the capture file. Each icon on the toolbar represents a different data analysis function.

10 Frontline 802.11 Hardware & Software User Manual
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&3 ComProbe Protocol Analysis System - 802.11 EI = IEI
File View Live Options Window Help

e i dY PN B /e

Configuration: <Mo Device'’>

Capture file: C:\Users\Public\Documents\Fronting Test EquipmentiMy Capture Files\Capture-20 13-05-23_075126.cfa
Capture Status: Paused (Capture to Single File) <1% used Packets o hjw: 0

For Help Press F1 Packet Decoder (0 pps) #) - 100%

Figure 2.8 - Control Window
Because the Control window can get lost behind other windows, every window has a Home icon @ that brings
the Control window back to the front. Just click on the Home icon to restore the Control window.

When running the Capture File Viewer, the Control window toolbar and menus contain only those selections
needed to open a capture file and display the About box. Once a capture file is opened, the analyzer limits Control
window functions to those that are useful for analyzing data contained in the current file. Because you cannot
capture data while using Capture File Viewer, data capture functions are unavailable. For example, when
viewing Ethernet data, the Signal Display is not available. The title bar of the Control window displays the name of

the currently open file. The status line (below the toolbar) shows the configuration settings that were in use when
the capture file was created.

2.3.1 Control Window Toolbar

Toolbar icon displays vary according to operating mode and/or data displayed. Available icons appear in color,
while unavailable icons are not visible. Grayed-out icons are available for the Frontline hardware and software
configuration in use but are not active until certain operating conditions occur. All toolbar icons have
corresponding menu bar items or options.

Table 2.5 - Control Window Toolbar Icons
Icon Description

Open File - Opens a capture file.

I/0 Settings - Opens settings

Start Capture - Begins data capture to disk

Stop Capture - Available after data capture has started. Click to stop data capture. Data can
be reviewed and saved, but no new data can be captured.

Il = o) & L

Save - Saves the capture file.

"y
M

Clear - Clears or saves the capture file.

}) Event Display - (framed data only) Opens a Event Display, with the currently selected bytes
highlighted.

Frontline 802.11 Hardware & Software User Manual 11
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Table 2.5 - Control Window Toolbar Icons (continued)
Icon Description

@ Frame Display - (framed data only) Opens a Frame Display, with the frame of the currently
selected bytes highlighted.

G Notes - Opens the Notes dialog.

% Cascade - Arranges windows in a cascaded display.

Coexistence View - Opens the Coexistence View dialog.

@® | Wi-Fi Error Statistics - Opens the Wi-Fi Error Statistics dialog.

2.3.2 Configuration Information on the Control Window

The Configuration bar (just below the toolbar) displays the hardware configuration and may include 1/O settings. It
also provides such things as name of the network card, address information, ports in use, etc.

ICDnFiguratiDn: Displays hardware configuration, network cards, address information. ports in use, etc. I

2.3.3 Status Information on the Control Window

The Status bar located just below the Configuration bar on the Control window provides a quick look at current
activity in the analyzer.

Capkure Status: | @ Mok Active (Capture Eo Single File) Mf&  used Utilization: 0% Host | 0% Control | Events: O

o Capture Status displays Not Active, Paused or Running and refers to the state of data capture.
o Not Active means that the analyzer is not currently capturing data.
o Paused means that data capture has been suspended.
o Running means that the analyzer is actively capturing data.

e % Used

The next item shows how much of the buffer or capture file has been filled. For example, if you are
capturing to disk and have specified a 200 Kb capture file, the bar graph tells you how much of the capture
file has been used. When the graph reaches 100%, capture either stops or the file begins to overwrite the
oldest data, depending on the choices you made in the System Settings.

« Utilization/Events

The second half of the status bar gives the current utilization and total number of events seen on the
network. This is the total number of events monitored, not the total number of events captured. The

12 Frontline 802.11 Hardware & Software User Manual
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analyzer is always monitoring the circuit, even when data is not actively being captured. These graphs
allow you to keep an eye on what is happening on the circuit, without requiring you to capture data.

2.3.4 Frame Information on the Control Window

Frame Decoder information is located just below the Status bar on the Control window. It displays two pieces of
information.

IFn:nr Help Press F1 Frame Decoder (233 Fps)  BEaleEERn B Tnks

« Frame Decoder (233 fps) displays the number of frames per second being decoded. You can toggle this
display on/off with Ctrl-D, but it is available only during a live capture.

o #132911 displays the total frames decoded.

o 100% displays the percentage of buffer space used.

2.3.5 Control Window Menus

The menus appearing on the Control window vary depending on whether the data is being captured live or
whether you are looking at a .cfa file. The following tables describe each menu.

Table 2.6 - Control Window File Menu Selections

Mode Selection I;Ot Description
ey
Live Close Closes Live mode.
Capture | Go Live Returns to Live mode
File
Reframe If you need to change the protocol stack used to interpret a
capture file and the framing is different in the new stack, you
need to reframe in order for the protocol decode to be correct. See
Reframing on page 60
Unframe Removes start-of-frame and end-of-frame markers from your
data. SeeUnframing on page 60
Recreate This option is available when you are working with decoders. If
Companion File you change a decoder while working with data, you can recreate
the ".frm file", the companion file to the ".cfa file". Recreating the
"frm file" helps ensure that the decoders will work properly.
Reload Decoders The plug-ins are reset and received frames are decoded again.

Frontline 802.11 Hardware & Software User Manual 13
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Table 2.6 - Control Window File Menu Selections (continued)

Protocol Analysis
System

Mode Selection nfe Description
Key
Live & Open Capture File | Ctrl- | Opens a Windows Open file dialog. at the default location
Capture -0 "...\Public Documents\Frontline Test Equipment\My Capture
File Files\". Capture files have a .cfa extension.
Save Ctrl- | Saves the current capture or capture file. Opens a Windows
S Save As dialog at the default location "...\Public
Documents\Frontline Test Equipment\My Capture Files\".
Exit ComProbe Shuts down the ComProbe Protocol Analysis System and all

open system windows.

Recent capture files

A list of recently opened capture files will appear.

The View menu selections will vary depending on the Frontline analyzer in use.

Table 2.7 - Control Window View Menu Selections

Mode Selection Hot key Description
Live & Event Display Ctrl- Opens the Event Display window for analyzing byte level
Capture Shift-E | data.
File
Frame Display Ctrl- Opens the Frame Display window for analyzing protocol level
Shift-M | data
Statistics Ctrl- Opens the Statistics Window that shows information about
Shift-S | packet throughput.

Coexistence View Opens the Coexistence View window that can
simultaneously display Classic Bluetooth, Bluetooth low
energy, and 802.11 packets and thourghput.

Wi-Fi Error Opens the Wi-Fi Error Statistics window that displays the

Statistics number of packet errors.

Table 2.8 - Control Window Edit Menu Selections
Mode Selection alcls Description
key
Capture | Notes Ctrl- Opens the Notes window that allows the user to add
File Shift-O | comments to a capture file.

The Live menu selections will vary depending on the Frontline analyzer in use.

14
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Table 2.9 - Control Window Live Menu Selections

Mode | Selection

| Hot-Key|

Description

The following two rows apply to all Frontline products except Set in Target.

Live Start Capture

Shift-F5

Begins data capture from the configured wireless devices.

Stop Capture

F10

Stops data capture from the configured wireless devices.

The following rows apply to all Frontline prod

ucts

Live Clear

Shift-
F10

Clears or saves the capture file.

Frontline 802.11 Hardware & Software User Manual
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Table 2.9 - Control Window Live Menu Selections (continued)

Mode Selection Hot-Key Description
Live & Hardware Settings 0 - Classic
Capture ’ hl
File 1 - Bluetooth low energy

1/0 Settings

0 - Classic

1 - Bluetooth low energy

System Settings Alt- Opens the System Settings dialog for configuring capture
Enter files.
Directories... Opens the File Locations dialog where the user can change
the default file locations.
Check for New When this selection is enabled, the program automatically

Releases at Startup

checks for the latest Frontline protocol analyzer software
releases.

Side Names...

Opens the Side Names dialog used to customize the names
of the slave and master wireless devices.

Protocol Stack...

Opens the Select a Stack dialog where the user defines the
protocol stack they want the analyzer to use when decoding
frames.

Set Initial Decoder
Parameters...

Opens the Set Initial Decoder Parameters window. There
may be times when the context for decoding a frame is
missing. For example, if the analyzer captured a response
frame, but did not capture the command frame, then the
decode for the response may be incomplete. The Set Initial
Decoder Parameters dialog provides a means to supply the
context for any frame. The system allows the user to define
any number of parameters and save them in templates for
later use.Each entry in the window takes effect from the
beginning of the capture onward or until redefined in the Set
Subsequent Decoder Parameters dialog. This selection is not
present if no decoder is loaded that supports this feature.

Set Subsequent
Decoder
Parameters...

Opens the Set Subsequent Decoder Parameters dialog
where the user can override an existing parameter at any
frame in the capture. Each entry takes effect from the
specified frame onward or until redefined in this dialog on a
later frame. This selection is not present if no decoder is
loaded that supports this feature.

Automatically
Request Missing
Decoder
Information

When checked, this selection opens a dialog that asking for
missing frame information. When unchecked, the analyzer
decodes each frame until it cannot go further and it stops
decoding. This selection is not present if no decoder is loaded
that supports this feature.

16

Frontline 802.11 Hardware & Software User Manual




Chapter 2 Getting Started

TELEDYNE LECROY

Table 2.9 - Control Window Live Menu Selections (continued)

Mode Selection Hot-Key Description
Enable/Disable When enabled, the Audio Expert System is active, other wise
Audio Expert it is not available. Only available when an Audio Expert
System System licensed device is connected.

The Windows menu selection applies only to the Control window and open analysis windows: Frame Display,
Event Display, Message Sequence Chart, Bluetooth Timeline, Bluetooth low energy Timeline, and
Coexistence View. All other windows, such as the datasource, are not affected by these selections.

Table 2.10 - Control Window Windows Menu Selections

Protocol Analysis
System

Mode Selection Hot-Key Description
Live & Cascade Ctrl-W | Arranges open analysis windows in a cascaded view with
Capture window captions visible.
File
Close All Views Closes Open analysis windows.
Minimize Control When checked, minimizing the Control window also
Minimizes All minimizes all open analysis windows.
Frame Display and When these windows are open the menu will display these
Event Display selections. Clicking on the selection will bring that window to
the front.
Table 2.11 - Control Window Help Menu Selections
Mode Selection Hot-Key Description
Live & Help Topics Opens the Frontline Help window.
Capture . . . .
File About Frontline Provides a pop-up showing the version and release

information, Frontline contact information, and copyright
information.

Support on the Web

Opens a browser to fte.com technical support page.

2.3.6 Minimizing Windows

Windows can be minimized individually or as a group when the Control window is minimized. To minimize
windows as a group:

1. Go tothe Window menu on the Control @ window.

2. Select Minimize Control Minimizes All. The analyzer puts a check next to the menu item, indicating
that when the Control window is minimized, all windows are minimized.

3. Select the menu item again to deactivate this feature.

4. The windows minimize to the top of the operating system Task Bar.

Frontline 802.11 Hardware & Software User Manual
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Chapter 3 Configuration Settings
In this section the Frontline software is used to configure an analyzer for capturing data .

3.1 802.11 Configuration
3.1.1 Wi-Fi Scanner Hardware Settings

The Hardware Settings dialog provides the ability to select a device to sniff/scan. The dialog only lists devices with
a MAC address that match the Frontline devices. To access the Hardware Settings dialog:

1. Select Hardware Settings from the Options menu on the 802.11 Control window.

Wi-Fi Scanner Hardware Settings = i'

Sniffer:  |CamProbe 802,11 [SH: 0702120052] j Refresh List

ok | Cancel | Help |

Figure 3.1 - Wi-Fi Scanner Hardware Settings Dialog
2. Select a device from the drop-down list.
3. SelectOK

If no devices are found, the list is blank.

Note: Upon launching the Air Sniffer, the first device in the drop-down is the default device.

3.1.2 802.11 I/O Settings - Datasource

1. Selectl/O Settings from the Options menu on the Control window.

Frontline 802.11 Hardware & Software User Manual
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I/O Settings | = |
Seftings lStatus ] Capture Filters ] Firmware Update
ComProbe 802 11 Seral Number 0102120052
Channel | 2412 MHz (1) =] Scanner
Bxtension Channel |0 -
FCS Filter |f-‘d| Frames j
0K | Cancel Help

Figure 3.2 - 802.11 I/O Settings Dialog

There are several things to remember about I/O Settings:

The 1/O Settings are specific to the device selected in the Hardware Settings.

Two 802.11 devices attached to a computer have different settings.

Changing the settings changes the devices’ default settings.

If a parameter is changed (e.g. Channel 1 is changed to 6), the new setting appears the next time the I/O

Settings dialog is opened for the device.

The settings are saved when the OK button is pressed.

3.1.2.1 Settings

20
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I/O Settings | %

Settings l Status ] Capture Filters ] Firnware Update ]

ComProbe 202.11 Seral Number 0102120052

Channel 2412 MHz (1) ] Scanner

BExtension Channel |0 -

FCS Fitter |AII Frames ﬂ

QK Cancel Help

Figure 3.3 - 802.11 I/O Settings Settings Tab

The Settings dialog allows you to change and observe basic configuration values. These include the Channel,
Extension Channel, FCS Filter and Capture Type.

o Channel - Select the channel from the drop-down list. Channels have been extended to the 5Ghz range.
« Extension- allows you to extend the range of channels available

o 0= Standard 1-14 Wi-Fi channels

o -1=Expanded channels below the standard range

o +1 = Expanded channels above the standard range

« FCS Filter - The Frame Check Sequence filter indicates if the device should capture frames with an invalid
FCS. Select All Frames or Valid Frames

Clicking on the Scanner button will open the Wi-Fi Scanner dialog. This action is useful if you do not know the
channel to sniff. Once you have selected a channel in the Wi-Fi Scanner dialog and confirmed your selection the
selected channel will appear in Channel.
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3.1.2.2 Status

/O Settings ﬁ

Seftings  Status | Capture Filters ] Fimmware Update

-

ComProbe 802.11 Senal Mumber 01027120052

Hardware Information: Software Version:

Clack Source: Source FPGA: 2.2

Capture Media Indicator: QK Application: 0.4
Imteface: 1.3

Data Capture Information:

Tatal Packets Captured: Total Bytes Captured:
Packets Bytes

Packets Mot Yet Read by PC: Bytes Mot Yet Read by PC:
Count Bytes

QK | Cancel Help

Figure 3.4 - 802.11 I/O Settings Status Tab

The Status dialog provides current information about the ComProbe device. There are no settings for this dialog.
3.1.2.3 Capture Filters

The Capture Filters dialog allows you create, modify, and delete capture filters. The dialog initially displays the
existing MAC address Capture Filters.

o To activate the capture filters and to be able to create/modify additional filters, you first must select the
Enable MAC Address Capture Filters check box.

« You can select/deselect which filters are active by checking/unchecking the Enable checkbox in the first
column in the table.

« You can also select to ignore Management, Control, Data, and Reserved frame types by selecting one or
more the checkboxes.
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VO Settings
Settings | Status  Caphure Fiters | WiF Diect | Femveare Updats |

[~ Ersbls MAC Address Capburs Fiters

Enable | Mac Address | Mode | Faekds | Add New Address
Bt Address |
Mave Address Up |
Move Address Down |
Framss typiss 1o ignone:;

Ok Canical

Figure 3.5 - 802.11 I/O Settings Capture Filters Tab
To create a key, select one of the following options:

« Add New Address - displays a text box where you can enter the address

Frontline 802.11 Hardware & Software User Manual
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5.

Add MAC Address %

e.g. 0014bf72h3a6

* Indude Field In MAC Frame

" Exdude v Address 1 (Receive)
v Address 2 (Transmit)
v Address 3
V' Address 4

v Implicit Transmit
(e.g. Transmitting an ACK)

0K | Cancel |

Figure 3.6 - 802.11 1/0O Settings Capture Filters Add New Address Dialog
Enter a MAC Address in the text field.
Select the Include radio button to only capture packets with this MAC address.
Select the Exclude radio button to capture packets with other filters, but not ones with this MAC address.
Select one or more check boxes to identify which fields in the MAC Frame to include.

The MAC header for an 802.11 frame can contain up to 4 address fields. Most frames do not have that
many. In general, the first address is the intended receiver and the second address is the device that
transmits the frame. The third and fourth address fields depend on the context of the frame. Some of the
control type frames do not include the transmitter address but they may be determined from previous
frames.

Select OK to close the dialog.

Once you have MAC addresses on the main dialog, you can modify them using four options.

24

« Remove Address - Highlight an address that you want to delete and select Remove Address to remove it
from the list.

« Edit Address - Highlight an address that you want to edit and select Edit to bring up a dialog where you can
edit the address. The address and any of the prior settings may be changes. Click OK to save and close.
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Edit Mac Address |

e.g. 0014bf72b3a6

001a70ddac 7
{* Indude Field In MAC Frame
I~ Exdude ¥ Address 1 (Receive)

[v Address 2 (Transmit)
Iv Address 3
[v Address 4

v Implicit Transmit
(e.qg. Transmitting an ACK)

QK | Cancel

e

Figure 3.7 - 802.11 1/O Settings Capture Filters Edit MAC Address Dialog

« Move Address Up - moves the selected address up in the queue.

« Move Address Down - moves the selected address down in the queue.

3.1.2.4 Firmware Update

To take full advantage of the improvements to the ComProbe 802.11 with ComProbe Protocol Analysis System
you must update the firmware on the ComProbe.

Note: With the release of ComProbe Protocol Analysis System (CPAS) version
15.11.8698.9035 in December 2015, an update to the firmware is required upon installation of
the software. For that version, the full update requires three complete passes through the
update process followed by a power cycle of the ComProbe 802.11. Subsequent firmware
updates may not require three firmware update cycles. This procedure is designed to take you
through one to three firmware update cycles. Follow the procedure carefully, paying attention
to jumps around unnecessary steps, and you should have no difficulty updating the firmware.

1. This tab displays the current firmware version in the hardware. You can check for the firmware updates by
first noting the current version and then clicking on the Check For Updates button.
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-
/O Settings g

Settings | Status | Capture Fiters Fimware Update

— Curmment fimmware versions in hardware:

FPGA Version: 22
Application Version: 04 Imterface Version: 13

Checlk For Updates I

Figure 3.8 - 802.11 I/0 Settings Firmware Update Tab

2. The Check for Updates dialog will open. If an update is available you can install it by clicking on the Start
Update button.
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| Firmuiare Update Fie(s) |  imageType | Feversonis) | Hjwversonls) |
comprobe_80211_fpga_revC_feu FPGA mage 29 9
comprobe B0211_app_rewl. fau AFP Image 0.7/1.% 0.4/1.3
comprabe_BO21L_AY reve, fwu FLF image 0.4
comgrobe_BO0211_pexS504_revC. fuu FENS604 mage 0.4
enmprabe_B0211_ath_revC. feu ATH mage 0.4
comprobe_BOZ11_athdk_revC. fuu ATHX image 0.4

comprobe _BO211_athikc_hw_revC. fay ATH HW mage 0.4
comprobe_B0211_athok_common_pevi. fwu ATHS COMMON image 0.4
comprobe_B0Z11_pdh_ude_revC. fnu PCH UDC image: Q.3
comprobe_B0211_g_padoet_rewl. feu GIPACHET image .2

Informational  comprobe_B0211_fpga_revC.feu  File Viersion [ 2.9 ) is same a8 curmently instaled HAW version (2.9 )

su-tmm“ o | cancel |

Figure 3.9 - 802.11 I/O Settings Firmware Check For Updates
3. When the update is complete, two situations can occur.

a. If more firmware updates are required the following dialog will appear. Click on OK, and continue
to step 4.

ComProbe 802.11

©  There are additional firmware updates required. After the device resets,
lh check for firmware updates again.

Figure 3.10 - 802.11 1/O Settings Check for Updates Again, second cycle.
b. If there are no more firmware updates, continue to step 15.
4. Click OK on the Check for Updates dialog.

5. Click Cancel on the 1/O Settings dialog Settings tab (See Settings on page 20). The ComProbe 802.11
will reset. Wait for a solid Activity LED on the ComProbe hardware .

6. Once the ComProbe 802.11 has reset, select I/O Settings from the Control Window Options menu.

7. Click on the I/O Settings dialog Firmware Update tab and then click on the Check for Updates
button. The Check for Updates dialog will appear.
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et v ==

Firmeiare Upaate Fie(s) [ imageType | Fdeversea(s) | HMW versenls) |
comprobe_B0211_fpga_revC.-fwa FPGA [mage 2.9 9
comprabe_B0211_app_rewi. fau AFP [mage 0713 0.4/1.3
comprobe_B0Z11_AF_revC, fuu FLF image 0.4
comprobe_B80211_pex3504_reve. fi FEXBE0 mage 0.4
comprobe B0211_ath_nevC. feu ATH mage 0.4
comprobe_BO0Z11_athak_revC. fvu ATHH image 0.4
comprobe_B0211_atikc_w_rewvC. fau ATH HW mage 0.4
enmprobe_B0211_athok_sommon_pev. fwu ATHS COMMON image 0.4
comprobe_B0Z11_pdh_ude_revC. vy PCH UDC image: 0.3
comprobe_BO211_g_padoet_revl.fmu G IFACKET image 0.2

Waarring [Error ] File | Descripbion ]

Informational  comprobe_B0211_fpga_revC.fu  File Version [ 2.9 ) = same a8 curmently instaded HW version [ 2.9 )

surtl.marrc| o | carcel |

Figure 3.11 - 802.11 1/O Settings Firmware Check For Updates, second cycle.
8. Click the Start Update button.
9. Again, when the update is complete, two situations can occur.

a. If there are more firmware updates the following dialog will be displayed. Click on OK and
continue to step 10.

ComProbe 802,11

. There are additional firmware updates required, After the device resets,
/ l}. check for firmware updates again.

Figure 3.12 - 802.11 1/0 Settings Check for Updates Again, third cycle.
b. If there are no more firmware updates, continue to step 15.
10. Click OK on the Check for Updates dialog.

11. Click Cancel on the I/O Settings dialog Settings tab (See Settings on page 20). The ComProbe 802.11
will reset. Wait for a solid Activity LED on the ComProbe hardware .

12. Once the ComProbe 802.11 has reset, select I/O Settings from the Control Window Options menu.

13. Click on the I/O Settings dialog Firmware Update tab and then click on the Check for Updates
button. The Check for Updates dialog will appear again.
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Frrrevare Lipiate Fie | EmageT... | Fieverson(s) | HMW verson(s) |
comprobe_80211_app_revE. vy AFF Image L4 10724
|
|
Woarring [Error ] File | Description ]

Start Upcate | o | cancel |

Figure 3.13 - 802.11 1/O Settings Firmware Check For Updates, third cycle.
14. Click the Start Update button.
15. When the update is complete the OK button will be enabled. Click the OK button.

16. When the I/O Settings dialog appears, click the OK button. The ComProbe 802.11 will reset. Reset is
complete when the ComProbe 802.11 unit serial number appears in the Control Window Configuration
Information.

| {J ComProbe Protocol Analysis Syst

| File View Live Options  Window Help

2P 0H LPRN B /e

Configuration: ComProbe 802, 11 [SM: 0142110001] |

Capture Status: ) Not Active (Capture to Single File) MNJA used Packets onhfw: 0
For Help Press F1

Figure 3.14 - ComProbe 802.11 Unit Reset Complete Indication

17. Remove power from the ComProbe 802.11 unit, and then reapply power. Wait until the Activity LED
comes back on and resume normal ComProbe operation. When the ComProbe 802.11 serial number
shows in the Control Window again, the firmware update is complete.

3.1.2.5 WiFi Security

With ComProbe 802.11, the WiFi decryption is not done in the datasource. It is done in the decoders, so you must
go to Set Initial Decoder Parameters to provide the security information to the decoder.

Frontline 802.11 Hardware & Software User Manual 29



TELEDYNE LECROY

From the Control window, select Set Initial
Decoder Parameters... from the Options

menu.

In the Set Initial Decoder Parameters dialog,
select the Security tab. In the tab pane, select
the encryption method being using with your
device under test (DUT) by clicking on the radio
button in the Encrypted Data box.

Chapter 3 Configuration Settings

&) ComProbe Protocol Analysis System - 802.11

File VWiew Live | Options | Window Help

=% @

Configuration: <Mo D

Hardware Settings...
/O Settings...
Systern Settings...

Directories...
Capture Status: @ N

Set Initial Decoder P
S —

Check for Mew Releases at Startup

Protocol Stack...
Set Initial Decoder Parameters...
Set Subsequent Decoder Parameters...

v Automatically Request Missing Decoding Information

Set Initial Decoder Parameters

9= d

| AvDTP | Security | LocAP | RFcomMM | a20P [use [ipx [ TP | uop |
|

‘ Template

Encrypted Data There are three types of types of encrypted data on the security tab, each one
selectable via a radio button.

@ WPAZ
Blustooth AMP
Pre-Shared Key

Table 3.1 - WiFi Encrypted Data Options
Option Description
WPA2 WPAZ2 (Wi-Fi Protected Access), and WEP (Wired Equivalent Privacy) data that is

transmitted over a 802.11 communications link. There are two values you have to enter for
the WPA2 and WEP to be decrypted properly.

Bluetooth
AMP

The Bluetooth alternative MAC/PHY (AMP) enables Bluetooth to support data rates up to 24
Mbps by using additional wireless radio technologies.

Pre-
shared
Key

The pre-shared key is a 32-byte hex number.

Within the Set Initial Decoder Parameters... dialog Security tab, the fields available will depend on the
Encrypted Data option selected.

30
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Select Data Capture Method....

Aggregated

llI|

S 40 BO211 AMP

. Interlaced Page Scan

~48 80211 and NFC

TELEDYNE LECROY

Note: When capturing both Bluetooth
and 802.11 data using the 802.11AMP
capture method, the ComProbe
software uses the link from the BR/EDR
connection. To automatically decode
802.11 AMP frames in this case, select
the Bluetooth AMP Encrypted Data,
but leave the Link Key field blank.

Enter the required security data in to the active fields for the selected Encrypted Data option. Click the OK button

48 80211 and 5D

48 80211 and USE
48 80211, Interlaced Page Scan
4 80211, 5D and USE
~48 80211/Blustooth Coexistence

Table 3.2 - WiFi Encrypted Data Option Fields

Encrypted
Data Field Description
Option

WPA2 WPA2: The station ID of the 802.11 communications link.
SSID
WEP: The station ID of the 802.11 communications link.
SSID
WEP: The shared passkey phrase used in communications.
Passkey

Bluetooth | BDR/EDR | Enter a hexadecimal value for the BR/IEDR Link

AMP Link Key |Key. (See Note above).
WEP: The station ID of the 802.11 communications link.
SSID
WEP: The shared passkey phrase used in communications.
Passkey

Pre- Raw Hex | Enter a 32-byte hex number

Shared Key

ey WEP: The station ID of the 802.11 communications link.
SSID
WEP: The shared passkey phrase used in communications.
Passkey

to set the decoder security parameters.

Wi-Fi security settings are also presented in detail in the Decoder Parameters section (See Wi-Fi Security Decoder

Parameters on page 40).
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3.1.2.6 Device Scanner
3.1.2.6.1 Wi-Fi Device Scanner

Chapter 3 Configuration Settings

1. On the I/O Settings dialog click on the Settings tab, and then click on the Scanner button. The Wi-Fi

Device Scanner dialog will open.

&) Wi-Fi Device Scanner

File Configure Centrol Help

# MAC Address

SSID

Type | Channel | Frequency | RSSI First Seen Last Seen

Status: Inactive

Devices Found: 0

Start Cancel Help

Sniffer: ComProbe 802,11 [SN: 0102120052]

Figure 3.15 - 802.11 Device Scanner with no Devices Detected

2. Onthe Wi-Fi Device Scanner dialog Select the Start button or select Start Scanning from the
Control menu to begin populating the list .

The Wi-Fi Device Scanner dialog displays a list of discoverable Wi-Fi devices in a table. The devices are

identified by:
o MAC Address
e SSID
o Type
e Channel
e Frequency
. RSSI
e First Seen

e Last Seen

Note: You can select the Stop or Stop Scanning from the Configure menu anytime
to stop the device search.

32
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File Configure Control Help
x MAC Address ) Type | Charmel | Frequency  RSS First Saen Last Seen
] 0C:D5:02: 24: 38R westel 1574 AP ] 437 [ 150448 1520+ 54
[ 2 | obikwdpdec:y | FTEGuest | _ap | & | 2437 | 90 | iSdéd |
3 00eIC:I0EREE:ER FTEARPH AP 4 2427 20 15:04:50 15:04:52
4 3C:43:BEBEDB:C2 Dwect 4 2427 41 150451 185:04:51
""" FTE-Guest ™
|  see | ¢ | Help
Status: 5080 MHz (16) (Scan range: 2417 to 5190 MHz) | Devices Found: 4 Sniffer: ComProbe 302,11 [SN: 01421 10040]

Figure 3.16 - 802.11 Device Scanner with Devices Detected
Select the device.

Click on Select channel <no>, where § .
<no> is the channel number selected. Canfirm sniffing channel [
The Confirm Sniffing Channel
confirmation will appear. Click on Yes
will close the Wi-Fi Device Scanner
and the ComProbe analyzer will used the
selected channel. Yes No

:I Do you want to sniff on Channel 10 (Access Point: FTE-Test_Systerns)?

File Menu

Under the File menu you can select Export to file which converts the information in the table to a text file.

1. Select Export to CSV file. The Save As menu appears
2. Select where you want to save the file in Save in.
3. Enter aFile Name.
4. Select Save.
Configure

From the Configure menu you can select, Hardware Settings and I/O Settings
3.1.2.6.2 Wi-Fi Scanner Hardware Settings

The Hardware Settings dialog provides the ability to select a device to sniff/scan. The dialog only lists devices with
a MAC address that match the Frontline devices. To access the Hardware Settings dialog:

1. Select Hardware Settings from the Options menu on the 802.11 Control window.
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Wi-Fi Scanner Hardware Settings = & |

Sniffer:  |ComProbe 802,11 [SN: 0102120052 ﬂ Refresh List

akK | Cancel | Help |

Figure 3.17 - Wi-Fi Scanner Hardware Settings Dialog
2. Select a device from the drop-down list.
3. SelectOK

If no devices are found, the list is blank.

Note: Upon launching the Air Sniffer, the first device in the drop-down is the default device.

3.1.2.6.3 Wi-Fi Device Scanner - 1/O Settings

The Device Scanner I/O Settings dialog is used to set a listening time and to activate a probe request. To access the
I/O Settings dialog:

1. Selectl/O Settings from the Configure menu on the Wi-Fi Device Scanner window.

Scan channels from 2417 MHz (2) *| upto 5190 MHz (38)

Channel listen time 1000 {ms)

Send probe requests to discover S5ID (if necessary ) Mo -

Cancel |

Figure 3.18 - Wi-Fi Device Scanner I/O Settings Dialog

2. Scan Channels from: Pick a lower and upper limit to scan a specific subset of frequencies. By default all
channels are selected. Choosing a subset of frequencies to scan saves time and can be used when the user
is interested in scanning only a certain range of frequencies.

3. Enter an amount, in msecs, for Channel listen time.

Channel listen time is how long Frontline® 802.11 will listen on a channel to discover devices before
moving on to the next channel.

4. SelectYes or No to choose whether to send a probe sync request.
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Sometimes an Access Point will intentionally not send it’s SSID in a beacon to conceal it’s identity. Selecting
Yes for this option will send the MAC address, the SSID will be part of the Probe Response it sends back.

5. Select OK to save the options and close the dialog or Cancel to close the dialog without saving your
choices.

3.1.2.6.4 Device Scanner RSSI Values

The 802.11 specification does not provide a relationship between the RSSI value and the actual power value. Here
are the definitions from the specification.

1. RSSIin FHSS PHY: The RSSI is an optional parameter that has a value of 0 through RSSI Max. This parameter
is a measure by the PHY of the energy observed at the antenna used to receive the current PPDU. RSSI
shall be measured between the beginning of the SFD and the end of the PLCP HEC. RSSl is intended to be
used in a relative manner. Absolute accuracy of the RSSI reading is not specified.

2. RSSlin DSSS PHY: The RSSI shall be a measure of the RF energy received by the DSSS PHY. RSSI indications
of up to 8 bits (256 levels) are supported.

3. RSSlin OFDM PHY: The allowed values for the RSSI parameter are in the range from 0 through RSSI
maximum. This parameter is a measure by the PHY of the energy observed at the antenna used to receive
the current PPDU. RSSI shall be measured during the reception of the PLCP preamble. RSSl is intended to
be used in a relative manner, and it shall be a monotonically increasing function of the received power.

Different vendors implement these value in their own way. The ComProbe 802.11 uses an Atheros chipset which
provides RSSI values in the range of 0 to 128. The radio hardware in the ComProbe 802.11 has two receive chains
(one for each antenna). Each received packet has RSSI values for both antennas as well as the combined value.

The hardware provides the following five values:
1. rssi_ant00: Receive signal strength indicator of control channel chain 0.
2. rssi_antO1: Receive signal strength indicator of control channel chain 1.
3. rssi_ant10: Receive signal strength indicator of extension channel chain 0.
4. rssi_antll: Receive signal strength indicator of extension channel chain 1

5. rssi_combined: Receive signal strenth indicator of combination of all active chains on the control and
extension channels.

All five of these values are shown in the PHY layer decoder for every packet. The Wi-Fi scanner shows the
combined value.

3.1.3 Wi-Fi Device - MAC Address Editor
If you know the MAC Address of the device you can enter it manually.
1. From the I/O Settings dialog select the "Edit" button.

2. Onthe MAC Address Editor enter the MAC Address for the device.

Frontline 802.11 Hardware & Software User Manual 35



TELEDYNE LECROY Chapter 3 Configuration Settings

MAC Address Edi x|
MAC Address: (e.g. 0014bf72b3a6 ) Listen Channel: (e.g. 1, 6, or 11)
| 0014bf72h3a6 | &
QK Cancel | Help

Figure 3.19 - Wi-Fi Direct MAC Address Editor
3. Enter achannel number in Listen Channel.
4. Select "OK".
The MAC Address appears on the I/O Settings dialog.

Once you close the dialog, the last MAC Address shown will appear when you reopen the dialog.

3.2 Decoder Parameters

Some protocol decoders have user-defined parameters. These are protocols where some information cannot be
discovered by looking at the data and must be entered by the user in order for the decoder to correctly decode
the data. For example, such information might be a field where the length is either 3 or 4 bytes, and which length
is being used is a system option.

There may be times when the context for decoding a frame is missing. For example, if the analyzer captures a
response frame but does not capture the command frame, then the decode for the response may be incomplete.
The Set Initial Decoder Parameters window allows you to supply the context for any frame. The dialog allows
you to define any number of parameters and save them in a template for later use

The decoder template function provides the capacity to create multiple templates that contain different
parameters. This capability allows you to maintain individual templates for each Bluetooth® network monitored.
Applying a template containing only those parameters necessary to decode transmissions particular to an
individual network, enhances the efficiency of the analyzer to decode data.

If you have decoders loaded which require decoder parameters, a window with one tab for every decoder that
requires parameters appears the first time the decoder is loaded.

For help on setting the parameters, click the Help button on each tab to get help information specific to that
decoder.

If you need to change the parameters later,

o Choose Set Initial Decoder Parameters... from the Options menu on the Control and Frame Display
windows.
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Options | Window  Help

v

Figure 3.20 - Select Set Initial Decoder Parameters... from Control window

The Set Initial Decoder Parameters window opens with a tab for each decoder that requires parameters.

Hardware 5ettings

I/O Settings

Systern Settings... Alt+Enter
Directories...

Check for Mew Releases at Startup

Side Mames...

Protecol Stack...
Set Initial Decoder Parameters...
Set Subsequent Decoder Parameters...

Automatically Request Missing Decoding Information

Set Initial Decoder Parameters

9

‘AVDTP | Security | L2caP | RFcOMM | A20P |usB |1Px | TCP | uDP |

Figure 3.21 - Tabs for each decoder requiring parameters.

o Each entry in the Set Initial Decoder Parameters window takes effect from the beginning of the capture

Template

=

onward or until redefined in the Set Subsequent Decoder Parameters dialog.

Override Existing Parameters

The Set Subsequent Decoder Parameters dialog allows the user to override an existing parameter at any

frame in the capture where the parameter is used.

If you have a parameter in effect and wish to change that parameter

o Selectthe frame where the change should take effect

o Select Set Subsequent Decoder Parameters... from the Options menu, and make the needed

changes. You can also right-click on the frame to select the same option.
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Options | Window Help

Directories...

v Check for New Releases at Startup

Side Mames...

Protocol Stack..

Set Initial Decoder Parameters...

| Set Subsequent Decoder Parameters...

v Automatically Request Missing Deceding Information

Figure 3.22 - Set Subsequent Decoder Parameters... from Control window

OOEB8QeO Q|

Unfiltered | Info | Configured BT low energy devices | Enors |

Baseband | LMP | PreConnection-FHS | Bluetooth FHS | L2CAP | SDP W—

TRA P

B... Framef Ruole Addr.
50 Master 1
51 Slave 1
52 Master 1
53 Slave 1

DLCI
0=00
000
0x=00
0x00

Channel

0

0
0
1]

Frame Type P/ Bt Cmd.. CmdType =
SABM 1

A 1

UIH 0 Com... Param. Meg.
UIH a

Res... Palam.Neg.l_l

Set Subsequent Decoder Parameters

#52. RFCOMM

Rules in effect from frame #52 onward until redefined here for a later frame:

On the Slave side, with Server Channel 13, RFCOMM is camying Hands Free ( Ovemidden by user )

Change the Selected tem to Camy | Hands Free

o]

Figure 3.23 - Example: Set Subsequent Decode for Frame #52, RFCOMM

« Each entry in the Set Subsequent Decoder Parameters dialog takes effect from the specified frame
onward or until redefined in this dialog on a later frame.

« The Remove Override button will remove the selected decode parameter override.

« The Remove All button will remove all decoder overrides.

If you do not have decoders loaded that require parameters, the menu item does not appear and you don't need

to worry about this feature.

3.2.1 Decoder Parameter Templates

3.2.1.1 Select and Apply a Decoder Template
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1. Select Set Initial Decoder Parameters... from the Options menu on the Control @ window or

the Frame Display @ window.

2. Click the Open Template V‘g icon in the toolbar and select the

- ﬁ m x |Temp|ate F

desired template from the pop up list. The system displays the content

of the selected template in the Initial Connections list at the top of the F'_| Frontlinel ‘
dialog FrontlineZ
3. Click the OK button to apply the selected template and decoders' Al Frontline2 1 |
settings and exit the Set Initial Decoder Parameters dialog. - Frontline? .
thie
L|'£ Frontlings I

3.2.1.2 Adding a New or Saving an Existing Template
Add a Template

A template is a collection of parameters required to completely decode communications between multiple
devices. This procedure adds a template to the system and saves it for later use:

1. Click the Save E button at the top of the Set Initial LT ——
Decoder Parameters dialog to display the Template
Manager d|a|0g Mame To Save Template As: Cancel

Frontlined

2. Enter a name for the new template and click OK. T ——————

Frontline

The system saves the template and closes the Template FrontineZ
Manager dialog.

Fiontines

3. Click the OK button on the Set Initial Decoder Parameters
window to apply the template and close the dialog.

Save Changes to a Template
This procedure saves changes to parameters in an existing template.
1. After making changes to parameter settings in a user defined template, click the Save E button at the
top of the Set Initial Decoder Parameters window to display the Template Manager dialog.
2. Ensure that the name of the template is listed in the Name to Save Template As text box and click OK.

3. The system displays a dialog asking for confirmation of the change to the existing template. Click the Yes
button.

The system saves the parameter changes to the template and closes the Save As dialog.

4. Click the OK button on the Set Initial Decoder Parameters window to apply the template and close
the window.
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3.2.1.3 Deleting a Template

1. After opening the Set Initial Decoder Parameters window click the Delete x button in the toolbar.

The system displays the Template Manager dialog with a list of saved templates.

2. Select (click on and highlight) the template marked for deletion and click the Delete button.
The system removes the selected template from the list of saved templates.

3. Click the OK button to complete the deletion process and close the Delete dialog.

4. Click the OK button on the Set Initial Decoder Parameters window to apply the deletion and close
the dialog.

3.2.2 Wi-Fi Security Decoder Parameters

On the Set Initial Decoder Parameters dialog, the security tab allows specifying a key for software decryption of
802.11 frames.

To access this dialog:

1. Inthe Options menu on the Control window and choose Set Initial Decoder Parameters.

2. Select the Security tab.
There are three types of types of encrypted data on the security tab, each one selectable via a radio button.
Table 3.3 - WiFi Encrypted Data Options
Option Description

WPA2 WPA2 (Wi-Fi Protected Access), and WEP (Wired Equivalent Privacy) data that is
transmitted over a 802.11 communications link. There are two values you have to enter for
the WPA2 and WEP to be decrypted properly.

Bluetooth | The Bluetooth alternative MAC/PHY (AMP) enables Bluetooth to support data rates up to 24

AMP Mbps by using additional wireless radio technologies.
Pre- The pre-shared key is a 32-byte hex number.

shared

Key

Depending on which Encrypted Data type you select, the options for entering data on the rest of the dialog
varies.

-

Select Data Capture Method.... Note: When capturing both Bluetooth
and 802.11 data using the 802.11AMP

i " capture method, the ComProbe
ogregate software uses the link from the BR/EDR

(a..h_____""“;’ 0211 aMP connection. To automatically decode
e : . Interlaced Page Scan 802.11 AMP frames in this case, select
48 80211 and NFC the Bluetooth AMP Encrypted Data,
-4 80211 and 5D but leave the Link Key field blank.

{:’ a02.11 and LISE

{:’ 80211, Interlaced Page Scan
0 20211, 50 and USE

{:’ 302,11 /Blustaoth Coexistence
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Table 3.4 - WiFi Encrypted Data Option Fields

Encrypted
Data Field Description
Option

WPA2 WPA2: The station ID of the 802.11 communications link.
SSID
WEP: The station ID of the 802.11 communications link.
SSID
WEP: The shared passkey phrase used in communications.
Passkey

Bluetooth | BDR/EDR | A hexadecimal value for the BR/EDR Link Key.

AMP Link Key | (See note See Note on the previous page).
WEP: The station ID of the 802.11 communications link.
SSID
WEP: The shared passkey phrase used in communications.
Passkey

Pre- Raw Hex | Enter a 32-byte hex number

Shared Key

Key WEP: The station ID of the 802.11 communications link.
SSID
WEP: The shared passkey phrase used in communications.
Passkey

AVDTP | Securty | Lacap | RFcoMm | a2pp

Encrypted Data

@ WPAZ
Bluetooth AMP
Pre-Shared Key

WPAZ
S5ID:

Passkey:

Blugtoath AMP
BR/EDR Link Key:

Pre-Shared Key
Raw Hex Key:

WEP

5510:

Passhkey:

USB | IPX TCP | UDP

Figure 3.24 - Decoder WiFi Security Tab
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3.2.3 Adding or Changing TCP/UDP Port Assignments

TCP and UDP are Transport layer protocols in the IP protocol suite. These transport layer protocols use ports to
establish communication between application layer protocols. For example, all Web traffic uses the HTTP
protocol. HTTP is an application layer protocol that uses the standard TCP/UDP port 80. The Internet Assigned
Numbers Authority (IANA) is responsible for maintaining the list of standard port numbers and their assignments.
For an up-to-date listing of all standard TCP/UDP port assighments, visit www.iana.org.

When the analyzer reads a TCP, UDP or IPX packet, it infers the upper layer protocols by using pre-defined rules of
traversal. For example, if the packet has a TCP source or destination port number 80, then the upper layer
protocol is HTTP. These rules, which are built in to the software, determine the upper layers of the protocol stack
based on the source or destination port numbers in the packet. The built-in rules are based on the standard port
assignments. However, it is quite common to come across network systems in which upper layer protocols use
user-defined port numbers for both standard and custom protocols. In such cases, the analyzer users can tell the
software which port numbers are assigned to which protocols.

The analyzer autotraverses the stack from TCP, UDP and IPX based on the source or destination port number.
Many systems use user-defined port numbers for both standard and custom protocols. Here’s how to tell the
analyzer about a custom port assignment on the system you are monitoring.

Add a New Port Assignment

1. Choose Set Initial Decoder Parameters from the Options menu on the Control @ window.

2. Click the TCP tab (or UDP or IPX for those protocols).
3. Choose the Single Port radio button
4. Enter the port number in the Port Number box.
5. Inthe Protocol drop-down list, choose the protocol to traverse to.
6. Click the Add button.
The system adds the new entry to the bottom of the port number list.
Modify an Existing Port Assignment
1. Choose Set Initial Decoder Parameters from the Options menu on the Control window.
2. Click the TCP tab (or UDP or IPX for those protocols).
3. Select (click on and highlight) the port assignment to modify.
4. Change the port number and/or choose the protocol to traverse to.

5. Select the Port Range radio button and specify the starting and ending port numbers. The range is
inclusive.

6. Click the Modify button.

The system displays the changes in port assignment.
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Delete a Port Assignment
1. Choose Set Initial Decoder Parameters from the Options menu on the Control window.
2. Click the TCP tab (or UDP or IPX for those protocols).
3. Select (click on and highlight) the port assignment to delete.
4. Select Delete.
The system deletes the port assignment.
Move a Port Assignment

If you need to move an entry to ensure it is processed before or after another entry, select the entry in the list
and then click the Move Up or Move Down buttons.

Port Assignment Considerations
« The analyzer traverses an entry if either the source or destination port match.

o The analyzer processes port number entries in order from top to bottom.

3.2.4 Determining Master and Slave

In Bluetooth , the device that initiates the connection is always the master at connection time. You only need to
know the master and slave at connection time when setting up the I/O Settings. Afterward a role switch may
occur, but the analyzer automatically follows the role switch.

Note: You do not have to identify a Master address if you are using Firmware Version 62 or
newer.

Role Switches

After the connection has been made, a role switch can take place. A good example of why this happens would be
when a mouse connects to the PC. The mouse initiates the connection, so it is the master. After the connection is
made, a role switch occurs so that the PC becomes the master and the mouse becomes a slave. The role switch
takes place because the PC may be working with multiple devices at the same time, and as such, the PC would not
be a slave of more than one device.

Let us say that a link exists between a PC and a keyboard with the PC a master. If the mouse wants to become a
member of the link it initiates the connection. Since the mouse initiated the connection, it is the master of a new
link and the PC is the slave. The PCis still the master of the link between the PC and keyboard. A role switch now
occurs between the PC and the mouse, and the PC is now the master of a link with two slaves: the mouse and
keyboard.

3.3 Conductive Testing

Conductive testing could be used for many reasons, but the most common use is to isolate the Wi-Fi test setup
from the surrounding environment. Interference from radio frequency (RF) sources is the most common reason
for isolating the test from the environment. This is especially important when the environment contains RF
sources using the industrial, scientific, and medical (ISM) radio bands from 2.4 to 2.485 GHz that are the bands
used for Wi-Fi.

“Conductive” in this context means that you are not “air sniffing”, that is, capturing Wi-Fi transmissions on the
Frontline analyzer's antenna. The conductive test setup uses coaxial cable to directly connect the Device Under
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Test (DUT) to the analyzer's antenna connectors. The coaxial cable provides the isolation from the environment
through shielding.

3.3.1 802.11 WiFi Conductive Testing

“Conductive” in this context means that you are not “air sniffing”, that is, capturing 802.11 transmissions on the
ComProbe 802,11 analyzer antenna. The conductive test setup uses coaxial cable to directly connect the DUT
(Device Under Test) to the analyzer antenna connectors. The coaxial cable provides the isolation from the
environment through shielding.

Test Equipment

The following equipment is required for the test setup. All cables, connectors and adapters, and attenuators
should be relatively flat from 2 GHz to 6 GHz.

1. Coaxial cable All cable must be 50Q and should be double shielded.
2. Coaxial T-connectors, 50Q.
3. RP.SMA adapters for connecting coaxial cable or attenuators to the antenna connectors, 50Q.
4, AT1 - AT9: 20 dB attenuators, 50Q.
5. Frontline 802.11 WiFi protocol analyzer.
6. Computer for running Frontline software.
Test Setup

Figure 3.25 below shows the 802,11 conductive test setup.
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DUT 1

DUT 2

i
<

AT6

ANT3

ANT2

ANT1

ANT1

ANT2

Frontline 802.11

ANT3

Figure 3.25 - Frontline 802.11 Conductive Test Setup for 3X3 MIMO
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The above test setup if for 3X3 MIMO 802.11 devices. If not testing this configuration, the ANT3 connection to the
DUTs and the ComProbe 802.11 is not used.

Test Process

After connecting DUT1, DUT2, and the Frontline 802.11 , follow these steps to capture WiFi data.
1. Establish data transmission between DUT 1 and DUT 2.
2. Begin capture of the data with the Frontline 802.11 .

3. Conduct protocol analysis with the Frontline software on the personal computer or save the capture file
for future analysis.
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Chapter 4 Capturing and Analyzing Data
The following sections describe the various ComProbe software functions that capture and display data packets.

4.1 Capture Data
4.1.1 Air Sniffing: Positioning Devices

When capturing over the air packets, proper positioning of the Frontline hardware and the Devices Under Test
(DUTSs) will result in the best possible captures and will mitigate sources of path loss and interference. The
following procedures will help optimize the capture process especially if you are have problems obtaining reliable
...captures.

Problems with indoor radio propagation

Even in free space, it is well understood that radio frequencies attenuate over distance. The free-space rule-of-
thumb dictates that radio energy decreases in strength by 20 dB by each 10-to-1 increase in range. In the real-
world, the effects of objects in an outdoor environment cause reflection, diffraction, and scattering resulting in
greater signal losses. Indoors the situation can be worse. Reflections occur from walls and other large flat surfaces.
Diffraction occurs from objects with sharp edges. Scattering is produced from objects with rough surfaces and
from small objects. Also any object directly in the path of the radiation can present a hard or soft partition
depending on the partition's material properties. Path losses from partitions are difficult to estimate.

Estimating indoor propagation loss

_1
One estimate of indoor path loss, based on path loss data from a typical building, provides a Tange*® power rule.
At 2.4 GHz, the following relationship provides an approximate estimate of indoor path loss:

Indoor Path Loss (in dB) = 40 + 35Log;,(range, in meters)
This approximation is expected to have a variance of 13 dB.
Mitigating path loss and interference

Bluetooth device design contributes to mitigating environmental effects on propagation through spread spectrum
radio design, for example. However, careful planning of the testing environment can also contribute to reliable
data capture process.
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The first step to ensuring reliable air-sniffing data capture is to understand the RF characteristics of the Devices
Under Test (DUTs). The Bluetooth Class, antenna types, and radiation patterns are all important factors that can
affect the placement of the DUTs and the Frontline hardware. Radiation patterns are rarely spherical, so
understanding your device's radiation patterns can greatly enhance successful data capture. Position devices to
avoid radiation attenuation by the surroundings.

This step is optional: Consider conductive testing to establish a baseline capture. Conductive testing isolates the
DUTs and analyzer from environmental effects.

The next step is to ensure that the testing environment is as clutter-free as possible.

o Line-of-sight obstructions should be eliminated between the Frontline hardware and the DUTs because they
cause a reduction in signal strength. Obstructions include, but are not limited to: water bottles, coffee cups,
computers, computer screens, computer speakers, and books. A clear, unobstructed line-of-sight is preferred
for DUT and Frontline hardware positioning.

« If using an analyzer connected to a computer, position the computer on an adjacent table or surface away
from the analyzer and DUTs, taking advantage of the cables' length. If this is not possible, position the
computer behind the analyzer as far away as possible. If using the Frontline FTS4BT, which is a dongle, either
use an extension USB cable or position the computer such that the dongle is positioned towards the DUTs.

o The preferred placement is positioning the DUTs and the Frontline hardware at the points of an equilateral
triangle in the same horizontal plane, i.e. placed on the same table or work surface. The sides of the triangle
should be between 1 and 2 meters for Bluetooth transmitter classes 1 and 2. The distance for transmitter class
3 should be 1/2 meter.

Figure 4.1 - Devices Equally Spaced in the Same Horizontal Plane

Finally, eliminate other RF sources.

o Wi-Fiinterference should be minimized or eliminated. Bluetooth shares the same 2.4 GHz frequency bands as
Wi-Fi technology. Wi-Fi interference can cause loss of packets and poor captures. In a laboratory or testing

48 Frontline 802.11 Hardware & Software User Manual



Chapter 4 Capturing and Analyzing Data TELEDYNE LECROY

environment do not place the DUTs and Frontline hardware in close proximity with Wi-Fi transmitting sources
such as laptops or routers. Turning off Wi-Fi on the computer running the Frontline software is recommended.

Poor Placement

A poor test configuration for the analyzer is placing the DUTs very close to each other and the analyzer far away.
The DUTs, being in close proximity to each other, reduce their transmission power and thus make it hard for the
analyzer to hear the conversation. If the analyzer is far away from DUTs, there are chances that the analyzer may
miss those frames, which could lead to failure in decryption of the data.

Obstacles in close proximity to or in between the analyzer and the DUTs can interfere and cause reduction in
signal strength or interference. Even small objects can cause signal scattering.

Figure 4.2 - Example: Poor Capture Environment

4.1.2 Capturing Data to Disk - General Procedure

Note: Capture is not available in Viewer mode.

1. Click the Start Capture button @ to begin capturing to a file. This icon is located on the Control ,
Event Display, and Frame Display windows.

2. Files are placed in My Capture Files by default and have a .cfa extension. Choose Directories from the
Options menu on the Control window to change the default file location.

Note: For the Dashboard, when you capture to series of files, the window displays the
data from the beginning of the first capture, even when a new file in the series is
created. This is because the Dashboard is a "Session Monitor", which means that
even if you capture to a series of files, the data from the first file is always displayed.
The display does not refresh when a new capture file in a series is created.
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3. Watch the status bar on the Control window to monitor how full the file is. When the file is full, it begins
to wrap, which means the oldest data will be overwritten by new data.

4. Click the Stop Capture icon [ to temporarily stop data capture. Click the Start Capture icon again to

resume capture. Stopping capture means no data will be added to the capture file until capture is
resumed, but the previously captured data remains in the file.

5. To clear captured data, click the Clear icon iré .

o Ifyouselect Clear after selecting Stop Capture, a dialog appears asking whether you want to save
the data.
o You can click Save File and enter a file name when prompted .
o If you choose Do Not Save, all data will be cleared.
o If you choose Cancel, the dialog closes with no changes.

« If you select the Clear icon while a capture is occurring:
o The capture stops.
o A dialog appears asking if you want to save the capture

o You can select Yes and save the capture or select No and close the dialog. In either case, the
existing capture file is cleared and a new capture file is started.

o If you choose Cancel, the dialog closes with no changes.
To see how to capture to a single file, choose System Settings from the Options menu on the Control window.

When live capture stops, no new packets are sniffed but there can still be packets that were previously sniffed but
not yet read by the ComProbe analyzer. This happens when packets are being sniffed faster than the ComProbe
analyzer can process them. These packets are stored either on the ComProbe hardware itself or in a file on the
PC. If there are remaining packets to be processed when live capture stops the Transferring Packets dialog
below is displayed showing the packets yet to be read by the ComProbe analyzer. The dialog shows the name of
each ComProbe hardware device, its process id in square brackets, and the number of packets remaining. These
stored packets are read until they’re exhausted or the user clicks the Discard button on the dialog.

Unlike 802.11, Bluetooth packets never come in faster than the datasource can process them. However, Bluetooth
packets must still be stored so that they can be read in chronological order with the 802.11 packets.
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Transferring Packets ... E

Current Packet Transfer Statistics:

Hardware Packets on hardware
ComProbe B02.11 [6120] 21,084
BPA 500 [2720] 3
Tokal 21,087

Live capture has stopped but there are packets buffered on the ComProbe Hardware that
have not been decoded.  These packets will continue to be transferred and decoded until
complete.

Press the "Discard” button ko stop packet transfer and discard all untransferred packets

Transfer iz 26% complete (0 seconds remaining)

[ Discard ] [ Help

Figure 4.3 - Packet Transfer Dialog
4.1.2.1 Frontline® 802.11 with Wireshark®

4.1.3 Capturing Using Frontline Wi-Fi Datasource with Wireshark®

Note: This topic is provided as a courtesy to our customers who want to use Wireshark in
conjunction with the ComProbe 802.11 although the ComProbe software is fully capable of
performing the same functions as Wireshark. Frontline does not support or maintain third party
products. Should you have difficulty with your Wireshark product contact the manufacturer for
support or maintenance.

Click on the "ComProbe 802.11 with Wireshark" short cut to launch and start capturing the Wi-Fi packets. If you do
not see any packets on the Wireshark window then check the status message indication on the Wi-Fi
Datasource window to see if sniffing has stopped. Click on the Start @ button .
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Wi-Fi Datasou: |
Eile Sniffing View Help

@l B

Stopped sniffing 802.11 packets

Number of 802.11 packets sent to Wireshark: 386

Ready ﬂ

Figure 4.4 - Datasource Stopped Sniffing

When the ComProbe 802.11 is sniffing the datasource will display the following message. Sniffing can be stopped
by clicking the Stop button m -

File Sniffing View Help

| @ 10

P

Sniffing 802.11 packets

Number of 802.11 packets sent to Wireshark: 428

Ready ﬂ

Figure 4.5 - Datasource Sniffing

-
i The Wireshark Network Analyzer [Wireshark L.8.3 (SVN Rev 45256 from /ftru

File Edit View Go (Capture Analyze Statistics Te\ephonz Tools I

a “ @ @ @ B Interfaces.. Criel b s & ’g §
i@ Options... Ctrl+K

R B Start Ctrl+E [

80211 Channel:| | - cha| @ Stop Ctri+E fhes None

@ Restart Ctrl+R

@ Capture Filters...
oo o Most Popular

Version 1.8.3 (SVN Rev 45256 from

Figure 4.6 - Wireshark Capture Dialog
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Note: Whenever you give Start Capture command on Wireshark, the status message on the
Wi-Fi Datasource window should display "Please START capturing on the Wireshark." If it is
displaying a different message then you can use the Reset button on the Wi-Fi Datasource

window or select Reset | 'b or in the Sniffing menu to get back to this message.

Eile Sniffing View Help

° Il %

1 S~
1\

""'x.__T Reset
\_{Shown inactive) )

Stop
|_(Shown inactive) |

Figure 4.7 - Wi-Fi Datasource Toolbar

File View Help

Start r

Stop

Hardware Settings
10 Settings

Reset

Figure 4.8 - Wi-Fi Datasource Sniffing Menu

Once the Wi-Fi Datasource starts capturing packets and sending them to Wireshark, you can pause and resume
capturing using the Stop ] and Start @ toolbar buttons on the Wi-Fi Datasource toolbar or the Sniffing

menu. Note that the Restart command on the Wireshark window does not function. The workaround is to click
Reset | * on the Wi-Fi Datasource then click Start on the Wireshark Capture menu. Also the Wireshark

Capture Filters menu does not function, but you can use 10 Settings menu on the Wi-Fi Datasource window or
Sniffing menu for setting filters.

Known Issues with Wireshark

o In Real Time capture mode (when you select Update list of packets in real time check-box in the Capture
Options dialog), if you move the Wireshark window around on the desktop or click on anything on the
Wireshark window, it freezes the desktop. You can unfreeze it by bringing up Windows Task Manager by
pressing Ctrl+Alt+Delete.
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n Wireshark: Capture Options =8 =
Capture
Capture Interface Link-layer header Prom. Mode Snaplen [B] Buffer [MB]' =
Broadcom NetXtreme Gigabit Et...
feB0-acT3cBBebablertl Ethernet enabled default 1
1321680159
¥|  \\\pipe\capture-using-fte-comp... Ethernet enabled default 1 =
7| m r
Capture on all interfaces Manage Interfaces
V| Capture all in promiscuous mode
Capture File(s) Display Options
File: Browse.. Update list of packets in real time
Use multiple files | Use pcap-ng format

7 . .
MR ae 1 ] Automatic scrolling in live capture
Next file every 1 minute(s) 7| Hide capture info dislog

Ring bufferwith |2 files
Mame Resolution
Stop capture after (1 file(s)

Stop Capture ... 7| Enable MAC name resolution

- after 1 +| packet(s) Enable network name resolution
... after 1 = | megabyte(s)
. after 1 = | minute(s) /| Enable transport name resolution

Figure 4.9 - Wireshark Capture Options

« If you capture more than a few millions of packets, e.g. 4 million, Wireshark crashes.
4.1.4 Combining BPA 600, 802.11, and HSU with ProbeSync

ProbeSync™ allows multiple ComProbe analyzers to work seamlessly together and to share a common clock.
Clock sharing allows the analyzers to precisely synchronize communications stream and to display resulting
packets in a single shared view.

The ComProbe BPA 600, ComProbe 802.11, and ComProbe HSU analyzers have ProbeSync capability allowing
timestamp synchronization of captured data. Synchronizing the clock for these ComProbe devices used in
combination requires attention to the sequence of hardware connection. It is important to remember the
following key points.

o« ComProbe devices are connected serially in a daisy-chain fashion. The combined length of all cables in the
chain cannot exceed 1.5 meters (4.5 ft.).

o The "master" ComProbe device provides the clock to the other devices. All other ComProbe devices are
"slaves" and received the clock from the "master" device.

e On ComProbe devices with an OUT and IN connector, the function of these connectors is dependent on if
they are a "master" or a "slave".

o "master" device: OUT connector provides the clock to all "slave" devices. IN connector is not used.

o "slave" device: IN connector receives the clock from the OUT connector of the prior device in the chain.
The OUT connector is just a pass-through connector on a "slave" device.

o BPA 600 is always the "master" device and the first device in the chain, if being used.
o HSU is always the last "slave" device in the chain, if being used.

o HSU maximum capture data rate is 6 Mbit/sec.
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Connecting ComProbe BPA 600, ComProbe 802.11, and ComProbe HSU devices in ProbeSync takes place in the
following steps.

1. Connectthe ComProbe BPA 600 OUT connector to the ComProbe 802.11 IN connector.
2. Connectthe ComProbe HSU Cat 5 cable to the ComProbe 802.11 OUT connector.

Each device datasource is setup individually to sniff their respective link. That is, you will see a separate
datasource window for the BPA 600 device, the 802.11 device, and the HSU device.

Data saved as a capture file will include data captured on each device.

Should the hardware be connected incorrectly, thatis IN to IN or OUT to OUT, an error message will appear.
Follow the instructions in error message. To continue click on the OK button. The ComProbe device datasource
Status window will also display a warning message suggesting information sources.

BPA 600 datasource @

A Probe Sync setup emor has been detected!

The Probe Sync cable should be connected to the "OUT" port of one BFA
and the "IN" port on the other BPA.

f IMPORTANT - Please follow these steps in the exact order listed!
1) Comectly connect the Probe Sync cable between the two BPAs.
2) Close CPAS -YOU MUST DO THIS STEP!

3) Restart CPAS.

f necessary, please refer to the Quick Start Guide for further information.

Figure 4.10 - Incorrect ProbeSync Hardware Connection Error

4) Reconnect the USE cable for both BF As. -
%) Restart CPAS.

BCEssary, please rﬂ‘ertuﬂme&jd{&ﬂiﬁjdeforﬁlﬂ'ﬁrfmnmon

Figure 4.11 - Incorrect ProbeSync Hardware Connection Message In Datasource Status

The BPA 600 datasource dialog Start Sniffing @ button initiates the capture for all connected ComProbe
802.11 and HSU devices. On the 802.11 and HSU receiving the clock—cable connected to IN— the Start
Sniffing button is disabled when using ProbeSync. In each ComProbe device's Control window status window
will announce the synchronizing function.
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Quenying for fimmware ids. -
Finished quenying for fimware ids.
Probe Sync cable connected to "OUT" part. -

Figure 4.12 - ProbeSync Synchronizing Device Status Message

Premium Maintenance will expire on August 16, 2014, -
Guening far fimmware ids.
m _ c cablemneded to "IN" part. -

Figure 4.13 - ProbeSync Synchronized Device Status Message

Data captured in the synchronized device will appear in the Frame Display, Event Display, Bluetooth
Timeline, Bluetooth low energy Timeline, and Coexistence View.

4.1.5 Sodera & 802.11: Capturing with ProbeSync

ProbeSync allows Frontline Sodera and 802.11 hardware to work seamlessly together and to share a common
clock. Clock sharing allows the analyzers to precisely synchronize communications streams and to display resulting
packets in a single shared view.

When configured for synchronization through ProbeSync, one Sodera device provides the clock to the other
device. The clock is provided by a provided CAT 5 cable between the master Sodera PROBESYNC OUT
connector—sending the synchronizing clock—to the slave device hardware ProbeSync IN connector—receiving
the clock.

When the Frontline software runs in ProbeSync mode, only the Sodera Control window and Sodera datasource
window will appear. Should the hardware be connected incorrectly, thatis IN to IN or OUT to OUT, an error
message will appear in the Event Log pane.

Event Log

Description Time
(i ComProbe Protocol Analysis Software Version: 16.4.10175.10266 5472016 9:13:23.267 AM
(i) Connected to ComProbe Sodera SN: A1604-00005 Hardware Veersion: FO 00 Fimware Version: 201511060720 5/4/2016 %:13:23.875 AM
(‘i) Premium-Mai 7 f 1, 2017, 5/4/2016 9:13:23.875 AM
1\ ProbeSync Cable not propery connected. h4/2016 9:13:25.123 AM

Figure 4.14 - Incorrect ProbeSync Hardware Connection Message
The Sodera datasource window Record button initiates the capture for both devices.

Data captured in the synchronized device will appear in the Frame Display, Event Display, Bluetooth
Timeline, Bluetooth low energy Timeline, and Coexistence View. Data saved as a capture file during
analysis will include data captured on both devices.

4.1.6 Extended Inquiry Response

Extended Inquiry Response (EIR) is a tab that appears automatically on the Frame Display window when
you capture data.
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Figure 4.15 - Frame Display Extended Inquire Response

EIR displays extensive information about the Bluetooth® devices that are discovered as data is being captured. EIR
provides more information during the inquiry procedure to allow better filtering of devices before connection;
and sniff subrating, which reduces the power consumption in low-power mode. Before the EIR tab was created,
this type of information was not available until a connection was made to a device. Therefore, EIR can be used to

determine whether a connection can/should be made to a device prior to making the connection.

Note: If a Bluetooth device does not support Extended Inquiry Response, the tab displays
Received Signal Strength Indication (RSSI) data, which is less extensive than EIR data.

4.2 Protocol Stacks
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4.2.1 Protocol Stack Wizard

The Protocol Stack wizard is where you define the

protocol stack you want the analyzer to use when Select a Protacol Stack 2
decoding frames.
Select a protocal stack:
. Build Your O ~
To start the wizard: mrme
802.11 Radio
Air Sniffer
1. Choose Protocol Stack from the Options BlueCere Sera Prtocol (ECSP from Cambdge Sion Radio) wih auoiravere =
i i Bluetooth HCI USB with autot
menu on the Control window or click the
Protocol Stack icon £ on the Frame Piettius Protocal wih autotraverse
- wt_Protocal
. LEEB
Dlsplay MWS Wireless Coexistence Inteface 2 2
. . Currert Protocol Stack: Remove Li
2. Selecta protocol stack from the list, and click e
Finish Bluetooth Virtual Transport with Autotraverse
Most stacks are pre-defined here. If you have special P

requirements and need to set up a custom stack, see
Creating and Removing a Custom Stack on page 59.

1. If you select a custom stack (i.e. one that was defined by a user and not included with the analyzer), the
Remove Selected Item From List button becomes active.

2. Click the Remove Selected Item From Listbutton to remove the stack from the list. You cannot
remove stacks provided with the analyzer. If you remove a custom stack, you need to define it again in

order to get it back.

If you are changing the protocol stack for a capture file, you may need to reframe. See Reframing on page 60 for
more information.

You cannot select a stack or change an existing one for a capture file loaded into the Capture File Viewer (the
Capture File Viewer is used only for viewing capture files and cannot capture data). Protocol Stack changes can

only be made from a live session.
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4.2.2 Creating and Removing a Custom Stack

TELEDYNE LECROY

To create a custom stack: [ E—— ) |
1. Choose Protocol Stack from the
Options menu on the Control Sekect & profoco sacic
P enuon the [ Buid YourOwn N
window or click the Protocol Stack 802.11 MAC
. . 802.11 Radio
icon @ on the Frame Display Air Sriffer _
— BlueCore Senal Protocal (BCSP from Cambridge Silicon Radio) with autotraverse =
Bluetooth HCI UART {H4) with autotraverse
toolbar. Bluetooth HCI USB with autotraverse
Bluetooth virtual transport with autotraverse B
. . Fictitious Protocol with autotraverse
2. Select Build Your Own from the list HADS with autotraverse
. wt_Protocol
and click Next. LEEB
MW S Wireless Coexistence Interface 2 sl
3. The system displays an information e — o T——
. . Cumrent Protocol Stack: IEMOVE Jeiecled e LIS
screen that may help you decide if you |
need to define your own custom stack.
Defining a custom stack means that the
analyzer uses the stack for every g Net> ] [ Concd
frame. Frames that do not conform to
the stack are decoded incorrectly.
Click Next to continue. Select a Protocol Stack L

Choose one at a time by
double clicking or by using
the select button:

Select Protocols

1. Selecta protocol from the list on the o Manager i

ATT
left. AVETP
AVDTP Media
AVDTP Recover
AVDTP Report
AVDTP Signaling
AVRCP
AVRCF Browsing
Baseband
BCCMD
EIP
BlueCore Seral Protocol ™
€ m b

2. Click the right arrow button to move it
to the Protocol Decode Stack box
on the right, or double-click the
protocol to move it to the right.

3. Toremove a protocol from the stack,
double-click it or select it and click the

left arrow button.

_ All addttional stack layers
@) can be detemmined
automatically.

-, There are no addtional
stack layers.

Add To Predefined List

Protocol Decode Stack:

Baseband
AVDTP

[ <Back |

Fiish | [ Cancl

4. If you need to change the order of the

protocols in the stack, select the
protocol you want to move, and click

on the Move Up and Move Down buttons until the protocol is in the correct position.

5. The lowest layer protocol is at the top of the list, with higher layer protocols listed underneath.

Auto-traversal (Have the analyzer Determine Higher Layers)

If you need to define just a few layers of the protocol stack, and the remaining layers can be determined based on

the lower layers:

1. Click the All additional stack layers can be determined automatically button.

2. If your protocol stack is complete and there are no additional layers, click the There are no additional

stack layers button.
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3. If you select this option, the analyzer uses the stack you defined for every frame. Frames that do use this
stack are decoded incorrectly.

Save the Stack

1. Click the Add To Predefined List button.

2. Give the stack a name, and click Add.
In the future, the stack appears in the Protocol Stack List on the first screen of the Protocol Stack wizard.
Remove a Stack

1. Selectitin the first screen and click Remove Selected Item From List.

2. If you remove the stack, you must to recreate it if you need to use it again.

Note: If you do not save your custom stack, it does appear in the predefined list, but applies to
the frames in the current session. However, it is discarded at the end of the session.

4.2.3 Reframing

If you need to change the protocol stack used to interpret a capture file and the framing is different in the new
stack, you need to reframe in order for the protocol decode to be correct. You can also use Reframe to frame
unframed data. The original capture file is not altered during this process.

Note: You cannot reframe from the Capture File Viewer .

To reframe your data, load your capture file, select a protocol stack, and then select Reframe from the File
menu on the Control window. Reframe is only available if the frame recognizer used to capture the data is
different from the current frame recognizer.

In addition to choosing to Reframe, you can also be prompted to Reframe by the Protocol Stack Wizard.

1. Load your capture file by choosing Open from the File menu on the Control window, and select the file
to load.

2. Select the protocol stack by choosing Protocol Stack from the Options menu on the Control window,
select the desired stack and click Finish.

3. If you selected a protocol stack that includes a frame recognizer different from the one used to capture
your data, the Protocol Stack Wizard asks you if you want to reframe your data. Choose Yes.

4. The analyzer adds frame markers to your data, puts the framed data into a new file, and opens the new
file. The original capture file is not altered.

See Unframing on page 60 for instructions on removing framing from data.

4.2.4 Unframing

This function removes start-of-frame and end-of-frame markers from your data. The original capture file is not
altered during this process. You cannot unframe from the Capture File Viewer (accessed by selecting Capture File
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Viewer or Load Capture File to start the software and used only for viewing capture files).

To manually unframe your data:

1. Select Unframe from the File menu on the Control window. Unframe is only available if a protocol
stack was used to capture the data and there is currently no protocol stack selected.

In addition to choosing to Unframe, you can also be prompted to Unframe by the Protocol Stack Wizard.
1. Load your capture file by choosing Open from the File menu on the Control window.
2. Select the file to load.
3. Choose Protocol Stack from the Options menu on the Control window
4. Select None from the list

5. Click Finish. The Protocol Stack Wizard asks you if you want to unframe your data and put it into a new
file.

6. Choose Yes.

The system removes the frame markers from your data, puts the unframed data into a new file, and opens the
new file. The original capture file is not altered.

See Reframing on page 60 for instructions on framing unframed data.

4.2.5 How the Analyzer Auto-traverses the Protocol Stack

In the course of doing service discovery, devices ask for and receive a Protocol Descriptor List defining which
protocol stacks the device supports. It also includes information on which PSM to use in L2CAP, or the channel
number for RFCOMM, or the port number for TCP or UDP. The description below talks about how the analyzer
auto-traverses from L2CAP using a dynamically assigned PSM, but the principle is the same for RFCOMM channel
numbers and TCP/UDP port numbers.

The analyzer looks for SDP Service Attribute Responses or Service Search Attribute Responses carrying protocol
descriptor lists. If the analyzer sees L2CAP listed with a PSM, it stores the PSM and the UUID for the next protocol
in the list.

After the SDP session is over, the analyzer looks at the PSM in the L2CAP Connect frames that follow. If the PSM
matches one the analyzer has stored, the analyzer stores the source channel ID and destination channel ID, and
associates those channel IDs with the PSM and UUID for the next protocol. Thereafter, when the analyzer sees
L2CAP frames using those channel IDs, it can look them up in its table and know what the next protocol is.

In order for the analyzer to be able to auto-traverse using a dynamically assigned PSM, it has to have seen the SDP
session giving the Protocol Descriptor Lists, and the subsequent L2ZCAP connection using the PSM and identifying
the source and channel IDs. If the analyzer misses any of this process, it is not able to auto-traverse. It stops
decoding at the L2CAP layer.

For L2CAP frames carrying a known PSM (0x0001 for SDP, for example, or 0x0003 for RFCOMM), the analyzer
looks for Connect frames and stores the PSM along with the associated source and destination channel IDs. In this
case the analyzer does not need to see the SDP process, but does need to see the L2CAP connection process,
giving the source and destination channel IDs.
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4.2.6 Providing Context For Decoding When Frame Information Is Missing

There may be times when you need to provide information to the analyzer because the context for decoding a
frame is missing. For example, if the analyzer captured a response frame, but did not capture the command frame
indicating the command.

The analyzer provides a way for you to supply the context for any frame, provided the decoder supports it. (The
decoder writer has to include support for this feature in the decoder, so not all decoders supportit. Note that not
all decoders require this feature.)

If the decoder supports user-provided context, three items are active on the Options menu of the Control
window and the Frame Display window. These items are Set Initial Decoder Parameters, Automatically
Request Missing Decoding Information, and Set Subsequent Decoder Parameters. (These items are
not present if no decoder is loaded that supports this feature.)

Set Initial Decoder Parameters is used to provide required information to decoders that is not context
dependent but instead tends to be system options for the protocol.

Choose Set Initial Decoder Parameters in order to provide initial context to the analyzer for a decoder. A
dialog appears that shows the data for which you can provide information.

If you need to change this information for a particular frame :
1. Right-click on the frame in the Frame Display window
2. Choose Provide <context name>.

Alternatively, you can choose Set Subsequent Decoder Parameter from the Options menu.
3. This option brings up a dialog showing all the places where context data was overridden.

4. If you know that information is missing, you can't provide it, and you don't want to see dialogs asking for it,
un-check Automatically Request Missing Decoding Information.

5. When unchecked, the analyzer doesn't bother you with dialogs asking for frame information that you don't
have. In this situation, the analyzer decodes each frame until it cannot go further and then simply stop
decoding.

4.3 Analyzing Protocol Decodes

4.3.1 The Frame Display

To open this window

Click the Frame Display icon @ on the Control window toolbar, or select Frame Display from the View
menu.

Frame Display Panes

The Frame Display window is used to view all frame related information. It is composed of a number of
different sections or "panes", where each pane shows a different type of information about a frame.

o Summary Pane - The Summary Pane displays a one line summary of each frame for every protocol found in
the data, and can be sorted by field for every protocol. Click here for an explanation of the symbols next to the
frame numbers.
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Decode Pane - The Decode Pane displays a detailed decode of the highlighted frame. Fields selected in the
Decode Pane have the appropriate bit(s) or byte(s) selected in the Radix, Binary, Character , and Event
panes

Radix Pane - The Radix Pane displays the logical data bytes in the selected frame in either hexadecimal,
decimal or octal.

Binary Pane - The Binary Pane displays a binary representation of the logical data bytes.

Character Pane - The Character Pane displays the character representation of the logical data bytes in either
ASCII, EBCDIC or Baudot.

Event Pane - The Event Pane displays the physical data bytes in the frame, as received on the network.

By default, all panes except the Event Pane are displayed when the Frame Display is first opened.

Protocol Tabs

Protocol filter tabs are displayed in the Frame Display above the Summary pane.

These tabs are arranged in separate color- .
coded groups. These groups and their imlm]i1=] ) © g = Classic Bluetooth (blue)
colors are General (white), Classic Bluetooth m St | e oL

(blue), Bluetooth low energy (green), LE BB | LE PKT | LE ADV |~

: —— _  Bluetooth low ener reen
802.11 (orange), USB (purple), NFC (brown) :m: — m::.m = o 9y (g ]-

and SD (teal). The General group applies to o i
all technologies. The other groups are kg T 802.11 (orange)

15.400
technology-specific. T

Clicking on a protocol filter tab in the General group filters in all packets containing that protocol regardless of
each packet’s technology.

Clicking on a protocol filter tab in a technology-specific group filters in all packets containing that protocol on
that technology.

A protocol filter tab appears in the General group only if the protocol occurs in more than one of the
technology-specific tab groups. For example, if L2CAP occurs in both Classic Bluetooth and Bluetooth low
energy, there will be L2CAP tabs in the General group, the Classic Bluetooth group, and the Bluetooth low
energy group.

Select the Unfiltered tab to display all packets.

There are several special tabs that appear in the Summary Pane when certain conditions are met. These tabs
appear only in the General group and apply to all technologies. The tabs are:

Bookmarks appear when a bookmark is first seen.

Errors appear when an error is first seen. An error is a physical error in a data byte or an error in the
protocol decode.

Info appears when a frame containing an Information field is first seen.

The tabs disappear when the capture buffer is cleared during live capture or when decoders are reloaded, even if
one of the tabs is currently selected. They subsequently reappear as the corresponding events are detected.
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Comparing Frames

If you need to compare frames, you can open additional Frame Display windows by clicking on the Duplicate
View icon ﬁ You can have as many Frame Display windows open at a time as you wish.

Frame Wrapping and Display

In order to assure that the data you are seeing in Frame Display are current, the following messages appear
describing the state of the data as it is being captured.

« All Frame Display panes except the Summary pane display "No frame selected" when the selected frame is
in the buffer (i.e. not wrapped out) but not accessible in the Summary pane. This can happen when a tab is
selected that doesn’t filter in the selected frame.

o When the selected frame wraps out (regardless of whether it was accessible in the Summary pane) all Frame
Display panes except the Summary pane display "Frame wrapped out of buffer".

o When the selected frame is still being captured, all Frame Display panes except the Summary pane display
"Frame incomplete".

4.3.1.1 Frame Display Toolbar

The buttons that appear in the Frame Display window vary according to the particular configuration of the

64

analyzer. For controls not available the icons will be grayed-out.

Table 4.1 - Frame Display Toolbar Icons

Icon Description

.@ Control — Brings the Control window to
the front.

r_,g Open File - Opens a capture file.

I/0 Settings - Opens the I/0 Settings
dialog.

e

Start Capture - Begins data capture to a
user designated file.

Stop Capture - Closes a capture file and
stops data capture to disk.

Save - Save the currently selected bytes
or the entire buffer to file.

Clear- Discards the temporary file and
clears the display.

Event Display — Brings the Event Display
window to the front.

E o/~ d 2|0

Show Statistics - Opens Statistics dialog
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Table 4.1 - Frame Display Toolbar Icons(continued)

Icon Description
Duplicate View - Creates a second Frame
ﬁ Display window identical to the first.
? Apply/Modify Display Filters - Opens the

Display Filter dialog.

Quick Protocol Filter - brings up a dialog
‘ﬁv box where you can filter or hide one or
more protocol layers.

Protocol Stack - brings up the Protocol
== Stack Wizard where you can change the
stack used to decode framed data

th

Reload Decoders - When Reload
Decoders is clicked, the plug-ins are
reset and received frames are re-
decoded. For example, If the first frame
occurs more than 10 minutes in the past,
the 10-minute utilization graph stays
blank until a frame from 10 minutes ago or
less is decoded.

Find - Search for errors, string patterns,
special events and more.

Display Capture Notes - Brings up the
Capture Notes window where you can
view or add notes to the capture file.

Add/Modify Bookmark - Add a new or
modify an existing bookmark.

E B U | &

Display All Bookmarks - Shows all
bookmarks and lets you move between
bookmarks.

Coexistence View - Opens the
Coexistence View

Extract Data - Opens the Extract Data
dialog.

& | ¢ B

Audio Extraction - Opens the Audio
Extraction dialog.

'

Pie Chart - This icon displays a chart that
displays the number of frames with and
without errors.

Frontline 802.11 Hardware & Software User Manual

TELEDYNE LECROY

65



TELEDYNE LECROY Chapter 4 Capturing and Analyzing Data

Table 4.1 - Frame Display Toolbar Icons(continued)
Icon Description

Reload Decoders - When Reload Decoders is clicked, the plug-ins are reset
and received frames are re-decoded. For example, If the first frame occurs
more than 10 minutes in the past, the 10-minute utilization graph stays blank
until a frame from 10 minutes ago or less is decoded.

Filter: Text giving the filter currently in
use. If nofilter is being used, the text
reads "All Frames" which means that
Filter: nothing is filtered out. To see the text of
the entire filter, place the cursor over the
text and a ToolTip pops up with the full
text of the filter.

The following icons all change how the panes are arranged on the Frame
Display. Additional layouts are listed in the View menu.

Show Default Panes - Returns the panes
to their default settings.

Show Only Summary Pane - Displays
only the Summary pane.

Shall All Panes Except Event Pane -
Makes the Decode pane taller and the
Summary pane narrower.

Toggle Display Lock - Prevents the
display from updating.

Go To Frame

First Frame - Moves to the first frame in
the buffer.

Previous Frame - Moves to the previous
frame in the buffer.

Next Frame - Moves to the next frame in
the buffer.

Last Frame - Moves to the last frame in
the buffer.

oo o e &= 0|0i

Find on Frame Display only searches the
Decode Pane for a value you enter in the
text box.

1
=
B
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Table 4.1 - Frame Display Toolbar Icons(continued)

Icon

Description

R

Find Previous Occurrence - Moves to the
previous occurrence of the value in the
Frame Display Find.

R

Find Next Occurrence - Moves to the next
occurrence of the value in the Frame
Display Find.

2

Cancel Current Search - Stops the
current Frame Display Find.

Summary:

Summary Drop Down Box: Lists all the
protocols found in the data in the file. This
box does not list all the protocol decoders
available to the analyzer, merely the
protocols found in the data. Selecting a
protocol from the list changes the
Summary pane to display summary
information for that protocol. When a low
energy predefined Named Filter (like
Nulls and Polls) is selected, the
Summary drop-down is disabled.

Summary: |Nnn-Captured Info "|

Text with Protocol Stack: To the right of the Summary Layer box is some text
giving the protocol stack currently in use.

- | Baseband with Auto-traverse

| summary: | Mon-Captured Info

TELEDYNE LECROY

Note: If the frames are sorted in other than ascending frame number order, the order of the
frames in the buffer is the sorted order. Therefore the last frame in the buffer may not have the

last frame number.

4.3.1.2 Frame Display Status Bar

The Frame Display Status bar appears at the bottom of the Frame Display. It contains the following

information:

« Frame #s Selected: Displays the frame number or numbers of selected (highlighted) frames, and the total
number of selected frames in parentheses

o Total Frames: The total number of frames in the capture buffer or capture file in real-time

« Frames Filtered In: The total number of frames displayed in the filtered results from user applied filters in

real-time
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4.3.1.3 Hiding and Revealing Protocol Layers in the Frame Display

Hiding protocol layers refers to the ability to prevent a layer from being displayed on the Decode pane. Hidden
layers remain hidden for every frame where the layer is present, and can be revealed again at any time. You can
hide as many layers as you wish.

Note: Hiding from the Frame Display affects only the data shown in the Frame Display and not any
information in any other window.

There are two ways to hide a layer.
1. Right-click on the layer in the Decode pane, and choose Hide [protocol name] Layer In All Frames.

2. Click the Set Protocol Filtering button on the Summary pane toolbar. In the Protocols to Hide box
on the right, check the protocol layer(s) you want hidden. Click OK when finished.

To reveal a hidden protocol layer:
1. Right-click anywhere in the Decode pane

2. Choose Show [protocol name] Layer from the right-click menu, or click the Set Protocol Filtering
button and un-check the layer or layers you want revealed.

4.3.1.4 Physical vs. Logical Byte Display

The Event Display window and Event Pane in the Frame Display window show the physical bytes. In other
words, they show the actual data as it appeared on the circuit. The Radix, Binary and Character panes in the Frame
Display window show the logical data, or the resulting byte values after escape codes or other character altering
codes have been applied (a process called transformation).

As an example, bytes with a value of less than 0x20 (the Ox indicates a hexadecimal value) cannot be transmitted
in Async PPP. To get around this, a 0x7d is transmitted before the byte. The 0x7d says to take the next byte and
subtract 0x20 to obtain the true value. In this situation, the Event pane displays 0x7d 0x23, while the Radix pane
displays 0x03.

4.3.1.5 Sorting Frames

By default, frames are sorted in ascending numerical sequence by frame number. Click on a column header in the
Summary pane to sort the frames by that column. For example, to sort the frames by size, click on the Frame
Size column header.

An embossed triangle next to the header name indicates which column the frames are sorted by. The direction of
the triangle indicates whether the frames are in ascending or descending order, with up being ascending.

Note that it may take some time to sort large numbers of frames.

4.3.1.6 Frame Display - Find

Frame Display has a simple Find function that you can use to search the Decode Pane for any alpha numeric
value. This functionality is in addition to the more robust Search/Find dialog.

Frame Display Find is located below the toolbar on the Frame Display dialog.
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Figure 4.16 - Frame Display Find text entry field
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Where the more powerful Search/Find functionality searches the Decode, Binary, Radix, and Character panes
on Frame Display using Timestamps, Special Events, Bookmarks, Patterns, etc.,

% Find =33

Decods | Pattem | Time

Searchfor (&hbaokie
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by

= [_geto ]
: (e ]

Mirwte Second 11000000 Second:
x ¢ S ML = | | 931000 ;

-

'@ Oirs of besd oo s spescifnd e
) On or after the rpacified tme

Figure 4.17 - Search/Find Dialog

Find on Frame Display only searches the Decode Pane for a value you enter in the text box.

To use Find:

1. Select the frame where you want to begin the search.

2. Enter avalue in the Find text box.

| Find:

Antenna: True

Note: The text box is disabled during a live capture.

3. Select Find Previous Occurrence ﬁ to begin the search on frames prior to the frame you selected,

or Find Next Occurrence ﬁ to begin the search on frames following the frame you selected.
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db Arterna Signat Trus The next occurrence of the value (if it is found) will be highlighted in
the Decode Pane.

dben Transmd Atberausation: Fales
db Tranemit Albernestion: False

4, Select Find Previous Occurrence or Find Next Occurrence to
continue the search.

There are several important concepts to remember with Find.
« When you enter a search string and select Enter, the search moves forward.

« Ifyou select Find Previous Occurrence, when the search reaches the first frame it will then cycle to the
last frame and continue until it reaches the frame where the search began.

e Shift + F3 is a shortcut for Find Previous Occurrence.

« Ifyou select Find Next Occurrence, when the search reaches the last frame it will then cycle to the first
frame and continue until it reaches the frame where the search began.

o F3isashortcut for Find Next Occurrence.

« You cannot search while data is being captured.

o After a capture is completed, you cannot search until Frame Display has finished decoding the frames.
« Find is not case sensitive.

o The status of the search is displayed at

the bottom of the dialog. Tokal Frames:| 259 | Frames Filkered In; | 259 Frame #s Selecked:  201; (1

e The search occurs only on the Search for "Antenna: True” results” ***Found***
protocol layer selected.

o To search across all the protocols on
the Frame Display, select the
Unfiltered tab.

e A drop-down list displays the search values entered during the current
session of Frame Display. w

e The search is cancelled when you select a different protocol tab during a
search.

o You can cancel the search at any time by selecting the Cancel Current
Search 45) button.

4.3.1.7 Synchronizing the Event and Frame Displays

The Frame Display is synchronized with the Event Display. Click on a frame in the Frame Display and the
corresponding bytes is highlighted in the Event Display. Each Frame Display has its own Event Display.

As an example, here's what happens if the following sequence of events occurs.
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1. Click on the Frame Display icon @ in Control window toolbar to open the Frame Display.

2. Click on the Duplicate View icon ﬁ to create Frame Display #2.

3. Click on Event Display icon p in Frame Display #2. Event Display #2 opens. This Event

Display is labeled #2, even though there is no original Event Display, to indicate that it is synchronized
with Frame Display #2.

4. Click on aframe in Frame Display #2. The corresponding bytes are highlighted in Event Display #2.
5. Click on aframe in the original Frame Display. Event Display #2 does not change.
4.3.1.8 Working with Multiple Frame Displays

Multiple Frame Displays are useful for comparing two frames side by side. They are also useful for comparing all
frames against a filtered subset or two filtered subsets against each other.

« To create a second Frame Display, click the Duplicate View icon @. on the Frame Display toolbar.
This creates another Frame Display window. You can have as many Frame Displays open as you wish.
Each Frame Display is given a number in the title bar to distinguish it from the others.

¢ To navigate between multiple Frame Displays, click on the Frame Display icon EI in the Control window
toolbar.
A drop-down list appears, listing all the currently open Frame Displays.

« Selectthe one you want from the list and it comes to the front.

Note: When you create afilter in one Frame Display, that filter does not automatically
appear in the other Frame Display. You must use the Hide/Reveal feature to display a
filter created in one Frame Display in another.

Note: When you have multiple Frame Display windows open and you are capturing data, you
may receive an error message declaring that "Filtering cannot be done while receiving data
this fast." If this occurs, you may have to stop filtering until the data is captured.

4.3.1.9 Working with Panes on Frame Display

When the Frame Display first opens, all panes are displayed except the Event pane (To view all the panes,
select Show All Panes from the View menu).

« The Toggle Expand Decode Pane icon Dj makes the decode pane longer to view lengthy decodes
better.

« The Show Default Panes icon % returns the Frame Display to its default settings.
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o The Show only Summary Pane icon D displays on the Summary Pane.

To close a pane, right-click on the pane and select Hide This Pane from the pop-up menu, or de-select Show
[Pane Name] from the View menu.

To open a pane, right-click on the any pane and select Show Hidden Panes from the pop-up menu and select
the pane from the fly-out menu, or select Show [Pane Name] from the View menu.

To re-size a pane, place the cursor over the pane border until a double-arrow cursor appears. Click and drag on
the pane border to re-size the pane.

4.3.1.10 Frame Display - Byte Export
The captured frames can be exported as raw bytes to a text file.

1. From the Frame Display File menu select Byte Export....

&) Frame Display - le - (modified channel maps) HID_kbd-cant_decrypt.
Edit View Format Filter Bookmarks Options Window

Go Live

Open Capture File...
Close
Save

Save Selection
Reframe...

1 le - (modified channel maps) HID_kbd-cant_decrypt GATT.cfa
2 example_btsnoop_hcilog.cfa

3 C\Users\..\BPA500.cfa

4 C:\Users\..\SDIO_20121005.cfa

Print...

Print Preview...

Export...
Byte Export...
HTML Export...

Reload Decoders

Recreate Companien File

Figure 4.18 - Frame Display File menu, Byte Export
2. From the Byte Export window specify the frames to export.

« All Frames exports all filtered-in frames including those scrolled off the Summary pane. Filtered-in
frames are dependent on the selected Filter tab above the Summary pane. Filtered-out frames are
not exported.

o Selected Frames export is the same as All Frames export except that only frames selected in the
Summary pane will be exported.
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Click the OK button to save the export. Clicking the Cancel button will exit Byte Export.

Byte Export 22

Export raw bytes from the currently selected filter tab

(@) All Frames

() Selected Frames

[ oK ll Cancel ]

Figure 4.19 - Byte Export dialog
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3. The Save As dialog will open. Select a directory location and enter a file name for the exported frames

file.

File name: BytelevelExport 1.t

&) Save As 2
@vvlu Desktop » v|$7|| arch Desktoy ol
Organize v New folder B @

-
- - . -
/% Favorites Mame Size Ttem type
Bl Desktop i 4 Libraries
4 Downloads A John W. Trinkle =
| Recent Places 18 Computer
Gi Metwork
- Libraries Frontline ComProb... File folder
3 Documents Frontline ComProb... File folder
rJ“- Music Frontline ComProb... File folder
[l Pictures Frontline ComProb... File folder
= Subversion e S -

Save as type: | Text Files (*.xt)

“ Hide Folders

[ Save I l

Cancel

Click on the Save button.

Figure 4.20 - Save As dialog

The exported frames are in a text file that can be opened in any standard text editing application. The header
shows the export type, the capture file name, the selected filter tab, and the number of frames. The body shows
the frame number, the timestamp in the same format shown in the Frame Display Summary pane, and the

frame contents as raw bytes.
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" ByteLevelExpart_Lixt - Notepad o= X

File Edit Format View Help

Byte export of all filtered-in frames -~
Capture file: "le - (modified channel maps) HID kbd-cant_decrypt_GATT.cfa"

Filter tab: "Unfiltered"

1,299 frames exported

rame Number,Timestamp, Frame Contents
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Figure 4.21 - Sample Exported Frames Text File
4.3.1.11 Panes in the Frame Display
4.3.1.11.1 Summary Pane

The Summary pane D displays a one-line summary of every frame in a capture buffer or file, including frame

number, timestamp, length and basic protocol information. The protocol information included for each frame
depends on the protocol selected in the summary layer box (located directly below the main toolbar).

On a two-channel circuit, the background color of the one-line summary indicates whether the frame came from
the DTE or the DCE device. Frames with a white background come from the DTE device, frames with a gray
background come from the DCE device.

Frame numbers in red indicate errors, either physical (byte-level) or frame errors. If the error is a frame error in
the displayed protocol layer, the bytes where the error occurred is displayed in red. The Decode Pane gives
precise information as to the type of error and where it occurred.

The Summary pane is synchronized with the other panes in this window. Click on a frame in the Summary
pane, and the bytes for that frame is highlighted in the Event pane while the Decode pane displays the full
decode for that frame. Any other panes which are being viewed are updated accordingly. If you use one pane to
select a subset of the frame, then only that subset of the frame is highlighted in the other panes.

Protocol Tabs
Protocol filter tabs are displayed in the Frame Display above the Summary pane.

o These tabs are arranged in separate color-coded groups. These groups and their colors are General (white),
Classic Bluetooth (blue), Bluetooth low energy (green), 802.11 (orange), USB (purple), and SD (brown). The
General group applies to all technologies. The other groups are technology-specific.

im]m]i=]: [5) @r.»__ Classic Bluetooth (blue).

[EEEEE bockmarks | Infe_ L= pm™

Bassband | LZCAP | TCS | ; .
LE BB | LE PET | LE AV | = )

BOZ11 Fade | BOZ.11 MAC | Dota | —___ Bluetooth low energy (green)

B

Framell

15.6M “'u.““.”“j —— .
g . 802.11 (orange) |
1E &

Figure 4.22 - Example Protocol Tags
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« Clicking on a protocol filter tab in the General group filters in all packets containing that protocol regardless of
each packet’s technology.

« Clicking on a protocol filter tab in a technology-specific group filters in all packets containing that protocol on
that technology.

« A protocol filter tab appears in the General group only if the protocol occurs in more than one of the
technology-specific tab groups. For example, if L2CAP occurs in both Classic Bluetooth and Bluetooth low
energy , there will be L2CAP tabs in the General group, the Classic Bluetooth group, and the Bluetooth low
energy group.

Select the Unfiltered tab to display all packets.

There are several special tabs that appear in the Summary pane when certain conditions are met. These tabs
appear only in the General group and apply to all technologies. The tabs are:

« Bookmarks appear when a bookmark is first seen.

o Errors appear when an error is first seen. An error is a physical error in a data byte or an error in the
protocol decode.

« Info appears when a frame containing an Information field is first seen.

The tabs disappear when the capture buffer is cleared during live capture or when decoders are reloaded, even if
one of the tabs is currently selected. They subsequently reappear as the corresponding events are detected.

The tabs disappear when the capture buffer is cleared during live capture or when decoders are reloaded, even if
one of the tabs is currently selected. They subsequently reappear as the corresponding events are detected.

Use the navigation icons, keyboard or mouse to move through the frames. The icons @ and @ move you to

the first and last frames in the buffer, respectively. Use the Go To icon ﬂa to move to a specific frame number.

Placing the mouse pointer on a summary pane header with truncated text displays a tooltip showing the full
header text.

) Frame Display - HTC_Headset A2DP.cfa (=] & [

File Edit View Format Filter Bookmarks Options Window Help
@2 LPHG VYE =2 MDMUMAASG i 8
( &) indl

: ;yamem,usa (Master) Len=36 - D ﬂa o @ - D@ ﬁ 'f)l Summary: |SDP
nf figured BT low energy devices | Enors

|
ction-FHS | BI FHS | L2cAP (TSR RFCOMM | AVDTP | AVDTF Signaling |
| A2DP | Non-Captured Info |

.o 2 8. Framett Roke

Clock: 0400003c3
Packet Status: 0K
FLOW: Go 10,054
TYPE: DH1 0102
LT_ADDR: 1 10,104 Master
{-SEON:O 0134 Slave
i -ARON:O & 10135 Master

PaamL.. ULID/Sve Handle Fram.. Della

00:00:00.C

5t

0:0000  Search/Atiib Requ.. 19 Handsfiee 40 00:00:00.4

0:0000  Searchdétib Resp.. 39 60 00:00:00.C

050000 Searchditib Requ.. 19 AudioSirk 40 00:00:00.7

040000 Search/itiib Resp.. 43 &4 00:00:00C
0

Total Frames: 28,707 Frames FiteredIn; 18 Frame #5 Selected: | 10,053; (1 total)

For Help Press F1

Figure 4.23 - Summary pane (right) with Tooltip on Column 5 (Tran ID)

4.3.1.11.2 Customizing Fields in the Summary Pane

You can modify the Summary Pane in Frame Display.

Summary pane columns can be reordered by dragging any column to a different position.
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Fields from the Decode pane can be added to the summary pane by dragging any Decodepane field to the
desired location in the summary pane header. If the new field is from a different layer than the summary pane a
plus sign (+) is prepended to the field name and the layer name is added in parentheses. The same field can be
added more than once if desired, thus making it possible to put the same field at the front and back (for example)
of a long header line so that the field is visible regardless of where the header is scrolled to.

An added field can be removed from the Summary pane by selecting Remove New Column from the right-
click menu.

The default column layout (both membership and order) can be restored by selecting Restore Default
Columns from the Format or right-click menus.

Changing Column Widths
To change the width of a column:
1. Place the cursor over the right column divider until the cursor changes to a solid double arrow.
2. Click and drag the divider to the desired width.
3. To auto-size the columns, double-click on the column dividers.
Hiding Columns
To hide a column:
1. Drag the right divider of the column all the way to the left.
2. The cursor changes to a split double arrow when a hidden column is present.

3. To show the hidden column, place the cursor over the divider until it changes to a split double arrow, then
click and drag the cursor to the right.

4. The Frame Size, Timestamp, and Delta columns can be hidden by right-clicking on the header and
selecting Show Frame Size Column, Show Timestamp Column, or Show Delta Column. Follow
the same procedure to display the columns again.

Moving Columns - Changing Column Order
To move a column :
1. Click and hold on the column header
2. Dragthe mouse over the header row.
3. A small white triangle indicates where the column is moved to.
4. When the triangle is in the desired location, release the mouse.
Restoring Default Column Settings
To restore columns to their default locations, their default widths, and show any hidden columns

1. Right-click on any column header and choose Restore Default Column Widths, or select Restore
Default Column Widths from the Format menu.
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4.3.1.11.3 Frame Symbols in the Summary Pane

Table 4.2 - Frame Symbols
Symbol Description

A green dot means the frame was decoded successfully, and the protocol listed in the Summary
Layer drop-down box exists in the frame. No dot means the frame was decoded successfully, but the
protocol listed in the Summary Layer drop-down box does not exist in the frame.

A green circle means the frame was not fully decoded. There are several reasons why this might
happen.

o One reason is that the frame compiler hasn't caught up to that frame yet. It takes some time for
the analyzer to compile and decode frames. Frame compilation also has a lower priority than other
tasks, such as capturing data. If the analyzer is busy capturing data, frame compilation may fall
behind. When the analyzer catches up, the green circle changes to either a green dot or no dot.

o Another reason is if some data in the frame is context dependent and we don't have the context.
An example is a compressed header where the first frame gives the complete header, and
subsequent frames just give information on what has changed. If the analyzer does not capture the
first frame with the complete header, it cannot decode subsequent frames with partial header
information.

- A magenta triangle indicates that a bookmark is associated with this frame. Any comments associated
with the bookmark appear in the column next to the bookmark symbol.

4.3.1.11.4 Decode Pane

The Decode pane (aka detail pane) I:D is a post-process display that provides a detailed decode of each frame

transaction (sometimes referred to as a frame). The decode is presented in a layered format that can be
expanded and collapsed depending on which layer or layers you are most interested in. Click on the plus sign to
expand a layer. The plus sign changes to a minus sign. Click on the minus sign to collapse a layer. Select Show All
or Show Layers from the Format menu to expand or collapse all the layers. Layers retain their expanded or
collapsed state between frames.

Protocol layers can be hidden, preventing them from being
_ displayed on the Decode pane. Right-click on any protocol layer
Hide "L2CAP" Layer In All Frames and choose Hide [protocol name] from the right-click menu.

| v Expand All Nodes

Provide AVDTP Rules... Each protocol layer is represented by a color, which is used to
highlight the bytes that belong to that protocol layer in the
Event, Radix, Binary and Character panes. The colors are not
assigned to a protocol, but are assigned to the layer.

The Event, Radix, Binary, Character and Decode panes are all synchronized with one another. Clicking on an
element in any one of the panes highlights the corresponding element in all the other panes.

Click the Toggle Expand Decode Pane icon [D to make the Decode pane taller. This allows for more of a

lengthy decode to be viewed without needing to scroll.
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4.3.1.11.5 Radix or Hexadecimal Pane

The Radix pane displays the logical bytes in the frame in either
hexadecimal, decimal or octal. The radix can be changed from
the Format menu, or by right-clicking on the pane and
choosing Hexadecimal, Decimal or Octal.

Because the Radix pane displays the logical bytes rather than
the physical bytes, the data in the Radix pane may be different
from that in the Event pane. See Physical vs. Logical Byte Display
for more information.

Colors are used to show which protocol layer each byte belongs
to. The colors correspond to the layers listed in the Decode
pane.

Chapter 4 Capturing and Analyzing Data
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This is the Radix Pane
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Copy Selection to Clipboard
Select Entire Frame

Change Text Highlight Color...
Hexadecimal

Decimal

Octal

The Event, Radix, Binary, Character and Decode panes are all synchronized with one another. Clicking on an
elementin any one of the panes highlights the corresponding element in all the other panes.

4.3.1.11.6 Character Pane

The Character pane represents the logical bytes in the frame
in ASCII, EBCDIC or Baudot. The character set can be
changed from the Format menu, or by right-clicking on the
pane and choosing the appropriate character set.

Because the Character pane displays the logical bytes rather
than the physical bytes, the data in the Character pane may
be different from that in the Event pane. See Physical vs.
Logical Byte Display for more information.

Colors are used to show which protocol layer each byte
belongs to. The colors correspond to the layers listed in the
Decode pane.

The Event, Radix, Binary, Character and Decode panes
are all synchronized with one another. Clicking on an element

mMZz@=1 om=C=n0eT0)

g o P 1
-

Mo 8 C 5 5 RN D
This is the Character Pane
Copy Selection to Clipboard
Select Entire Frame

Change Text Highlight Celor...
ASCH

7-bit ASCI

EBCDIC

Baudot

in any one of the panes highlights the corresponding element in all the other panes.

4.3.1.11.7 Binary Pane

The Binary pane displays the logical bytes in the frame in binary.

Because the Binary pane displays the logical bytes rather than the physical bytes, the data in the Binary pane may

be different from that in the Event pane. See Physical vs. Logical Byte Display for more information.

Colors are used to show which protocol layer each byte belongs to. The colors correspond to the layers listed in

the Decode pane.

The Event, Radix, Binary, Character and Decode panes are all synchronized with one another. Clicking on an

elementin any one of the panes highlights the corresponding element in all the other panes.
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4.3.1.11.8 Event Pane

The Event pane shows the physical bytes

in the frame. You can choose between [I]E R 2a 28 3~ 1Ff 0OW at ha
displaying only the data events or ﬁ 0 This is the Event Pane
displaying all events by clicking the All T1
Events icon | | |. e Copy Selection to Clipboard
’ ﬁ Select Entire Frame

) . ) E
Displaying all events means that special Change Text Highlight Color...
events, such as Start of Frame, End of i
Frame and any signal change events, are v Display All Events

displayed as special symbols within the
data.

The status lines at the bottom of the pane give the same information as the status lines in the Event Display
window. This includes physical data errors, control signal changes (if appropriate), and timestamps.

Because the Event pane displays the physical bytes rather than the logical bytes, the data in the Event pane may
be different from that in the Radix, Binary and Character panes. See Physical vs. Logical Byte Display for more
information.

Colors are used to show which protocol layer each byte belongs to. The colors correspond to the layers listed in
the Decode pane.

The Event, Radix, Binary, Character and Decode panes are all synchronized with one another. Clicking on an
elementin any one of the panes highlights the corresponding element in all the other panes.

4.3.1.11.9 Change Text Highlight Color

Whenever you select text in the Binary, Radix, or T 5|
Character panes in Frame Display, the text is displayed e T -
with a highlight color. You can change the color of the —
highlight. Select Colar: |-| I 0k, I
N EEEn ——
1. Select Change Text Highlight Color from the EEEE Cancel
Options menu. You can also access the option by EEEE
right clicking in any of the panes. EETE Dsfaults
2. Selecta color from the drop-down menu. HEEN
Other...
3. Click OK. [ Other.. |

The highlight color for the text is changed.

Select Cancel to discard any selection. Select Defaults to return the highlight color to blue.

4.3.1.12 Protocol Layer Colors

4.3.1.12.1 Data Byte Color Notation

The color of the data in the panes specifies which layer of the protocol stack the data is from. All data from the
first layer is bright blue, the data from the second layer is green, the third layer is pink, etc. The protocol name for
each layer in the Decode pane is in the same color. Note that the colors refer to the layer, not to a specific
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protocol. In some situations, a protocol may be in two different colors in two different frames, depending on
where it is in the stack. You can change the default colors for each layer.

Red is reserved for bytes or frames with errors. In the Summary pane, frame numbers in red mean there is an
error in the frame. Also, the Errors tab is displayed in red. This could be a physical error in a data byte or an error
in the protocol decode. Bytes in red in the Radix, Character, Binary and Event panes mean there is a physical
error associated with the byte.

4.3.1.12.2 Red Frame Numbers and Bytes

Red is reserved for bytes or frames with errors. In the Summary pane, frame numbers in red mean there is an
error in the frame. This could be a physical error in a data byte or an error in the protocol decode.

4.3.1.12.3 Changing Protocol Layer Colors
You can differentiate different protocol layers in the Decode, Event, Radix, Binary and Character panes.
1. Choose Select Protocol Layer Colors from the Options menu to change the colors used.
The colors for the different layers is displayed.
2. To change a color, click on the arrow next to each layer and select a new color.
3. Select OK to accept the color change and return to Frame Display.

Select Cancel to discard any selection. Select Defaults to return the highlight colors to the default settings.

Protocol Layer Color Selector

Layer1:  Abcd |*| Layers  Abed |'| 0Ok
Laper 20 Abcd |v Laver10: NN Cancel

o HEENR
Layer 3 Abcd |' Laper 11: HUEE Defaults

Layer 4 Abed |v Layer 12 BT
Layer 5 Abed |v| Layer 13: EREE
Layer 5 &bed |v| Laper 14

Layer 7:  Abed |v Loy 115 |v|

Laper 8 Abod TR0 |- Layer 16:  Abcd T |-

kg

Figure 4.24 - Frame Display Protocol Layer Color Selector

4.3.1.13 Filtering

Filtering allows the user to control the display which capture frames are displayed. Filters fall into two general
categories:

1. Display filters allow a user to look at a subset of captured data without affecting the capture content.
Frames matching the filter criteria appear in the Frame Display; frames not matching the criteria will not
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appear.
2. Connection filters Two options are available.

a. A Bluetooth connection: Displays only the frames associated with a Classic Bluetooth link or a
Bluetooth low energy access address. A new Frame Display will open showing only the protocol
tabs, frames, summary, and events associated with that particular Bluetooth connection.

b. A specific wireless or wired technology. Displays all of the frames associated with:
« Classic Bluetooth
o Bluetooth low energy
« 802.11
o HCI

A new Frame Display will open showing only the protocol tabs, frames, summary and events
associated with the selected technology.

4.31.13.1 Display Filters

A display filter looks at frames that have already been captured. It looks at every frame in the capture buffer and
displays those that match the filter criteria. Frames that do not match the filter criteria are not displayed. Display
filters allow a user to look at a subset of captured data without affecting the capture content. There are three
general classes of display filters:

e Protocol Filters
« Named Filters
o Quick Filter
Protocol Filters

Protocol filters test for the existence of a specific single layer. The system creates a protocol filter for each
decoder that is loaded if that layer is encountered in a capture session.

There are also three special purpose filters that are treated as protocol filters:
o All Frames with Errors

o All Frames with Bookmarks

« All Special Information Nodes

Named Filters

« Named filters test for anything other than simple single layer existence. Named filters can be constructed that
test for the existence of multiple layers, field values in layers, frame sizes, etc., as well as combinations of
those things. Named filters are persistent across sessions.

« Named filters are user-defined. User-defined filters persist in a template file. User defined filters can be
deleted.
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Quick Filters

o Quick Filters are combinations of Protocol Filters and/or Named Filters that are displayed on the Quick Filter
tab.

o Quick Filters cannot be saved and do not persist across sessions.

o Quick Filters are created on the Quick Filter Dialog.

4.3.1.13.1.1 Creating a Display Filter

There are two steps to using a display filter. Define the filter conditions, and then apply the filter to the data set.
The system combines both filter definition and application in one dialog.

1. Click the Display Filters icon ? on the Frame Display@ window or select Apply/Modify

Display Filters from the Filter menu to open the Set Condition dialog box. The Set Condition dialog is
self configuring which means that when you Select each frame under Conditions the following
displayed fields depend on your selection. With each subsequent selection the dialog fields will change
depending on you selection in that field.

Set Condition | £

Currently Active Condition: <Untitled:

@ Include

) Exclude

Condition

Select each frame | where the protocol v]

[weTP -

[field

)

[ Command/Responze

v] [Is Mot Present

| [ Fields)

[ ok

][ Cancel ][ Help

Figure 4.25 - Example: Set Conditions Self Configuring Based on Protocol Selection

- R
Set Condition &J
Currently Active Condition: <Untitled>
@ Include () Exclude
Condition
Select each frame [in the range -
187 to 234
[Enter decimal numbers by typing in the number
directly, and hexadecimal numbers by starting
the number with 0x]
5% [ carce ] [
\

Figure 4.26 - Example: Set Conditions Self Configuring Based on Frame Range

2. Select Include or Exclude to add filtered data or keep out filtered data respectively.

3. Select the initial condition for the filter from the drop-down list.
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4. Setthe parameters for the selected condition in the fields provided. The fields that appear in the dialog
box are dependent upon the previous selection. Continue to enter the requested parameters in the fields
provided until the condition statement is complete.

5. Click OK. The system displays the Save Named Condition dialog. Provide a name for the filter condition
or accept the default name provided by the system and click OK. Prohibited characters are left bracket [,
right bracket ']’ and equal sign '=". The Set Condition dialog box closes, creates a tab on the Frame
Display with the filter name, and applies the filter.

The filter also appears in the Quick Filtering and Hiding Protocols dialog.

When a display filter is applied, a description of the filter appears to the right of the toolbar in the Frame Display
windows.

Notes:
o The system requires naming and saving of all filters created by the user.

« The OK button on the Set Condition dialog box is unavailable (grayed out) until the condition selections are
complete.

« When you have multiple Frame Display windows with a display filter or filters, those filter do not automatically
appear in other Frame Display windows. You must use the Hide/Reveal feature to display a filter created in
one Frame Display in different Frame Display window.

4.3.1.13.1.2 Including and Excluding Radio Buttons

All filter dialog boxes contain an Include and an Exclude radio button. These buttons are mutually exclusive. The
Include/Exclude selection becomes part of the filter definition, and appears as part of the filter description
displayed to the right of the Toolbar.

Include: A filter constructed with the "Include" button selected, returns a data set that includes frames that meet
the conditions defined by the filter and omits frames that do not.

Exclude: A filter constructed with the "Exclude" button selected, returns a data set that excludes frames that
meet the conditions defined by the filter and consists of frames that do not.

4.3.1.13.1.3 Named Display Filters

You can create a unique display filter by selecting a data type on the Frame Display and using a right click menu.
When you create a Name Filter, it appears in the Quick Filtering dialog, where you can use it do customize the
data you see in the Frame Display panes.

1. Select aframe in the Frame Display Summary Pane.

2. Rightclick in the one of the data columns in the Summary Pane: CRC, NESN, DS, Packet Success,
Ethertype, Source Address, etc.
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3. Select Filter in (data type) = . The Filtering Results

. Filtering Results
dialog appears.

4. Enter a name for the filter

5. Select OK.
Filter Mame:
The filter you just created appears in the Named Filters section ASCIL: . ...3

of the Quick Filtering dialog.

OK | | Cancel

4.3.1.13.1.4 Using Compound Display Filters

Compound filters use boolean logic to create complex and precise filters. There are three primary Boolean logic
operators: AND, OR, and NOT.

The AND operator narrows the filter, the OR operator broadens the filter, and the NOT operator excludes
conditions from the filtered results. Include parentheses in a compound filter to nest condition sets within larger
condition sets, and force the filter-processing order.

There are two steps to using a compound filter. Define the filter conditions, and then apply the filter to the data
set. The analyzer combines both filter definition and application in one dialog.

1. Click the Display Filters icon ? on the Frame Display window or select Apply/Modify Display
Filters... from the filter menu to open the Set Condition dialog box.

2. Click the Advanced button on the Set Condition dialog box.

3. Select Include or Exclude radio button.
Now you can set the conditions for the filter.

4. Select the initial condition for the filter from the
combo box at the bottom of the dialog for Select
each frame.

Condition

Select each frame | where the protocal w

5. Setthe parameters for the selected condition in with the conversation
the fields provided. The fields that appear in the L:ittmr::r;?;
dialog box are dependent upon the previous
selection. Continue to enter the requested
parameters in the fields provided until the
conditions statement is complete.

[ NOT Condition ] ANDA.

vwhere the protocol 7777 exists AND

w | where the protocol ' FFFTETETER Y aigt W

X & [= [+

Figure 4.27 - Two Filter Conditions Added with an AND Operator
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6. Click the plusicon ﬂ on the left side of the dialog box and repeat steps 4 and 5 for the next condition.

Use the up ﬂ and down ﬂ arrow icons on the left side of the dialog box to order your conditions, and

the delete button * |to delete conditions from your filter.

7. Continue adding conditions until your filter is complete.
8. Include parentheses as needed and set the boolean operators.
9. Click OK.

10. The system displays the Save Named Condition dialog. Provide a name for the filter condition or accept
the default name provided by the system and click OK.

Save Mamed Condition

MHame Thiz Condition: 0

|
L Cancel

I1zer Defined Conditions;

| FilterD

Help

Figure 4.28 - Save Named Filter Condition Dialog

The Set Condition dialog box closes, creates a tab on the Frame Display with the filter name, and applies the
filter.

When a display filter is applied, a description of the filter
Filter: Include each frame where the protocol Data exists appears to the right of the toolbar in the Frame
Display windows.

Note: The OK button on the Set Condition dialog box is unavailable (grayed out) until the
condition selections are complete.
4.3.1.13.1.5 Defining Node and Conversation Filters

There are two steps to using Node and Conversation display filter. Define the filter conditions, and then apply the
filter to the data set. The analyzer combines both filter definition and application in one dialog.

1. Click the Display Filters icon ? on the Frame Display window or select Apply/Modify Display
Filters... from the filter menu to open the Set Condition dialog box.
2. From the Select each frame combo box choose frames with the conversation as the initial condition.

3. Selectan address type—IP, MAC, TCP/UDB—from the Typecombo box (The address type selection
populates both Address combo boxes with node address in the data set that match the type selection).

Frontline 802.11 Hardware & Software User Manual 85



TELEDYNE LECROY Chapter 4 Capturing and Analyzing Data

8.

Select a node address from the first Address combo box.

Choose a direction arrow from the direction box . The left arrow filters on all frames

where the top node address is the destination, the right arrow filters on all frames Crmm -

where the top node address is the source, and the double arrow filters on all frames s

where the top node address is either the source or the destination. - |
=

If you want to filter on just one node address, skip step 7 and continue with step 8.

If you want to filter on traffic going between two address nodes (i.e. a conversation), select a node address
from the second Address combo box..

Click OK. The Set Condition dialog box closes and the analyzer applies the filter.

When a display filter is applied, a description of the filter appears to the right of the toolbar in the Frame Display
windows.

Note: The OK button is unavailable (grayed out) until the condition selections are complete.

4.3.1.13.1.6 The Difference Between Deleting and Hiding Display Filters

If you wish to remove a filter from the system permanently, then use the Delete procedure. However, if all you
want to do is remove a filter as a means to un-clutter the display, then use the Hide procedure.

Deleting a saved filter removes the filter from the current session and all subsequent sessions. In order to retrieve
a deleted filter, the user must recreate it using the Set Conditions dialog.

Hiding a filter merely removes the filter from the display. A hidden filter can be reapplied using the Show/Hide
procedure.

Deleting Saved Display Filters

Hiding and Revealing Display Filters

1.

Select Delete Display Filters from the Filter

menu in the Frame Display @ window to Delete Named Conditions X
open the Delete Named Condition dialog. et [::S“E;Td °°;‘di“°”3: [ ok |
The system displays the Delete Named Eglter1n' U Cancel
Condition dialog with a list of all user defined Fito2
filters : E:IE:E —
. lf
Fitert [ Heb |
Fole: Slave
Select the filter to be deleted from the list. SCO fink: Supported

Click the Delete button.

Click OK. The Delete Named Condition
dialog box closes and the system deletes the
filter.

If a display filter is showing the following steps will hide
that filter but will not delete it.
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1. Select Hide/Show Display
Filters... from the Filter menu on the

Frame Display@ window to open

the Hide/Show Filters dialog. The
system displays the Hide/Show

TELEDYNE LECROY

' -
Hide/Show Filters @
Filters
[ascr: . .3 . - Show
Description

Filters diaIOg with a list of all user Fndude each frame where the protocol "Data” field ASCII Contains the Substring ™.
defined filters. b3

[ oK ] [ Cancel l [ Help l

Select the filter to be hidden from the
combo box. “

Click the Hide button. The Hide button is only showing if the selected filter is currently showing in the
Frame Display.

Click OK. The Hide/Show Filters dialog box closes, and the system hides the filter and removes the filter
tab from the Frame Display.

If a display filter is hidden the following steps will reveal that filter in the Frame Display.

1.

Select Hide/Show Display Filters... from the Filter menu in the Frame Display EI window to

open the Hide/Show Filters dialog. The system displays the Hide/Show Filters dialog with a list of all
user defined filters.

. Select the filter to be revealed from the combo box.

Click the Show button.

Click OK. The Hide/Show Filters dialog box closes and the system reveals the filter in the Frame
Display.

You can also open the Quick Filter dialog and check the box next to the hidden filter to show or hide a display

filter.

Hamed Filters

[|Filterd
Flascl. .3 .
[ Filter1
[ Filter2

[ Filter?
[[Rale: Slave

[]5C0 link: Supparted
[ Filter3

Figure 4.29 - Using Named Filters Section of Quick Filters to Show/Hide Filters

Note: When you have multiple Frame Display windows with a display filter or filters, those
filter do not automatically appear in other Frame Display windows. You must use the
Hide/Show dialog to display a filter created in one Frame Display in different Frame Display
window.
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4.3.1.13.1.7 Editing Filters
Modifying a Condition in a Filter

1. Click the Display Filters icon ? on the Frame

.

Display@ window or select Apply/Modify Display SEAETTEILET

Filters... from the Filter menu to open the Set @ [Zeel Curentl ative Candiion: Fiterd
Condition dialog box. The Set Condition dialog box Filterd
displays the current filter definition at the top of the dialog. ASCEE: . ..3

o
To display another filter, click the Open -~ icon, and
select the filter from the pop-up list of all the saved filters.

2. Edit the desired parameter of the condition: Because the required fields for a condition statement depend
upon previously selected parameters, the Set Condition dialog box may display additional fields that were
not present in the original filter. In the event this occurs, continue to enter the requested parameters in
the fields provided until the condition statement is complete.

3. Click OK. The system displays the Save Named Condition dialog. Ensure that the filter name is
displayed in the text box at the top of the dialog, and click OK. If you choose to create an additional filter,
then provide a new name for the filter condition or accept the default name provided by the system and
click OK.) The Set Condition dialog box closes, and the system applies the modified filter.

Note: When a display filter is applied, a description of the filter appears to the right of the
toolbar in the Frame Display windows.
Deleting a Condition in a Filter

If a display filter has two or more conditions you can delete conditions. If there is only one condition setin the
filter you must delete the filter using Delete Display Filters... from the Filters menu.

1. Click the Display Filters icon ? on the Frame Display window or select Apply/Modify Display

Filters... from the Filter menu to open the Set Condition dialog box. Click on the Advanced button to
show the condition in Boolean format. The dialog box displays the current filter definition. To display
another filter, click the Open e icon, and select the filter from the pop-up list of all the saved filters.
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-

Set Conditicn i
Currenty Active Condition: Filker3

@ Inchude ) Exclude

[ WNOT Condition ] AND/OR

where the protocal "Bazeband” fisld "LT_ADDR" |z Equ... AMD

ifi the range 178 to 243

)« (% &

< Delete selected condtion

Figure 4.30 - Set Condition Dialog in Advanced View

2. Selectthe desired condition from the filter definition.

3. Click the Delete Selected Line icon.

4. Editthe Boolean operators and parentheses as needed.

5. Click OK. The system displays the Save Named Condition dialog. Ensure that the filter name is
displayed in the text box at the top of the dialog, and click OK. (If you choose to create an additional filter,
then provide a new name for the filter condition or accept the default name provided by the system and
click OK.) The Set Condition dialog box closes, and the system applies the modified filter.

Note: When a display filter is applied, a description of the filter appears to the right of the
toolbar in the Frame Display windows.

Renaming a Display Filter

1. Select Rename Display Filters... from the Filter menu in the Frame Displaygl window to open

the Rename Filter dialog. The system displays the Rename Filter dialog with a list of all user defined
filters in the Filters combo box.

Rename Filters [ = |
Filters
[Fiter -

Description

lIndudE each frame where the protocol "Baseband” field "LT_ADDR" Is Equal To 6

MNew Name

oK ] [ Cancel ] [ Help ]

Figure 4.31 - Rename Filters Dialog

2. Selectthe filter to be renamed from the combo box.
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3. Enter a new name for the filter in the New Name box. Optionally click the Apply button and the new
name will appear in the Filters combo box and the New Name box will empty. This option allows you to
rename several filters without closing the Rename Filter dialog each time.

4. Click OK. The Rename Filter dialog box closes and the system renames the filter.
4.3.1.13.2 Connection Filtering

Connection Filtering allows the user to view a subset of the total available packets within the Frame Display. The
subset can include data from a single Bluetooth connection, or all of the BR/EDR packets, all of the low energy
packets, all of the 802.11 packets, or all of the HCI packets.

Bluetooth Applicability
A connection (device pair) is identified by
1. A Link for Classic Bluetooth,
2. An Access Address for Bluetooth low energy.

The link ID is a number that the ComProbe software assigns to identify a pair of devices in a BR/EDR connection. In
the Frame Display details pane, the Baseband layer contains the link ID field if the field’s value is not 0.

An Access Address is contained in every Bluetooth low energy packet. The Access Address identifies a connection
between a slave and a master or an advertising packet.

Connection filtering displays only the frames, protocols, summary, details, and events for the selected
connections.

Note: Connection Filters are not persistent across sessions.

4.3.1.13.2.1 Creating a Connection Filter
In the Frame Display there are four ways to create a connection filter.
From the Frame Display Filter menu

Click on the Frame Display Filter menu Connection Filter selection. From the drop down menu, select
Classic or Bluetooth low energy. The options are

o Classic Bluetooth:

o All will filter in all Classic Bluetooth frames. You are in effect filtering out any Bluetooth low energy frames
and are selecting to filter in all the Classic Bluetooth links.

o Links displays all the master-slave links. You can select only one link to filter in. The selected link will filter
in only the frames associated with that link.

e Bluetooth low energy:

o All will filter in all Bluetooth low energy frames. You are in effect filtering out any Classic Bluetooth frames
and are selecting to filter in all Bluetooth low energy access addresses.

o Access Addresses displays all the low energy slave device's access address. You can select only one
access address to filter. The selected link will filter in only the frames associated with that access address.
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o« 802.11:
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o All will filter in all 802.11 frames. You are in effect filtering out any other technology frames.

e HCI:

o All will filter in all HCI frames. You are in effect filtering out any other technology frames.

&) Frame Display - TestFileSlimmer.cfa

® =3 le ol

o+ Frame B.477: [Master] Len=289

|- Ernors:

- Bazeband - Packet Status: CRI
(- Basehand:

- Header Length: 11

File Edit View Format Live Bookmarks Options Window Help

Quick Filtering...

Apply/Modify Display Filters...
Delete Display Filters...
Hide/Show Display Filters...

|t Pm
GOQ| Find:

HS5 ] SC0/eSCO ]

|4 S |d bt

-

|£ﬁ @|Summa

Rename Display Filters...

- Header Version: 3 esaddd ORI RDANDR Eram Delta

- Link: 4 Connection Filter 3 Classic 3 All |
EE;nh;s?;r_[g:ﬂ?g-ﬁdﬂgﬁzb-m TE ey 6,464 Bluetooth low energy » Link 3 0
- Clock: 0x0001d0cD B e e
- Packet Statuz: CRC Error [=0] £, 486 &0 00:004 4
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441372015 10:55:32.661!
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10:55:32. 671!
10:55:32.6901
10:55:32 692"
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4413/2015 10:55:32. 701!

Figure 4.32 - Connection Filter from the Frame Display Menu
From the Frame Display toolbar

Right-click anywhere in the toolbar and select Connection Filter from the pop-up menu. The procedure for
creating a connection filter are identical as described in From the Frame Display Filter menu, above.

&) Frame Display - TestFileSlimmer.cfa

File Edit View Format Live Filter Bookmarks Options Window Help

LAl L ——

O e [ W [ 2| | 9N
3 Al I

A AS | bt

o Frame B,471: [Mg Connection Filter 3 Classic | 4@ ﬁ 0 | Summa
; A - 5
= Errars: Bluetooth low energy 4 Link 4 0 ~
-~ Baseband - f Show Hidden Panes 4 LR LG S L e ) 3

eband: Baseband | PreConnection-FHS | SCO/eSCO

Header Length: 11 4

Header Yersion: 3 B.. Framet Pr.. Accessadd.. CRC ED&DD fam..  Delta Timestamp -

e £.463 17 441342015 10:55:32 661!

Figure 4.33 - Connection Filter from the Frame Display Toolbar right-click
From the Frame Display panes

Right-click anywhere in a Frame Display pane and select Connection Filter in the pop-up menu. The procedure
for creating a connection filter are identical as described in From the Frame Display Filter menu, above.
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Figure 4.34 - Connection Filter from the Frame Display Pane right-click
From the Frame Display frame selection

Select a frame in the summary pane. Right-click and select Connection Filter in the pop-up menu. The
procedure for creating a connection filter are identical as described in From the Frame Display Filter menu,
above.

If the frame you have selected is associated with a Classic Bluetooth link or a Bluetooth low energy access address,
an additional pop-up menu item will appear as shown in the example image below. This selection is a
predetermined filter based on your selection. In the example, frame "6471" is associated with "Link 4", so the
predetermined filter assumes that you may want create a connection filter for that link. Clicking on Connection
Filter Link = 4 will filter in "Link 4" frames without opening all the drop-down menus.
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B... Framelt ASCH Hes Fram... Delta Timeztamp |~

This is the Summary Pane

Copy Selection to Clipboard
Save Selection...

Go To..

<

Show Frame Size Column
v Show Timestamp Celumn
v Show Delta Column

Add New Column (Help)

Remove Mew Column

Change Column Order (Help)

m

Restore Default Columns

Add Bookmark...

Export...

Connection Filter 2 Classic 2 All

Connection Filter Link = 4 Bluetcoth low energy 2 Link 2 0
3

Provide L2CAP Rules... 4

Set Subsequent Decoder Parameters...

Show Hidden Panes 4

Figure 4.35 - Connection Filter from frame selection right-click
Creating from any Frame Display window

A Connection Filter can be created from any open Frame Display window, and the filtering will always be applied
to the original captured data set.

4.3.1.13.2.2 Connection Filter Display

Once you have selected which connections to filter in, another Frame Display will open. The original Frame
Display will remain open, and can be minimized.

Note: The system currently limits the number of frame displays to 5. This limit includes any
Frame Displays opened using Duplicate View ﬁﬁ from the Toolbar (see Working with

Multiple Frame Displays on page 71)

The new Frame Display with the filtered connection frames will only contain the data defined by the filter criteria.

That is, the criteria could be a single link or data for a particular technology.
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Display Example 1: Bluetooth low energy Access Address selected

B =

=

@2 L Hg

Frame 1: Len=53
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* Header Length: 13
- Header Version: 3
[SCE
Channel Index; 37 - 2402 MHz
- Masts Predefired Filtet Criteria for

-+ Receive Status: Received witho
- Decryption Initiated: Ho
. Signal Strenath: 7 medium)
FDU Length: 37
LE PKT
L Preamble: Okaa
- Access Address: DxBel3beds
. CAL: Dxfed626
= LE ADY:
POU Type: ADV_IND
Advertizer dddiess Type: randam
i Payload Length: 25
Advertizer Address: 0x71 2500001
B 4D Data

4D Type: Flags
- AD Data
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- AD Element
Length: 11
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B 4D Data
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{ UUID: Heart Rate M
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EF AD Element
i Length: 13
—T—

Total Frames: 6,767 Frames Filtered In:
For Help Press F1

File Edit View Format Filter Bookmarks

Yvis2nbw

Options  Window Help

|__ S W Original Data Set - note protocol tabs
EE%‘ O®| Find:
[initered ]

- |££ @|Summary: Data
Eurars |

LE BB | LE PKT | LE ADV | LE DATA | LE LL | L2CAP | SMP | ATT | Data |

<[

{3 Frame Display Connection Filter Bluetooth low energy : Access Address : 0xBeBObed® - UPFS0_Tue LE Pairing 123456_71 25 00_00 00_02.cfa = | B S
File Edit View Format Filter Bookmarks Options Window Help
=] 3
2 PHGR VST VALY A4S d
Frame 1: Len=53 o o -
i ( ) Find: ) | summary: [Dat:
1 LEBB DEM‘ 0®| v‘dggo v [oe |

- HeaderLentc 13 oo ]y Eriois | Filtered Data Set - note protocol tabs
gpea:if\fefsm"i 3 LE BB | LE PKT | LE ADV | Data | P

-~ Channel Index: 37 - 2402 MHz B.. Framett ASCI Hex Fram. Delta Timestamp i
Meets Predefined Fiter Ciiteria for T low eneray devi ] g 1
g:i?’ﬁ;’f;‘;@:ﬁ:e‘j vithot encrs 2 53 DOO0:000..  1/27/2015 10:02.04 5285

SEL . 3 53 DOO0000.  1/27/2015 10:02.04 335
~ Signal Strength: 7 (medium

L~ PDU Langth: 37 4 53 000000, 1/27/2015 10:02.04 5479

& LE PRT: 5 53 0000000, 1/27/2015 10.02.04 529
Eraamble: (xaa g kil 00.00:00.0..  1/27/2015 10,02 04.6534..
Access Address: (4BeE5heds 7 k] 00.00:00.0..  1/27/2015 10,02 04.6537..
CRE: OdfeSGel g 5 00.00:00.0..  1/27/2015 10,02 04.6579..
- LE ADV: E] kil 00.00:00.0..  1/27/2015 10,02 04.6584..

L DU Type: ADV_IND 1 10 k] 00.00.00.0..  1/27/2015 10,02 04.6587...
Advetiser Addiess Type: 1andom = 1 53 0000:00.0..  1/27/2015 10:0204.6773..
Payload Length: 35 12 53 DOO0:000.  1/27/2015 10:02.04 5823
Advertiser Address; 0471250000002 13 53 DOO0O0O.. /2772015 10:02:04.6873

=-4D Data 14 kil 0000000, 1/27/2015 100204 6878
&r4b E‘emegtz 15 k] 000000, 1/27/2015 10:02.04 5881
englh 16 53 00.00.00.0..  1/27/2015 10:02:04.7060
ig E*"fe Flags 7 kY 000000, 1/27/2015 10,0204 7065
A SRVEDR et Sunnertad: e 18 k] 00.00:00.0..  1/27/2015 10,02 04.7089..
P ) 19 53 00.00.00.0..  1/27/2015 10.02.04.7110..
- LE General Discoverable Mode: Yes
38D Element Ell 53 00.00:00.0..  1/27/2015 10.02.04.7160..
~ Lenathe 11 21 53 00.00.00.0..  1/27/2015 10.02.04.7335..
D Type: Complete list of 18- ULIDS 2 kil 0000:00.0..  1/27/2015 10:02.04.7340..
5 AD Data 2 kGl DOO0000.  1/27/2015 10:02.04 7344
-~ UUID: Health Themomster 24 53 DOO0:000.  1/27/2015 10:02.04 7385
LIUID: Heart Rate Monitor 25 53 DOO0000.  1/27/2015 10:02.04 7435
- UUID: Blood Prassure Moriter b % 53 DOO0:000.  1/27/2015 10:02.04 7585
LIUID: Weight Seale i 53 000000, 1/27/2015 10:02:04 7635
LILID: Body Compasition 2 53 0000000, 1/27/2015 10.02.04 7685
D Element 23 53 00.00:00.0..  1/27/2015 10:02.04.7792..
Length: 13”' : : 2 0 5 0000000, 1/27/2015 10:02.04 7842..
Total Frames: 6,767 FramesFitered In: 6,017 Frame #s Selected:  1; (1 total)

Figure 4.36 - Front Display: Filtered on Access Address 0x8e89bed6

In the figure above is an example Bluetooth low energy data set connection filtered on Access Address =
0x8e89bed6. The Frame Display in the front is the filtered data set. One way to note the difference between the
original and the filtered display is to observe the Protocol Tabs. In the filtered display there are four low energy
protocol tabs as compared to nine in the original display. This access address connection is not using five of the

protocols.

From any open Frame display the user can set another Connection Filter based on the original data set.

Display Example 2: All 802.11 data filtered in

In this example, there is a capture file with Classic Bluetooth, Bluetooth low energy, and 802.11. To view just the
802.11 data set, 802.11 = All is selected from the right-click pop up menu.

94

Frontline 802.11 Hardware & Software User Manual



Chapter 4 Capturing and Analyzing Data

&3 Frame Display - BTAmp80211FTPwLEcfa =

File Edit View Format Filter Bookmarks
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Figure 4.37 - Unfiltered: Capture File with Classic, low energy, and 802.11

When the Frame Display with the filtered 802.11 data set appears, only the Protocol Tabs for 802.11 are present

and the tabs for Classic Bluetooth and Bluetooth low energy have been filtered out.
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Figure 4.38 - Connection Filter selecting All 802.11 frames, front
4.3.1.13.3 Protocol Filtering from the Frame Display
4.3.1.13.3.1 Quick Filtering on a Protocol Layer

[EE= R Info | Errors |
802.11 Hadin] 802.11 MAC] LLC 302.2} SNAP ] 802.11 AMP] BDZ.IX] LZCAPI DBEX ] FTP ] Data ]
B.. FrameH# ASCI Hex Fram.. Dela Timestamp
1,660 103 0000410, 440/2012 3551085203,

On the Frame Display, click the Quick Filtering icon ﬁ; or select Quick Filtering from the Filter menu.

This opens a dialog that lists all the protocols discovered so far. The protocols displayed change depending on the
data received.
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Quick Filtering and Hiding Protocels &]
Pratocols ToFilter In Protocols To Hide Named Filters
[40 Frames ‘with Enars [T] 40l But the Last Layer [ Filterd
[ &0l Frames with Infarmation [7] &0l Frames with Infarmation [ Filter1
[F]avDTP [ &vDTP [ Fiker2 Hep
[]&%DTP Signaling [C1&¥DTP Signaling [T15C0 link: Supported
[ Baseband [7]Baseband [ Filter3
[]Blustacth FHS [ Blustacth FHS [ Rale: Slave
[|Headset [[Headset [T Configured BT low energy devic
[C1L2CaP [F]L2cap [7]Exelude MULLs and POLLs
[CILMP LM
[|Mon-Captured Info []Mon-Captured Info
[T PreCannectionFHS [] PreConnection-FHS
[TIRFCOMM [CIRFCOMM
[150P 150
Filtering shows only frames that contain the protocaol desired, but it shows the entire frame.

Hiding remowves any protocal lavers from displaying in any frame.

Figure 4.39 - Frame Display Quick Filtering and Hiding Protocols Dialog

The box on the left is Protocols To Filter In. When you select the checkbox for a protocol in the Protocols to
Filter In, the Summary pane will only display those frames that contain data from that protocol.

If you filter on more than one protocol, the result are all frames that contain at least one of ] Quick Filter ]
those protocols. For example, if you filter on IP and IPX NetBIOS, you receive all frames that . .
contain either IP or IPX NetBIOS (or both). A Quick Filter tab then appears on the Frame

Display. Changing the filter definition on the Quick Filter dialog changes the filter applied on the Quick Filter
tab. Quick filters are persistent during the session, but are discarded when the session is closed.

The box in the center is the Protocols To Hide. When you select the checkbox for a protocol in the Protocols
To Hide, data for that protocol will not appear in the Decode, Binary, Radix, and Character panes. The
frames containing that type data will still appear in the Summary pane, but not in the Decode, Binary, Radix,
and Character panes.

The box on the right is the Named Filters. It contains filters that you create

using the Named Filter and Set Condition dialogs. When you select the Mamed Filters
checkbox for the Name Filters, a tab appears on the Summary Pane that | Fiterd
displays the frame containing the specific data identified in the filter. The [ Filter1
named Filter tab remains on the Frame Display Summary [ Fiter2
| Filter3 |  Pane unless you hide it using the Hide/Show Display Filters

[]5C0 link: Supported

dialog.

Check the small box next to the name of each protocol you want to filter in, ["|Rale: Slave

hide, or Named Filter to display. (| Configured BT low energy devic
[[]Exclude MULLs and POLL:

Then click OK
4.3.1.13.3.2 Easy Protocol Filtering

There are two types of easy protocol filtering. The first method lets you filter on the protocol shown in the
Summary pane, and the second lets you filter on any protocol discovered on the network so far.

Filtering on the Summary Layer Protocol

To filter on the protocol in the Summary in the Frame Display window pane:
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1. Select the tab of the desired protocol, or open the Summary combo box.

2. Select the desired protocol.

3. Tofilter on a different layer, just select another tab, or change the layer selection in the combo box.
Filtering on all Frames with Errors
To filter on all frames with errors:

1. Open the Frame Display@window.
2. Click the starred Quick Filter icon g or select Quick Filtering from the Filter menu

3. Check the box for All Frames With Errors in the Protocols To Filter In pane, and click OK.
4. The system creates a tab on the Frame Display labeled "Errors" that displays the results of | Ewors |
the All Frames With Errors filter.

Note: When you have multiple Frame Display windows open and you are capturing data, you
may receive an error message declaring that "Filtering cannot be done while receiving data
this fast." If this occurs, you may have to stop filtering until the data is captured.

4.3.2 Coexistence View
(Click here to see an introduction video...)

The Coexistence View displays Classic Bluetooth, Bluetooth low energy, and 802.11 packets and throughput in
one view. You access the Coexistence View by clicking its button in the Control window or Frame

Display toolbars, or Coexistence View from the View menus.
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Figure 4.40 - Coexistence View Window

4.3.2.1 Coexistence View Menus

The following tables
describe each of the
Coexistence View Menus.

|E| Coexistence View - Capture-2015-12-02_104121.cfa

A kA

lFiIE Format Zoom Mavigate Spectrum Help

Table 4.3 - Coexistence View File Menu Selections
Selection Description

Reset Resets the Coexistence View window to its default settings.

Exit Closes the Coexistence View window.

Table 4.4 - Coexistence View Format Menu Selections
Selection Description

Show Packet | When checked, the packet number shows below the packet in the Viewport. =
Number 8,758,509

Show Packet | When checked, the packet type shows below the packet in the Viewport. —
Type LMF
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4,000 to 20,000
(May Be Slow)

Selection Description
Show Packet When checked, the packet subtype shows below the packet in the Viewport, if applicable.
Subtype
Hide Packet When checked, hides any text shown below the packet in the Viewport. Applies the text
Text shown by the Show Packet Number, Show Packet Type, and Show Packet Subtype

menu selections.

Auto Hide When checked, automatically hides any text shown below the packet in the Viewport
Packet Text when the Viewport duration exceeds 31.25 ms. Applies the text shown by the Show
When Packet Number, Show Packet Type, and Show Packet Subtype menu selections.
Duration > The Viewport duration is shown at the bottom of the Viewport. This selection reduces
31.25 ms. display clutter when viewing a larger timeline section.
Increase Auto | When not checked, the default, the packets in the viewport are hidden if the number of
Hide Packet visible packets exceeds 4,000.
Count from

When checked, the default count increased from 4,000 to 20,000 packets before the
packets are hidden. Choosing this selection may slow down the displaying of the
packets.

The following three selections are mutually exclusive.

Use All
Packets for
Throughput
Indicators

When checked, all captured packets are used for average throughput calculations and
all packets in the last one second of the capture session are used for the 1 sec
throughput. See on page 108 for more information. Performs the same function as the
throughput indicator All radio button.

Use Selected
Packets for

When checked, the packets selected in the Viewport are used for average throughput
calculations, and selected packets in the one second before the last selected packet are

Throughput used for the 1 sec throughput. See on page 108 for more information. Performs the
Indicators same function as the throughput indicator Selected radio button.

Use Viewport | \When checked, all packets appearing in the Viewport are used for average throughput
Packets for calculations, and all packets in the one second before the last packet in the Viewport are
Throughput used for the 1 sec throughput. See on page 108 for more information. Performs the
Indicators same function as the throughput indicator Viewport radio button.

Set 802.11 Tx
Address

When checked, this selection is used to specify the 802.11 source address, where any
packet with that source address is considered a Tx packet and is shown with a purple
border in the timelines. Performs the same function as the SET button. Refer to_on

page 117

The following three selections are mutually exclusive.

Show Packet
Throughput

When checked, the Throughput Graph and Throughput Indicator shows data based on
packet throughput. Performs the same function as the Throughput Packet radio button.

Show Payload
Throughput

When checked, the Throughput Graph and Throughput Indicator shows data based on
payload throughput. Performs the same function as the Throughput Payload radio
button.
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Table 4.4 - Coexistence View Format Menu Selections (continued)

Selection Description
Show Both When checked, the Throughput Graph will graph both the data based on packets
Packet And throughput in darker colors and payloay throughput in lighter colors. The Throughput
Payload Indicator will show calculations based on packet throughput. Performs the same
Throughput function as the Throughput Both radio button.
The following four selections are mutually exclusive.
Show 5 GHz When checked, the 5 GHz Timeline is visible and the 2.4 GHz Timeline is not visible.
Timeline Only 802.11 5 GHz packets are shown. Performs the same function as the Timeline 5
GHz radio button.
Show 2.4 GHz | When checked, the 2.4 GHz Timeline is visible and the 5 GHz Timeline is not visible.
Timeline The timeline will show Classic Bluetooth, Bluetooth Low Energy, and 802.11 2.4 GHz

packets. Performs the same function as the Timeline 2.4 GHz radio button.

Show Both 2.4

When checked, the 2.4 GHz Timeline and the 5GHZ Timeline is visible. Performs the

GHz and 5 same function as the Timeline Both radio button.

GHZ Timelines

Show When check,shows only timelines which have had packets at some point during this
Timelines session. If no packets are present, the 2.4 GHz Timeline is visible. Performs the same

Which Have or
Had Packets
(Auto Mode)

function as the Timeline Auto radio button.

The following two selections are mutually exclusive.

Show Low When checked, shows in the 2.4 GHz Timeline only packets from Bluetooth low enegry
Energy devices configured for this session, and uses these packets for throughput calculations.
Packets From | Performs the same function as the LE Devices Configured radio button.
Configurated
Devices Only
Show All Low | When checked, shows in the 2.4 GHz Timeline all Bluetooth low energy packets
Energy captured in this session, and uses these packets for throughput calculations. Performs
Packets the same function as the LE Devices All radio button.
Large When checked, the Throughput Graph appears in the bottom half of the window,
Throughput swapping position with the timeline.
Graph
B When not checked, the Throughput Graph appears in its default position at the top of the
window.
Performs the same function as clicking the Swap button. See on page 112.
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Table 4.4 - Coexistence View Format Menu Selections (continued)

Selection

Description

Show Dots in
Throughput
Graph ( Dots
Reveal
Overlapped
Data Points)

When checked, displays dots on the Throughput Graph. Dots are different sizes for each
technology so that they reveal overlapping data points which otherwise wouldn’t be
visible. A tooltip can be displayed for each dot. Performs the same function as the Dots

button. See on page 113.

Show Zoomed

When checked, dispalys a Zoomed Throughput Graph above the Throughput Graph. The

Throughput Zoomed Throughput Graph shows the details of the throughput in the time range covered
Graph by the viewport in the Throughput Graph. Performs the same function as the Show
Zoom button.
When not checked, the Zoomed Throughput Graph is hidden. Performs the same
function as the Hide Zoom button.
See on page 114
Freeze Y Only active when the Zoomed Throughput Graph is visible.
Scales in
Zoom When checked, it freezes the y-axis scales and makes it possible to compare all time
Throughput ranges and durations. Performs the same fuction as the Freeze Y button, which appears
Graph with the Zoomed Throughput Graph.
When not checked, the y-axis scales are unfroozen. Performs the same function as the
Unfreeze Y button, which appears with the Zoomed Throughput Graph.
See on page 114
Show Tooltips | When checked, Timeline and Throughput Graph tooltips will appear in the upper-left
in Upper-Left corner of your computer sceen. You can relocate the tool tip for convenience or to see
Corner of the timeline or throughput graph unobstructed while displaying packet information. See _
Screen on page 122,
Table 4.5 - Coexistence View Zoom Menu Selections
Selection Description Hot Key
Zoom In When clicked, Ctrl+Plus
Viewport time duration
decreased.
Zoom Out When clicked, Ctrl+Minus
Viewport time duration
increases

The following two selectioins are mutually exclusive.

Scroll Tool (Mouse Wheel Scrolls - Ctrl Key
Switches to Zoom Tool)

When checked, sets the mouse wheel to scroll
the Viewport. Pressing the Ctrl key while
scrolling switches to zooming the Viewport.
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Table 4.5 - Coexistence View Zoom Menu Selections (continued)

Selection Description | Hot Key
Zoom Tool (Mouse Wheel Zooms- Ctrl Key When checked, sets the mouse wheel to zoom
Switches to Scroll Tool) the Viewport. Pressing the Ctrl key while

zooming switches to scrolling the Viewport.

Zoom To Time Range of Selected Packets Active only when packets are selected.

When clicked, the Viewport duration changes to
the time range covered by the selected packets.

Zoom To Throughput Graph Data Point When clicked, the Viewport duration changes to
the time range of the Throughput Graph selected
data point.

Custom Zoom (Set by Zoom To Time Range of Automatically checked when taking any zoom

Selected Packets, Zoom To Throughput Graph action other than the fixed Viewport zoom

Data Point, or dragging Viewport Slide) durations listed below.
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Table 4.5 - Coexistence View Zoom Menu Selections (continued)
Selection | Description | Hot Key

The following 21 selections are mutually exclusive.

150 usec Each of these Zoom selections sets the Viewport
and the Timeline to a fixed time duration.

300 usec

625 usec (1 Bluetooth slot)

1.25 msec (2 Bluetooth slots)

1.875 msec (3 Bluetooth slots)

2.5 msec (4 Bluetooth slots)

3.125 msec (5 Bluetooth slots)

6.25 msec (10 Bluetooth slots)

15.625 msec (25 Bluetooth slots)

31.25 msec (30 Bluetooth slots)

62.5 msec (100 Bluetooth slots)

156.255 msec (250 Bluetooth slots)

31.25 msec (500 Bluetooth slots)

625 msec (1,000 Bluetooth slots)
1 sec (1,600 Bluetooth slots)

2 sec (3,200 Bluetooth slots)

3 sec (4,800 Bluetooth slots)

4 sec (6,400 Bluetooth slots)

5 sec (8,000 Bluetooth slots)

10 sec (16,000 Bluetooth slots)
20 sec (32,000 Bluetooth slots)

Note: Right-clicking anywhere in the Coexistence View window will open the Zoom menu in
a pop-up.
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Table 4.6 - Coexistence View Navigate Menu Selections

Selection

Description Hot key

First Packet

When clicked, the first packet in the session is Home
selected and displayed in the Timeline. Performs
the same function as the @ First Packet

button.

Last Packet

When clicked, the last packet in the session is End
selected and displayed in the Timeline. Performs
the same function as the @ Last Packet

button.

Previous
Packet

When clicked, the first packet occurring intime | Left Arrow
prior to the currently selected packet is selected
and displayed in the Timeline. Performs the
same function as the @ Previous Packet

button.

Next Packet

When clicked, the first packet occurring nextin | Right Arrow
time from the currently selected packet is
selected and displayed in the Timeline. Performs
the same function as the @ Next Packet

button.

Previous
Retransmitted
Packet

When clicked, selects the first prior retransmitted packet from the current selection and
displays it in the Timeline.. Performs the same function as the <:j Previous

Retransmitted Packet button.

Next
Retransmitted
Packet

When clicked, selects the next retransmitted packet from the current selection and
displays it in the Timeline.. Performs the same function as the ,:{> Next Retransmitted

Error Packet

Packet.
Previous When clicked, selects the first prior invalid Bluetooth low energy IFS packet from the
Invalid IFS current selection and displays it in the Timeline. Performs the same function as the ¢
Packet
Previous Invalid IFS Packet button.
Next Invalid | When clicked, selects the next invalid Bluetooth low energy IFS packet from the current
IFS Packet selection and displays it in the Timeline. Performs the same function as the = Next
Invalid IFS Packet button.
Previous When clicked, selects the first prior packet with | Ctrl+Left Arrow

an error from the current selection and displays it
in the Timeline. Performs the same function as
the @ Previous Error Packet button.
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Table 4.6 - Coexistence View Navigate Menu Selections (continued)

Selection Description Hot key
Next Error When clicked, selects the next packet with an Ctrl+Right Arrow
Packet error from the current selection and displays it in

the Timeline. Performs the same function as the
l# Next Error Packet button.

First Legend

When clicked, selects the first legend packet in the session and displays it in the

Packet Timeline. This control is enabled when a bold packet type is selected in the Coexistence
View Legend. Referto on page 119. Performs the same functions as the €= First
Legend Packet button.

Previous When clicked, selects the first prior legend packet in time from the current selection and

Legend displays it in the Timeline. This control is enabled when a bold packet type is selected in

Packet the Coexistence View Legend. Refer to on page 119. Performs the same functions as
the ‘ Previous Legend Packet button.

Next Legend | When clicked, selects the next legend packet in time from the current selection and

Packet displays it in the Timeline. This control is enabled when a bold packet type is selected in

the Coexistence View Legend. Refer to_on page 119. Performs the same functions as
the » Next Legend Packet button.

Last Legend

When clicked, selects the last legend packet in the session and displays it in the

Packet Timeline. This control is enabled when a bold packet type is selected in the Coexistence
View Legend. Referto on page 119. Performs the same functions as the B Last
Legend Packet button.

Toggle This selection is active during Live capture mode only. Checking this selection will lock

Display Lock | the Throughput Graph and the Timeline in its current position, however the capture will

continue. Not checking this selection will cause the Throughput Graph and the Timeline
to scroll as data is collected.

Note: Navigate menu selections are context sensitive. For example, If the first packet is
selected, the Next Packet and the Last Packet selections are active, but the Previous
Packet selection is inactive.

4.3.2.2 Coexistence View - Toolbar

COOD ¢ wed ¢dleenrHARIND (B

Figure 4.41 - Coexistence View Toolbar

The toolbar contains the following selections:
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Table 4.7 - Coexistence View Toolbar icons

Description

Move to the first packet.

Move to the previous packet.

Move to the next packet.

Move to the last packet.

Move to the previous retransmitted packet.

Move to the next retransmitted packet

Move to the previous invalid IFS for Bluetooth low energy.

Move to the next invalid IFS for Bluetooth low energy.

Move to the previous bad packet.

Move to the next bad packet.

Move to the first packet of the type selected in the legend.

Move to the previous packet of the type selected in the legend

Move to the next packet of the type selected in the legend.

Move to the last packet of the type selected in the legend.

Zoom in.

Zoom out.

"o P s 2T |28 220000 QE

Scroll cursor.
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Table 4.7 - Coexistence View Toolbar icons (continued)

Icon Description

@ When selected the cursor changes from Scroll @ to a context-aware zooming cursor. Click on

normal cursor to remove the zooming cursor.

n Zooming cursor.

E' Scroll Lock/Unlock during live capture mode.

[3 Reset during live capture mode. Clears the display.

4.3.2.3 Coexistence View - Throughput Indicators

(Click here to see a video on the Throughput Indicators...)
Throughput Indicators

Packets: 14l (O Selected () Wiewport

wicth = 1

Figure 4.42 - Coexistence View Throughput Indicators

Throughput indicatorsshow average throughput and 1 second throughput for Classic Bluetooth® (all devices,
master devices, and slave devices are each shown separately), Bluetooth low energy, and 802.11.

4.3.2.4 Throughput

Throughput is total packet or payload size in bits of the included packets divided by the

Throughput  qyration of the included packets, where:
() Packet

(%) Payload
) Both

Frontline 802.11 Hardware & Software User Manual
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Packet size is used if the Packet or Both radio button is selected in the Throughput group.

Payload size is used if the Payload radio button is selected in the Throughput group.

Included packets are defined separately for each of the radio buttons that appear above the throughput
indicators.

Duration of the included packets is measured from the beginning of the first included packet to the end of
the last included packet.

4.3.2.5 Radio Buttons

Packetsz: (&l () Selected () Wiewport The radio buttons above the throughput indicators specify
which packets are included. Radio button descriptions are modified per the following:

o Bluetooth low energy packets from non-configured devices are excluded if the

Configured radio button in the LE Devices group is selected. LE Devices
(®) Configured
« Frame Display filtering has no effect here in that packets that are filtered-out in Al

Frame Display are still used here as long as they otherwise meet the criteria for
each radio button as described below.

4.3.2.6 All radio button

All packets are used for average throughput, and packets
Packetz: @Al O Selected O Viewport occurring in the last 1 second of the session are used for 1
second throughput, except that Bluetooth low energy
packets from non-configured devices can be excluded as noted above.

4.3.2.7 Selected radio button

Selected packets (the selected packet range is shown in
the timeline header) are used for average throughput,
and packets in the 1 second duration ending at the end of
the last selected packet are used for 1 second, except that Bluetooth low energy packets from non-
configured devices can be excluded as noted above.

Packets: (Al (3 Selected () Wiewport

Selected Packets: 15,434 - 15437 Gap 4477 ms  Timestamp Delta: 45922 ms Span: 46192 m=s

Figure 4.43 - Timeline Header Showing Selected Packets

4.3.2.8 Viewport radio button

The viewport is the purple rectangle in the Throughput
Graph and indicates a specific starting time, ending time,
and resulting duration. Packets that occur within that
range of time are used for average throughput, and packets in the 1 second duration ending at the end
of the last packet in the viewport time range are used for 1 second throughput, except that Bluetooth
low energy packets from non-configured devices can be excluded as noted above.

Packets: (&l (O Selected (%) Wiewport
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Figure 4.44 - Throughput Graph viewport.

4.3.2.9 Indicator width

The width of each indicator is the largest 1 second throughput seen up to that point for that technology (Classic
Bluetooth, Bluetooth low energy, or 802.11), where the 1 second throughput is calculated anew each time
another packet is received. The 1 second throughput indicator will never exceed this width, but the average
throughput indicator can. For example, the image below has a large average throughput because the Selected
radio button was selected and a single packet was selected, and the duration in that case is the duration of the
single packet, which makes for a very small denominator in the throughput calculation. When the average
throughput exceeds the indicator width, a plus sign (+) is drawn at the right end of the indicator.

Packets: (Al (3 Selected (O Viewpart
Aorg throughput g

| 1
[ Classic | [EEEEER +M1 152
533 333 +M1 152
0 0

wickth =1

Figure 4.45 - Average throughput indicators show a plus sign (+) when the indicator width is exceeded.

F

13,442 Dhi1

Figure 4.46 - A single selected packet

(Click here to see a video on how the Throughput is calculated...)

4.3.2.10 Coexistence View - Throughput Graph

(Click here to see aThroughput Graph video...)
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Visnwpot synchronized with |
. Loamed Throughpul Graph
80211 Packat Classic Packet
Thraughput Throughput

andTimelines

802.11 Payload :
Throughput Classic Paylad

Throughput

Figure 4.47 - Coexistence View Throughput Graph

The Throughput Graph is a line graph that shows packet and/or payload throughput over time as specified by
the radio buttons in the Throughput group. If the Both radio button is selected, packet and payload throughput
are shown as two separate lines for each technology. The payload throughput line is always below the packet
throughput line (unless both are 0).

The data lines and y-axis labels are color-coded: Blue = Classic Bluetooth, Green = Bluetooth low energy, Orange =
802.11. Each data point represents a duration which is initially 0.1 s. Each time the number of data points per line
reaches 300, the number of data points per line is halved to 150 and the duration per data point is doubled. The
duration per data point thus progresses from 0.1 st0 0.2 sto 0.4 s to 0.8 s and so on.

4.3.2.11 Throughput Graph Y-axis labels

The y-axis labels show the throughput in bits per second. From left-to-right the labels are for 802.11,
Bluetooth low energy, and Classic Bluetooth. The duration of each data point must be taken into account for
the y-axis label’s value to be meaningful. For example, if a data point has a duration of 0.1 s and a bit count of
100, it will have a throughput of 1,000 bits/s, and the y-axis labels will be consistent with this.

Figure 4.48 - Throughput Graph y-axis labels.
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4.3.2.12 Excluded packets

Retransmitted packets and bad packets (packets with CRC or Header errors) are excluded from throughput
calculations.

4.3.2.13 Tooltips

Placing the mouse pointer on a data point shows a tooltip for that data point. The tooltip first line shows the
throughput, the throughput type (packet or payload), and the technology. Subsequent lines show the bit
count, the duration of the data point, the packet range of that duration (only packets of the applicable
technology from that packet range are used for the throughput calculation), and the number of the data point
(which is 0 for the first data pointin each line).

\

2.880 bitz/s [Packet Throughput - Classic]
Bit Count: 288 \

Diuration: 100 mz
Clazzic Packets in Packet Bange 15,435 - 15,437
Data Point 12

Figure 4.49 - Data point tooltip

The Throughput graph tool tips can be shown in the upper-left corner of your computer screen to provide an
unobstructed view. Refer to Relocating Tool Tips.

4.3.2.14 Discontinuities

A discontinuity is when the timestamp going from one packet to the next either goes backward by any amount
or forward by more than 4.01 s. This value is used because the largest possible connection interval in
Bluetooth low energy is 4.0 s. A discontinuity is drawn as a vertical dashed line. A discontinuity for a
timestamp going backward is called a negative discontinuity and is shown in red. A discontinuity for a
timestamp going forward by more than 4.01 s is called a positive discontinuity and is shown in black. A
positive discontinuity is a cosmetic nicety to avoid lots of empty space. A negative discontinuity is an error.

Shaw Zaom 1]

Figure 4.50 - A negative discontinuity.
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point 94 ¢ = 1 falict

s 7 Bl Throughput Over Time

T0134.659531

Figure 4.51 - Three positive discontinuities.

4.3.2.15 Viewport

The viewport is the purple rectangle in the Throughput Graph. It indicates a specific starting time, ending
time, and resulting duration, and is precisely the time range used by the Timeline. The packet range that
occurs within this time range is shown above the sides of the viewport.

Figure 4.52 - Throughput Graph Viewport

The viewport is moved by dragging it or by clicking on the desired location in the Throughput Graph (the
viewport will be centered at the click point).

The viewport is sized by dragging one of its sides or by using one of the other zooming techniques. See the
Zooming subsection in the Timeline section for a complete list.

4.3.2.16 Swap button

The Throughput Graph and Timeline can be made to trade positions by clicking the Swap button.

Clicking the Swap button swaps the positions of the Throughput Graphs and the Timelines.
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Figure 4.53 - Small Timeline and large Throughput Graph after pressing the Swap button.

4.3.2.17 Dots button

The dots on the data points can be toggled on and off by clicking the Dots button. Dots are different

sizes for each technology so that they reveal overlapping data points which otherwise wouldn’t be visible. A
tooltip can be displayed for each dot.

Dots can be removed for greater visibility of the plots when data points are crowded together.

Dots toggled on | Dots toggled off J

Figure 4.54 - Dots Toggled On and Off
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Overlapping Dots:
. Classic Bluetooth (top)
. Bluetooth low enegy (middle)

s\ St o ) Overlapping Dots:
et /" Cursor placed on visilble
' /4 bottom dot to display 802.11
N =1 74 | packet information. )

380,859 bits/s (802.11 Packet Throughput)
(3,120 bits / 8.192 ms)

802.11 Packets in Overall Packet Range 16,785 - 16,787
— 1 Data Point 85

Right-click to zoom to data point

gk

Figure 4.55 - Overlapping Dots Information Display

4.3.2.18 Zoomed Throughput Graph

Clicking the Show Zoom button [5haw Zoom| displays the Zoomed Throughput Graph above the

Throughput Graph. The Zoomed Throughput Graph shows the details of the throughput in the time
range covered by the viewport in the Throughput Graph. Both the Zoomed Throughput Graph and the
Timelines are synchronized with the Throughput Graph’s viewport. The viewport is sized by dragging one
of its sides or by using one of the other zooming techniques listed in the Zooming subsection in the Timelines
section.
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Figure 4.56 - Synchronized Zoomed Throughput Graph and View Port

The largest value in each technology in the Zoomed Throughput Graph is snapped to the top of the graph.
This makes the graph easier to read by using all of the available space, but because the y-axis scales can change

it can make it difficult to compare different time ranges or durations. Clicking the Freeze Y button

freezes the y-axis scales and makes it possible to compare all time ranges and durations (the name of the

button changes to Unfreeze Y and a Y Scales Frozen indicator appears to the right of the title. Clicking the
Unfreeze Y @ button unfreezes the y-axis scales.

e oo || Fremon [

The largest value of aach
’ T technolegy is snapped othe
| top of the graph
Il |
1
] |
L L
e NI L 't o Tel/flI ||
(P BE : N i
M ' Ii

Figure 4.57 - Zoomed Throughput Graph- Largest Value Snaps to Top
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\With Y-scales frozen the

largest low enggy
threughput valusis not | | dhan Y scales
snappedisthetop. | "dw'mraip:::;n“
I
- With Y-scales frozenthe
largest B02.11
i threughput values is ot
. snappediothe iop.

Figure 4.58 - Zoomed Throughput Graph - Freeze Y keeps the y-axis constant
Interval Menu

The Interval drop-down menu is used to set the duration of each data
Interval point in the Zoomed Throughput graph. The default setting is Auto that
— sets the data point interval automatically depending on the zoom level.
'u"' The other menu selections provide the ability to select a fixed data point
10 mzecs i interval. Selecting from a larger to a smaller interval will display more
100 mzec: [ data points. Should the number of data points exceed 30,000, no data is
1 sec displayed and a warning will appear in the graph area.

4.3.2.19 Zoom Cursor
Selecting the Zoom Cursor[;j—\ button changes the cursor to the zoom cursorTj\ . The zoom cursor is

controlled by the mouse wheel and zooms the viewport and thus the Timelines and the Zoomed Throughput
Graph. The zoom cursor appears everywhere except the Throughput Graph, which is not zoomable, in
which case the scroll cursor is shown. When the zoom cursor is in the Timelines or Zoomed Throughput
Graph zooming occurs around the point in time where the zoom cursor is positioned. When the zoom cursor
is outside the Timelines and the Zoomed Throughput Graph the left edge of those displays is the zoom
point.

4.3.2.20 Comparison with the Bluetooth Timeline's Throughput Graph

The Throughput Graphs for Classic Bluetooth in the Coexistence View and the BluetoothTimeline can
look quite different even though they are plotting the same data. The reason is that the Coexistence View
uses timestamps while the BluetoothTimeline uses Bluetooth clocks, and they do not always match up
exactly. This mismatch can result in the data for a particular packet being included in different intervals in the
two Throughput Graphs, and can have a significant impact on the shapes of the two respective graphs. This
can also result in the total duration of the two Throughput Graphs being different.
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Another factor that can affect total duration is that the BluetoothTimeline's Throughput Graph stops at the
last Classic Bluetooth packet while the Coexistence View’s Throughput Graph stops at the last packet

regardless of technology.

4.3.2.21 Coexistence View - Set Button

(Click here to see a video on the Wi-Fi Tx Address Set button...

The Set button is used to specify the 802.11 source address, where any

80217 Tw: 00:0c:23:85F331  packet with that source address is considered a Tx packet and is shown with
a purple border in the timelines.

All source MAC addresses that have been seen during this session are listed in the dialog that appears when the
Set button is clicked. Also listed is the last source MAC address that was set in the dialog in the previous session.
If that address has not yet been seen in this session, it is shown in parentheses.

802.11 Tx Address X

802,11 Tx Address

Each §02,11 packet with this source address is considered a Tx packet and is shown with a
purple border.

&l source MAC addresses that have been seen during this session are listed here, Also lisked
is the last source MAC address that was set here in the previous session, If that address has
nok yvet been seen in this session, it is shown in parentheses,

I ] [ Cancel

Figure 4.59 - 802.11 Source Address Dialog
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3

802,11 Tx Address
00:0c: 29 85:F3 31

IZIIII:EI-::29:21:|:B:-:|9

= None =

00:00:74: <51 ed: 25 foe address is considered a Tx packet and is shown with a

al
00:14:ph 720336
0olcilied:esnd
00:leesdz2:06:658
00:24:21:33: ae:b2
00:2F:58:42:06: 68
00:50:56:84:00:00
00:50;56:84:00: 04
00:50:56:84:00:0b
40:01:c6:33:bbice
Soi26i0a:43: k940
Tif1aliediadial
Taied00:2a:54:05
a4:badbifd:11:a6
fg:1eidfids:b2:93

tve been seen during this session are listed here, Also lisked
ak was set here in the previous session. IF that address has
it is shown in parentheses.

(0.4 ] [ Cancel

Figure 4.60 - 802.11 Source Address Drop Down Selector

4.3.2.22 Coexistence View - Throughput Radio Buttons

Throughput
(%) Packet

) Pavload
) Both

The radio buttons in the Throughput group specify whether to show packet and/or payload lines
in the Throughput Graph, and also whether to show packet or payload throughput in the
throughput indicators (if the Both radio button is selected, packet throughput is shown in the
throughput indicators).

4.3.2.23 Coexistence View - Timeline Radio Buttons

Timeline
()5 GHz
() 2.4 GHz
(%) Bath
() duto

The radio buttons in the Timeline group specify timeline visibility. The first three buttons specify
whether to show one or both timelines, while the Auto button shows only timelines which have
had packets at some point during this session. If no packets have been received at all and the
Auto button is selected the 2.4 GHz timeline is shown.

4.3.2.24 Coexistence View — low energy Devices Radio Buttons

LE Devices
() Configured

® Al

device.

118

The radio buttons in the LE Devices group (where “LE” means Bluetooth® low energy)
specify both visibility and inclusion in throughput calculations of Bluetooth low energy packets.
The All radio button shows and uses all Bluetooth low energy packets. The Configured radio
button shows and uses only Bluetooth low energy packets which come from a configured
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4.3.2.25 Coexistence View — Legend

(This video provides more details on the Legend...)

[ classic Classic LF [302.11]
LE )

[ 50211 5 GHz

| m | 802.11 2.4 GHz

| | 802.11 Freg

W FH=
smit LIP :
Bad Packet W Filler 1atc Mgyt
Can't D ‘fat UL i
Il Fol j Cortraol

Click on any bold entry above to enable navigation

Figure 4.61 - Coexistence View Legend

The legend describes the color-coding used by packets in the timelines. Selecting a packet in a timeline highlights
the applicable entries in the legend. An entry is bold if any such packets currently exist. Clicking on a bold entry
enables the black legend navigation arrows in the toolbar for that entry.

4.3.2.26 Coexistence View — Timelines

(Click here to see a Coexistence View Timeline video...)

'Iuw
e  r— e e e e
"‘ - Fu:-—
L L - L -
B

Figure 4.62 - Coexistence View Timelines

The Timelines show Classic Bluetooth® , Bluetooth low energy, and 802.11 packets by channel and time.
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4.3.2.27 Packet information

Packet information is provided in various ways as described below.

Packets are color-coded to indicate attribute (Retransmit, Bad Packet, Can’t Decrypt, or Invalid IFS), master/Tx,
technology (Classic Bluetooth® , Bluetooth low energy, or 802.11), and category/type.

Selection Box
Attribute (Bad Packet)
MasterTx (Master)

Technology (Classic Bluetooth)

Packet Categary or Type (ACL)

Figure 4.63 - Each packet is color-coded

The innermost box (which indicates packet category/type) is the packet proper in that its vertical position
indicates the channel, its length indicates the packet’s duration in the air, its left edge indicates the start time,
and its right edge indicates the end time.

The height of Classic Bluetooth and Bluetooth low energy packets indicates their frequency range (1 MHz and 2
MHz respectively). Since 802.11 channels are so wide (22 MHz), 802.11 packets are drawn with an arbitrary 1
MHz height and centered within a separate frequency range box which indicates the actual frequency range.

Selecting a packet by clicking on it draws a selection box around it (as shown above) and highlights the
applicable entries in the legend.

[ classic Classic LE (30211 ]
LE »
O c02.11 5 GHz

|m 802,11 2.4 GHz

| | 802.11 Freq

W FHS

B Retranzmit LiP & Data
Bad Packet H Filler : Pyt

I ULl y
W Faoll 1t Control

Click on any bold entry above to enable navigation

Figure 4.64 - Highlighted entries in the legend for a selected packet.

Summary information for a selected packet is displayed in the timeline header.
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Selected Packet: 15457 Timestamp: 50172011 10:41:15.2 3 A Technology: sic Type: Dbl Bluetooth Clock: 001132610

Payload Len: 3 hytes
Figure 4.65 - Timeline header for a single selected packet.

When multiple packets are selected (by dragging the mouse with the left button held down, clicking one
packet and shift-clicking another, or clicking one packet and pressing shift-arrow), the header shows Gap
(duration between the first and last selected packets), Timestamp Delta (difference between the
timestamps, which are at the beginning of each packet), and Span (duration from the beginning of the first
selected packet to the end of the last selected packet).

Selected Packets: 15,434 - 15437 Gapc 4477 ms  Timestamp Delta: 45922 ms Span: 46.192 ms

Figure 4.66 - Timeline header for multiple selected packets

- - . Text can be displayed at each packet by selecting Show Packet
Show Packet Number Number, Show Packet Type, and Show Packet Subtype
Show Packet Type from the Format menu.

v Show Packet Subtype
Hide Packet Text
v Auto Hide Packet Text When Duration = 31.25 ms

————— | = """
15,455 Momt 15 458 Data 15 459 Data 15 460 Data

[

1:3,4:36 Dh1

I_I
15,457 Dhit

Figure 4.67 - Descriptive text on timeline packets.

Placing the mouse pointer on a packet displays a tooltip (color-coded by technology) that gives detailed
information.
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o
15457 Dhil

Packet 15,457 [Classic] - DM1

8742011 10:41:19.835783 AM [Beginning Timestamp)
83/17/2011 10:41:19.836053 AM [Ending Timestamp]
Druration: 270 us

Faole: Master

Channel: 36 - 2438 MH:z

Clock: 0x0113e610

Packet Status: CRC Error [=0]

FLOW: Go

TvPE: D1

LT_aDDR: 0

L2CAP Flow: Go

Logical Link 1D: L2CAP start or no fragmentation
SEQM: 1

ARGN: 0

Pavload Length: 9 [53% of 17 butes max)

Decypted by Eluetooth ComProbe: Mo

Bad packet data; 0= 4502 02 00 ...

Figure 4.68 - A tool tip for a Classic Bluetooth packet.

4.3.2.28 Relocating the tool tip

You can relocate the tool tip for convenience or to see the timeline or throughput graph unobstructed
while displaying packet information. In the Format menu select Show Tooltips in Upper-Left Corner
of Screen, and any time you mouse-over a packet the tool tip will appear anchored in the upper-left
corner of the computer screen. To return to viewing the tool tip adjacent to the packets deselect the tool
tip format option in the menu.
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Coexistence View - le - Sniffer_Capture_GB6900AA_2.cfa

File | Format | Zoom Mavigate Help
Show Packet Mumber :
Show Packet Type

Show Packet Subtype

Hide Packet Text

Auto Hide Packet Text When Duration > 31.25 ms

Increase Auto Hide Packet Count From 4,000 to 20,000 (May Be Slow)

Use All Packets for Throughput Indicators
Use Selected Packets for Throughput Indicators
Use Viewport Packets for Throughput Indicators

Set 80211 Tx Address

Show Packet Throughput
Show Payload Throughput
Show Both Packet and Payload Throughput

Show 5 GHz Timeline

Show 2.4 GHz Timeline
Show Both 5 GHz and 2.4 GHz Timelines !
Show Timelines Which Have or Had Packets (Auto Mode)

Show Low Energy Packets From Cenfigured Devices Only
Show All Low Energy Packets

Large Throughput Graph
Show Dots in Throughput Graph (Dots Reveal Overlapped Data Points)
Show Zoomed Throughput Graph I

Show Tooltips in Upper-Left Corner of Screen

Figure 4.69 - Coexistence View Format Menu - Show Tooltips on Computer Screen
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Packet 6,486 (LE) - Data (Empty) - LLID: Continuation/Empty
31442013 12:14:54 222188 PM (Beginning Timestamp)

31442013 12:14:54 222268 PM (Ending Timestamp)

Duration: 80 us

Role: Side 1

CP#1

Channel Index: 18 - 2442 MHz

Meets Predefined Filter Criteria for BT low energy devices: No

Ewvent Status: Received without errors

PDU Length: 2

LE DATA — Access Address: Oxaf9ab45e Chan: 18 Side: 1 Event Counter: 0x013b Len: 0 LLID: Empty MD: 0 NESN: 1 SN: 1

ffer_Capture_GBGI00AA_2.cfa

Equipment\My Capture FilesYe - Snil

Coexistence View - le - Sniffer_Capture_GBBS00AA_2.cfa

File

Format Zoom Mavigate

Help

Packets: |

OO«

Al () Selected  (

width = 1 sec peak = 0

e e aEdr AR

Throughput Over Time

Wiewport

O T SR T S 7 e e P

[E450]

461 Data

Viewport Packet Range (48 Packets) -
None

B
8,480 Data

n ]
6,492 Data =]
8,506 Data 8,513 Data

A ]
8,478 Data £.488 Data

n ]
6.501 Data 8,515 Data

Figure 4.70 - Coexistence View Timeline Tool Tip Shown Anchored to Computer Screen

4.3.2.29 The two Timelines

There are two Timelines available for viewing, one for the 5 GHz range and one for the 2.4 GHz range.
Classic Bluetooth and Bluetooth low energy occur only in the 2.4 GHz range. 802.11 can occur in both.
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Viewport Packet Range (85 Packeta) 512 |
_ Sekcted Packet: Nons

SI2009 32205 860783 PM A S0008 322 11 455188 PM

Figure 4.71 -5 GHz and 2.4 GHz 802.11 packets

The y-axis labels show the channels for each technology and are color-coded: Blue = Classic Bluetooth, Green
= Bluetooth low energy, Orange = 802.11.

The 5 GHz timeline has only 802.11 channel labels, and the rows alternate orange and white, one row per
channel.

The 2.4 GHz timeline has labels for all three technologies. The rows alternate blue and white, one row per
Classic Bluetooth channel. The labels going left-to-right are 802.11 channels, Bluetooth low energy advertising
channels, Bluetooth low energy regular channels, and Classic Bluetooth channels.

The Viewport Packet Range above the timelines shows the packet range and packet count of packets that
would be visible if both timelines were shown (i.e. hiding one of the timelines doesn’t change the packet
range or count). This packet range matches the packet range shown above the viewport in the Throughput
Graph, as it must since the viewport defines the time range used by the timelines. When no packets are in the
time range, each of the two packet numbers is drawn with an arrow to indicate the next packet in each
direction and can be clicked on to navigate to that packet (the packet number changes color when the mouse
pointer is placed on it in this case).

m‘An arrow points to the next packet when no packets are in the time range.

=15 M7 ~An arrowed packet number changes color when the mouse pointer is on it. Clicking navigates to
that packet.

The header shows information for packets that are selected.
The footer shows the beginning/ending timestamps and visible duration of the timelines.

The ‘i’ buttons bring up channel information windows, which describe channel details for each technology.
They make for interesting reading.
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802.11 5 GHz
Oty channels with 3 bage value of 5 GHz and spacings of either 20 or 40 MHz are shown here. Due to space limitations, each channel iz drawn with fiked
zpacing inztead of being zpaced relative to its digtance from other channelz az iz done with 2.4 GHz channels [with the exception of 802,17 channel 14).

Figure 4.72 - 5 GHz information window

Bluctooth Classic

There are 79 Classic channels. Each channel is 1 MHz wide and has the indicated center frequency. Channels do not averlap
0=2402MHz 10=2412MHz 20=2422MHz 30=2432MHz 40=2442MHz 50=2452MHz 60=2462MHz 70 = 2472 MHz
1-0403MHz 11=2013MHz 21=2423MHz 31=2433MHz 41-2443MHz 51-2453MHz 51-2463MHz 71 = 2473 MHz
2=2404MHz 12=2414MHz 22=2424MHz 32=2434MHz 42-2444MHz 52-2454MHz £2=2464MHz 72 = 2474 MHz
3-0405MHz 13=2415MHz 23-2425MHz 33-2435MHz 43-2445MHz 53-2455MHz 53-2465MHz 73 = 2475 MHz
4=2405MHz 14=241EMHz 24-3426MHz 34-2436MHz 44-2446MHz 54-2456MHz 54 - 2486 MHz 74 = 2476 MHz
5=2407MHz 15=2417MHz 25=2427MHz 35=2437MHz 45=2447MHz 55=2457 MHz £5=2467MHz 75 = 2477 MHz
5-0408MHz 16=2418MHz 25-2428MHz 35-2438MHz 46-2448MHz 56-2458MHz 56-24B8MHz 76 = 2478 MHz
7=2409MHz 17=2419MHz 27=2429MHz 37=2433MHz 47-=2449MHz 57-2459MHz 57 =2469MHz 77 = 2479 MHz
8=0410MHz 18=2420MHz 2B=2430MHz 38-2440MHz 48-2450MHz 58-2460MHz 58=2470MHz 78 = 2480 MHz
9=2411MHz 19=2421 MHz 23=2431 MHz 39=2441MHz 49=2451 MHz 59=2461 MHz 69 = 2471 MHz

The rows labels are placed at the center frequancy of ach channel,

Bluctaoth low energy (LE)

There are 40 LE channeks. Each channel is 2 MHz wide and has the indicated center frequency. Channels da nat overlap.

Channes 0 through 36 are Data channels. Channels 37 thiough 39 are Advertising channels.

37-2402MHz 4=2412MHz 3 13-2432MHz 18-2442MHz 23-2452MHz 28-2462MHz 33= 2472 MHz

0= 2404 MHz 414 MHz 434 MHz 444 MHz 464MHz  29= 2464 MHz 34 = 2474 MHz
1-0406MHz B=2416MHz 38-2426MHz 15-2436MHz 20-246MHz 25-2456MHz 30-2486MHz 35 = 2476 MHz
2-2408MHz 7-2418MHz 11-2428MHz 16-2438MHz 21 -2448MHz 25-24B8MHz 31 - 2468MHz 36 - 2478 MHz
3=2410MHz B=2420MHz 12=2430MHz 17 =2440MHz 22=2460MHz 27 =2460MHe 32=2470MHz 39 = 2480 MHz

The rows labels are placed at the center frequency of sach channel,

802.11 2.4 GHz

In the 802,11 2.4 GHe frequency range there are 11 channels in the US4, 1% in Ewape, and 14 in Japan. Each channel is 22 MHz wide. Channels overlap.

There is a 5 MHz shift between sach of the fiist 13 chanrels. There is a 12 MH shift between channels 13 and 14,

m

1= 2401-2423 MHz  [centered ot 2412 MHz) (US4, Europe, Japan) 8= 24362458 MHz  [centered ot 2447 MHz) (US4, Ewape, Japan)
2= 2406-2426 MHz  [centered ot 2417 MHz)  (USA, Europe, Japan) 9= 24412463 MHz  [centered ot 2452 MHz) (US4, Ewope, Japan)
3=0411-2433MHz [centered at 2422 MHz] (US4, Eurape, Japan] 10= 24462468 MHz  [contered at 2457 MH2) (US4, Ewape, Japan)
4= 2416-2438 MHz  [centered ot 2427 MHz) (US4, Europe, Japan) 11 = 2451 2473 MHz  [centered ot 2462 MHz) (US4, Ewope, Japan)
5=0421-2443MHz [centered at 2432 MHz] (US4, Europe, Japan) 12 = 24562478 MHz  [centered at 2467 MHz) - [Ewops, Japan)

£ = 2426-2448 MHz  [centered ot 2437 MHz) (US4, Europe, Japan) 13= 2461 2483 MHz  [centered ot 2472 MHz) - (Ewope, Japan)
7=0431-2453MHz  [centered at 2442 MHz] (US4, Europe, Japan) 14= 24732495 MHz  [contered at 2484 MH2)  apan)

The row labels for 80211 channels 1-13 are placed at the center frequency of each channel
The row label for 802.11 channel 14 is in parentheses because that channel's center frequency is above the top of the graph.

Figure 4.73 - 2.4 GHz information windows

4.3.2.30 Bluetooth slot markers

When zoomed in far enough Bluetooth slot markers appear in the 2.4 GHz timeline. A Bluetooth slot is 625 ps
wide.

15,4000 Can-

Figure 4.74 - Vertical blue lines are Bluetooth slot markers

4.3.2.31 Zooming

There are various ways to zoom:
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1. Drag one of the sides of the Throughput Graph viewport.
2. Selectazoom preset from the Zoom or right-click menus.
3. Selectthe Zoom In or Zoom Out button or menu item.

4. Turn the mouse wheel in the Timelines or the Zoomed Throughput Graph while the zoom cursor
is selected. The action is the same as selecting the Zoom In and Zoom Out buttons and menu items
except that the time point at the mouse pointer is kept in place if possible.

5. Selectthe Zoom to Data Point Packet Range menu item, which zooms to the packet range shown
in the most recently displayed tool tip.

6. Selectthe Zoom to Selected Packet Range menu item, which zooms to the selected packet range
as indicated in the Selected Packets text in the timeline header.

7. Selectthe Custom Zoom menu item. This is the zoom level from the most recent drag of a viewport
side, selection of Zoom to Data Point Packet Range, or selection of Zoom to Selected Packet.

The zoom buttons and tools step through the zoom presets and custom zoom, where the custom zoom is
logically inserted in value order into the zoom preset list for this purpose.

4.3.2.32 Discontinuities

(Click here to see a Timeline Discontinuities video...)

A discontinuity is when the timestamp going from one packet to the next either goes backward by any amount
or forward by more than 4.01 s (this value is used because the largest possible connection interval in
Bluetooth low energy is 4.0 s). A discontinuity is drawn as a vertical cross-hatched area one Bluetooth slot (625
ps) in width. A discontinuity for a timestamp going backward is called a negative discontinuity and is shown in
red. A discontinuity for a timestamp going forward by more than 4.01 s is called a positive discontinuity and is
shown in black. A positive discontinuity is a cosmetic nicety to avoid lots of empty space. A negative
discontinuity is an error.

[0 % Packatni

Figure 4.75 - A negative discontinuity
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Virwpt Pkt Barga (1 Pt eing £

Figure 4.76 - A positive discontinuity

When there are one or more discontinuities the actual time encompassed by the visible timeline differs from
the zoom level duration that would apply in the absence of any discontinuities. The actual time, referred to as
absolute time, is shown followed by “(abs)”. The zoom level duration, referred to as relative time, is shown
followed by “(rel)”. When there are no discontinuities, relative and absolute time are the same and a single
value is shown.

= ——

Selected Packets: 477 - 478 Gap: 7199584 = Timestamp Delta; 720011 = Spanc 7.20

Figure 4.77 - Timeline header with discontinuity
15.625 m= (rel) 7.21484 = (abs)
Figure 4.78 - Timeline duration footer with discontinuity

For example, the timeline above has a zoom level duration of 15.625 ms (the relative time shown in the
footer). But the discontinuity graphic consumes the width of a Bluetooth slot (625 ps), and that area is 7.19984
s of absolute time as shown by the Gap value in the header. So the absolute time is 7.21484 s:

Zoom level duration — Bluetooth slot duration + Gap duration =
15.625 ms- 625 ps + 7.19984 s =

0.015625 s—0.000625 s + 7.199840 s =

0.015000 s + 7.199840 s =

7.214840s =

7.21484 s

4.3.2.33 High-Speed Bluetooth

High-speed Bluetooth packets, where Bluetooth content hitches a ride on 802.11 packets, have a blue
frequency range box instead of orange as with regular 802.11 packets (both are shown below), and the tool
tip has two colors, orange for 802.11 layers and blue for Bluetooth layers.
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Figure 4.79 - High-speed Bluetooth packets have a blue frequency box and a two-tone tool tip

4.3.2.34 High Speed Live View

When using the Frontline® 802.11 in conjunction with other ComProbe devices, or in a stand-alone configuration,
a smaller version of the standard Coexistence View is available. This High Speed Live View is essentially the
Viewport from the standard Coexistence View.

When viewing High Speed Live, only 802.11 traffic is visible. Because Bluetooth packets are slow they are not
visible in High Speed mode.

1. Click on the Control window File menu and select Close.

7
&) ComProbe Protocol Analysis System - 802.11 [ —n| =) ﬂ_ﬁj
View Live Options Window Help

Open Capture File... Ctrl+0 &)
Close
Save \\\" |Ctr\+ S [Capture Files\Capture-2012-12-21_135337.cfa
. Close the active file e
1 Capture-2012-1 | EEETE
. . Packet Decoder (23 pps) [IEE /R 1E)
|| e A e _

2. The Control window will open again. Click on the Control Window File menu and select Go Live (High-
Speed Mode)

) cPas l= 2=
File Options Methods Help

PGS

|For Help Press F1
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-
&) ComProbe Protocol Analysis System - HSView.cfa

Edit View Options Window Help

Go Live
Go Live (High-Speed Mode)

il @

Open Capture File... Ctrl+0
Close . =
. [ )
Save ~J |
\ Select High-Speed Live Mode to see the
- Reframe... Coexistence High-Speed View
Unframe...

\.

Recreate Companicn File
1 C\Users\..\HSView.cfa

Exit ComProbe Protocel Analysis System

3. Click on the Control window Start Capture button @ to begin capturing data. Click on the

Coexistence View button ||and the High-Speed View will appear.

&) ComProbe Protacol Analysis System - 802.11

File View Live Options Window Help

ELXLTEILTN

Configuration: Cor'\ he 802,11 [SN: 0102120052] AN

Capture file: C:Wsé, \DocumentsFrontine Test Equ\\ \‘QMy Capture Files\Capture-2012-12-21_140206.cfa

Captury TEFie) 4%\ sgketsonhjw:0
ForHe 1. Click on Start Capture A\ ~

1 and then...

—~ - —
FE. Click on Coexistence View
to see the High-Speed View.

.

The Coexistence View (High Speed Live Mode) window will appear.

Coexistence View (High-Speed Live Mode)

[=]@] = ]

File Format Zoom Mavigate Help

COOD/ed e ea|ees QARG

Captured Packets
u 2,325 packets (100%)

m 60 packets/s (27 avg)

W 103,048 bils/s (62,084 avg)

Dropped Packets
m 0 packets (0%)

Packets dropped at

W Bluetooth driver: 0 (0%)

m Blustooth datasource: 0 (0%}
W 802,11 driver: 0 (0%)

m 30211 datasource: 0 (0%)
Throughput Over Time (High-Speed Live Mode)

Graph Info
W 0:01:24.624849
m 212 data points
W 400 ms/point

0:01:24 624648

For Help Press F1

Figure 4.80 - High-Speed Live Window
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4.4 Analyzing Byte Level Data
4.4.1 Event Display

To open this window click the Event Display icon 69 on the Control window toolbar.

The Event Display window provides detailed information about every captured event. Events include data
bytes, data related information such as start-of-frame and end-of-frame flags, and the analyzer information, such
as when the data capture was paused. Data bytes are displayed in hex on the left side of the window, with the
corresponding ASCII character on the right.

&3 Event Display - Homer.cfa lﬂ'
File Edit View Format Bookmarks Ortiu:n"- Window Help
Event Mumber 2 E] 4 8 910/ 1112 13/ 14/ 15 -
432 Slave
0001 5a03 ™ B 4a 04 a5 23 6b be 00 00 01 taster
4337 B 48 38 o0 23 Slave
%5 a6 23 6bbe 00 00 01 M taster
4353 |0 24 5C E 02 00 08 00 ™ Slave
Captured Byte b aster
4363 Slave
B 1bkbd c0 2300 9d 52 00 0L 0717 ™ B 21 50 Master
4385 Slave
d0 23 0b 9d 5c 00 01 5201l M B 34 50 £0 23 Ob Master
4401 B 37 68 £0 23 0b %4 Slave o
Event 4,333 of 4,331 (Frame 188) 5/3/2011 1:48:53.604338 PM
Source  ASCIT Hex Dec Oct Binary Errors
Master ' 27 3% 47 00100111 ‘Q‘\:—-..
For Help Press F1 N Captured Byte Information |

Figure 4.81 - Event Display

Click on an event to find out more about it. The three status lines at the bottom of the window are updated with
information such as the time the event occurred (for data bytes, the time the byte was captured), the value of the
byte in hex, decimal, octal, and binary, any errors associated with the byte, and more.

Events with errors are shown in red to make them easy to spot.

When capturing data live, the analyzer continually updates the Event Display as data is captured. Make sure the
Lock icon 'EI is displayed on the toolbar to prevent the display from updating (Clicking on the icon again will

unlock the display). While locked, you can review your data, run searches, determine delta time intervals
between bytes, and check CRCs. To resume updating the display, click the Lock icon again.

You can have more than one Event Display open at a time. Click the Duplicate View icon to create a

second, independent Event Display window. You can lock one copy of the Event Display and analyze your
data, while the second Event Display updates as new data is captured.

Event Display is synchronized with the Frame Display and Mesage Sequence Chart dialogs. Selecting a
byte in Event Display will also select the related frame in the Frame Display and the related message in the
Message Sequence Chart.
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4.4.2 The Event Display Toolbar

132

O « g B EUNSEm pidoe 9

Home — Brings the Control window to the front.

Open a capture file

Start Capture - Begins data capture to disk.

Stop Capture - Closes a capture file and stops data capture to disk.

Save - Prompts user for a file name. If the user supplies a name, a .cfafile is saved.

Clear- Discards the temporary file and clears the display.

Lock - In the Lock state, the window is locked so you can review a portion of data. Data
capture continues in the background. Clicking on the Lock icon unlocks the window.

Unlock - In the Unlock state, the screen fills in the data captured since the screen lock and
moves down to display incoming data again. Clicking on the Unlock icon locks the window.

Duplicate View - Creates a second Event Display window identical to the first.

Frame Display - (framed data only) Brings up a Frame Display, with the frame of the currently
selected bytes highlighted.

Display Capture Notes - Brings up the Capture Notes window where you can view or add
notes to the capture file.

Add/Modify Bookmark - Add a new or modify an existing bookmark.

Display All Bookmarks - Shows all bookmarks and lets you move between bookmarks.

Find - Search for errors, string pattemns, special events and more.

Go To - Opens the Go To dialog, where you can specify which event number to go to.

CRC - Change the algorithm and seed value used to calculate CRCs. To calculate a CRC,
select a byte range, and the CRC appears in the status lines at the bottom of the Event
Display.

Mixed Sides - (Serial data only) By default, the analyzer shows data with the DTE side above
the DCE side. This is called DTE over DCE format. DTE data has a white background and
DCE data has a gray background. The analyzer can also display data in mixed side format. In
this format, the analyzer does not separate DTE data from DCE data but shows all data on
the same line as it comes in. DTE datais still shown with a white background and DCE data
with a gray background so that you can distinguish between the two. The benefit of using this
format is that more data fits onto one screen.
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A

Character Only - The analyzer shows both the number (hex, binary, etc.) data and the
character (ASCII, EBCDIC or BAUDOT) data on the same screen. If you do not wish to see
the hex characters, click on the Character Only button. Click again to go back to both number
and character mode.

Number Only - Controls whether the analyzer displays data in both character and number
format, or just number format. Click once to show only numeric values, and again to show
both character and numeric values.

All Events - Controls whether the analyzer shows all events in the window, or only data bytes.
Events include control signal changes and framing information.

Timestamping Options — Brings up the timestamping options window which has options for
customizing the display and capture of timestamps.

4.4.3 Opening Multiple Event Display Windows

Click the Duplicate View icon ﬁ from the Event Display toolbar to open a second Event Display window.

You can open as many Event Display windows as you like. Each Event Display is independent of the others
and can show different data, use a different radix or character set, or be frozen or live.

The Event Display windows are numbered in the title bar. If you have multiple Event Displays open, click on
the Event Display icon )D on the Control window toolbar to show a list of all the Event Displays currently

open. Select a window from the list to bring it to the front.

4.4.4 Calculating CRCs or FCSs

The cyclic redundancy check (CRC) is a function on the Event Display window used to produce a checksum. The
frame check sequence (FCS) are the extra checksum characters added to a frame to detect errors.

1. Open the Event Display )D window.

2. Click and drag to select the data for which you want to generate a CRC.

3. Click on the CRC icon .

[ Choose CRC Method S |
4. Inthe CRC dialog box, click on the down arrow to show the list
of choices for CRC algorithms. Choose an algorithm to use. Choose [S':H':'m '] [ LS ]
CRC 32 (Ethernet). Choose CRC 32 (Ethernet) for Ethernet data or gﬂm 1's camp Cancel
i i Sum 2'z comp I
the appropriate CRC type for serial data. CHE boRT o
. . . . A0R 1's comp
5. Enter a Seed value in hexadecimal if desired. L XOR 2 cnmi
6. Click OK to generate the CRC. It appears in the byte information EEE:EEETT"T
lines at the bottom of the Event Display window. Whenever you EEE-E%IEETMV

select a range of data, a CRC using the algorithm you selected is

calculated automatically.

Calculating CRC for interwoven data
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Frontline calculates the CRC for either side of the interwoven data. Which side it calculates is determined by the
first byte selected. If the first byte is from one side, then Frontline calculates the CRC for just the bytes on that
side. If the first byte is from the other side, then Frontline calculates the CRC for just the bytes on that side.

Incorrect results with CRC16 for serial data

If you are calculating CRCs using the CRC16 algorithm and the CRCs do not match what you know they should be,
try CRC16rev. What hardware often calls CRC16 is what software calls CRC16rev.

4.4.5 Calculating Delta Times and Data Rates

1. Click on the Event Display icon ﬁ on the Control window to open the Event Display window.

2. Use the mouse to select the data you want to calculate a delta time and rate for.

3. The Event Display window displays the delta time and the data rate in the status lines at the bottom of
the window.

|-\

&) Event Display - Homer.cfa | = | = X

File Edit View Format Bookmarks Options Window Help

ﬂﬁﬂ%\DﬂmmeACII]

Slave

00 41 00 Ob ef 1d Od O« y 43 49 45 56 3a 1 Master

5 00 24 0b 58d 3e ( Slave

Zc 30 0d 0a 9a M b aster

31 ™ Slave

B 30 58 00 24 Ob 54 5£ 00 01 07 18 = & ISR

Slave

24 6c 00 24 0 95d 5c 00 01 58 05 ™ B 4b 54 24 [EEH)

B 43 Ze 24 0b od [N A

0 Master

4529 |5c O 2L Slave i
Event 4,449 to 4,528 of 4,831 (80 eu’enb& 5/3/2011 1:49:04.521786 PM to 5/,

Rate Celta C‘C Slave CRC Master Errors
15 ev/fsec 00:00:04,985329 80 6b 09

Figure 4.82 - Delta fields

4.4.6 Switching Between Live Update and Review Mode

The Event Display and Frame Display windows can update to display new data during live capture, or be
frozen to allow data analysis. By default, the Event Display continually updates with new data, and the Frame
Display is locked.

1. Make sure the Lock icon ‘3 is active so the display is locked and unable to scroll.
2. Click the Unlock [E icon again to resume live update.

The analyzer continues to capture data in the background while the display is locked. Upon resuming live update,
the display updates with the latest data.

You can have more than one Event Display or Frame Display window open at a time. Click the Duplicate
View icon ﬁﬁ to open additional Event or Frame Display windows. The lock/resume function is independent on
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each window. This means that you can have two Event Display windows open simultaneously, and one window
can be locked while the other continues to update.

4.4.7 Data Formats and Symbols
4.4.7.1 Switching Between Viewing All Events and Viewing Data Events
By default, the analyzer on the Event Display dialog shows all events! that include:

« Data bytes

o Start-of-frame

¢ End-of-frame characters

o Data Captured Was Paused.

Click on the Display All Events icon | toremove the non-data events. Click again to display all events.

See on page 137 for a list of all the special events shown in the analyzer and what they mean.

4.4.7.2 Switching Between Hex, Decimal, Octal or Binary

On the Event Display window the analyzer displays data in Hex by default. There are several ways to change the
radix? used to display data.

Go to the Format menu and select the radix you want. A check mark next to the radix indicates which set is
currently being used.

Bookmarks

¥ Hexadecimal
Decimal
Octal
Binary

v ASCH
7-bit ASCI
EBCDIC
Baudot

Figure 4.83 - Format Menu

1An event is anything that happens on the circuit or which affects data capture. Data bytes, control signal changes, and long
and short breaks are all events, as are 1/0 Settings changes and Data Capture Paused and Resumed.
2The base of a number system. Binary is base 2, octal is base 8, decimal is base 10 and hexadecimal is base 16.
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1. Right-click on the data display header labels and choose a different radix.

I e e e aml an
Display numbers in Binary
L Display numbers in Octal
) od 0 Display numbers in Decimal

T s v | Display numbers in Hexadecimal

Figure 4.84 - Header labels, right click

2. Orright-click anywhere in the data display and select a different radix.

l0a 98 &

30 | Copy the selection and put it on the
Save As...
Go to an Event Mumber
52|  Find
| ¥ Display Only Numbers
44 Display Only Characters
Display Sides Together

= v Display all Event Infarmation

% numbers in Binary

Display numbers in Octal
Display numbers in Decimal

v Display numbers in Hexadecimal

Figure 4.85 - Data display right click menu
If you want to see only the numerical values, click on the Numbers Only icon 1 on the Event Display
toolbar.
4.4.7.3 Switching Between ASCIIl, EBCDIC, and Baudot
On the Event Display window, the analyzer displays data in ASCIl by default when you click on the Characters

Only icon A . There are several ways to change the character set used to display data.

1. Go to the Format menu and select the character set you want. A check mark next to the character set
indicates which set is currently being used.

2. With the data displayed in characters, right-click on the data panel header label to choose a different
character set.

If you want to see only characters, click on the Characters Only icon A on the Event Display toolbar.

4.4.7 4 Selecting Mixed Channel/Sides

If you want to get more data on the Event Display window, you can switch to mixed sides mode. This mode
puts all the data together on the same line. Data from one side (Slave ) is shown on a white background and data
from the other side ( Master )is shown on a gray background.
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[ERN

Click once on the Mixed Sides icon D to put the display in mixed sides mode.

2. Click again to return to side over side mode.

3. You can right click in the center of the data display window to change between mixed and side over side
modes by selecting Display Sides Together. A check mark is displayed. Click on Display Sides
Together to remove the check mark and return to side-by-side display.

TELEDYNE LECROY

4. Rightclick in the sides panel on the right of the data display and select Display Sides Together. A check
mark is displayed. Click on Display Sides Together to remove the check mark and return to side-by-
side display.

4.4.7.5 List of all Event Symbols

By default, the Event Display shows all eventsl, which includes control signal changes, start and end of frame
characters and flow control changes. If you want to see only the data bytes, click on the All Events button | . Click

again to display all events.

Click on a symbol, and the analyzer displays the symbol name and sometimes additional information in the status

lines at the bottom of the Event Display window. For example, clicking on a control signal change symbol
displays which signal(s) changed.

In addition to data bytes, the events shown are (in alphabetical order):

Table 4.8 - Event Symbols

Symbol Event
(3 | Abort
Broken Frame - The frame did not end when the analyzer expected it to. This occurs most often
with protocols where the framing is indicated by a specific character, control signal change, or
other data related event.
@ Buffer Overflow - Indicates a buffer overflow error. A buffer overflow always causes a broken

frame.

Control Signal Change - One or more control signals changed state. Click on the symbol, and
the analyzer displays which signal(s) changed at the bottom of the Event Display window.

Data Capture Paused - The Pause icon was clicked, pausing data capture. No data is recorded
while capture is paused.

Data Capture Resumed - The Pause icon was clicked again, resuming data capture.

Dropped Frames - Some number of frames were lost. Click on the symbol, and the analyzer
displays many frames were lost at the bottom of the Event Display window.

End of Frame - Marks the end of a frame.

1An event is anything that happens on the circuit or which affects data capture. Data bytes, control signal changes, and long

and short breaks are all events, as are 1/0 Settings changes and Data Capture Paused and Resumed.
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Table 4.8 - Event Symbols (continued)
Symbol Event

Flow Control Active - An event occurred which caused flow control to become active (i.e.
M caused the analyzer to stop transmitting data) Events which activate flow control are signal
changes or the receipt of an XON character.

Flow Control Inactive - An event occurred which caused flow control to become inactive (i.e.
b caused the analyzer to transmit data). Events which deactivate flow control are signal changes
or the receipt of an XOFF character.

Frame Recognizer Change - A lowest layer protocol was selected or removed here, causing the
frame recognizer to be turned off or on.

2 I/0 Settings Change - A change was made in the 1/0O Settings window which altered the baud,
parity, or other circuit setting.

EE Long Break

X Low Power - The battery in the ComProbe® is low.

by Short Break

SPY Event (SPY Mode only) - SPY events are commands sent by the application being spied on
tothe UART.

Start of Frame - Marks the start of a frame.

Begin Sync Character Strip

End Sync Character Strip

Sync Dropped

Sync Found

Sync Hunt Entered

Sync Lost

B | m | 52| @ | <o =] @& & ==

Test Device Stopped Responding - The analyzer lost contact with the ComProbe for some
reason, often because there is no power to the ComProbe.

+

Test Device Began Responding - The analyzer regained contact with the ComProbe.

a0 Timestamping Disabled - Timestamping was turned off. Events following this event are not
timestamped.

@ Timestamping Enabled - Timestamping was turned on. Events following this event have
timestamps.
F Truncated Frame- A frame that is not the same size as indicated within its protocol.

o Underrun Error
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Table 4.8 - Event Symbols (continued)
Symbol Event

s Unknown Event

4.4.7.6 Font Size

The font size can be changed on several Event Display windows. Changing the font size on one window does not
affect the font size on any other window.

To change the font size:
1. Click on Event Display menu Options, and select Change the Font Size.

Options | Window  Help

I[ Set Timestamp Format...

Change the Font Size...
Choose CRC Method... F7

Figure 4.86 - Event Display Options menu

2. Choose afont size from the list.

.

Change Font Size

[
;
Size
I
16

Figure 4.87 - Event Display Font Size Selection
3. Click OK.

4.5 Data/Audio Extraction

You use Data/Audio Extraction to pull out data from various decoded Bluetooth protocols. Once you have
extracted the data, you can save them into different file types, such as text files, graphic files, email files, .mp3
files, and more. Then you can examine the specific files information individually.

1. You access this dialog by selecting Extract Data/Audio from the View menu or by clicking on the icon from

the toolbar g .
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Data/Audio Extraction Settings lﬁ
Select:
[7]420P [#] Open File(s) After Extraction
j ’;‘:’F“f 5C0/25C0 Options
J BRF “wiiite Streams as...
[ZIFTP () Two Mono Files
[FIHCRP @ One Steren File
[FIHF
[¥HS [] Carwert A-Law and p-law ta Linear PCM
| AP CWSD iz always converted
[@0PP
[ FEAP | Add Silence packets
[¥]5C0/5C0

| Estract Cancel

Figure 4.88 - Data/Audio Extraction Settings dialog

2. Choose a checkbox(es) on the left side of the dialog to identify from which profile(s) you want to extract
data.

It's important to note that if there is no data for the profile(s) you select, no extracted file is created.

3. If you want the file(s) to open automatically after they are extracted, select the Open File(s) After
Extraction checkbox.

Note: This does not work for SCO/eSCO.

4. Click on a radio button to write the streams as Two Mono Files or as One Stereo File.

Note: This option is for SCO/eSCO only.

5. Select the checkbox if you want to convert A-Law and p-law to Linear PCM.
CVSD are always converted to Linear PCM. It's probably a good idea to convert to Linear PCM since more
media players accept this format.

Note: This option is for SCO/eSCO only.

6. Selectthe Add Silence packets to insert the silence packets (dummy packets) for the reserved empty
slots into the extracted file. If this option is not selected, the audio packets are extracted without inserting
the silence packets for the reserved empty slots.

Note: This option is for SCO/eSCO only.
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7. Select Extract.

TELEDYNE LECROY

Save As EE'
A Save As dialog appears. Savein | 22 AP v O & @
1% aFH Change(Cha).frm
The application will assign a file name and file type - gﬁ:;:m"”
for each profile you select in Step 1 above. The file i
type varies depending on the original profile. A f,‘a
N o o Dressh
separate file for each profile will be created, but ®
only for those profiles with available data.
My Documents
8. Select alocation for the file. !a’
9. Click Save. i
. . g Fenm =
The Data Extraction Status and Audio PPl e = =
Extraction Status dialogs appear. When the
process is complete the dialogs display what files
have been created and where they are located.
Eiup dala mdraction startad i -~
[ SR TR LR e e s et e Audio Extraction Status - BipBppFipOppProfile...
Bip dats exdrachon fruched
Bop dala extraction stated e
File CADocuments ard Sethrgs\tab\D ssktophdata extisction] P8 Types: One Sterea Fis
Bipp dala exdraction frashed Pt CADocuments and Settings\atnDesktophdats
Fip data edraction staited Fierame  Statuz  Fomat  Output
File \Diocumenis and Sestingshtab\D eskicp\data exdracton’R
Fip data exdrachon frashed
Fip dala exraction stanted
File \Diocuments and Sestingshtab\Deskiophdats extractonr
Fip dala exdrachon frushed
Fip data exdraction stared
File "Documents and Settings\lab\D eskicp\data exdrachon'\Mel Processing Frame: 540 (100%]
Fip dala exdraction frushed
Ho PP data oo evact
Ma SY‘INC r.tlua Ir:n.ndlbe;dlacl @
Files whose cutensions are Lnknown
C-ADiocuments and Sellings\tab\De cklop'dala edraction\BipBppFipD ppProfles{BPFY1] Unknown
Fename to: [
Frocessng Frame: Done [ U RRMNNNARARANNNRNNRRNNENARRARRNNNNNA] pe
Figure 4.89 - Data and Audio Extraction Status
If you selected Open Files(s) After Extraction, the files open automatically.
10. If you did not select this option, you can open a file by simply double-clicking on the name.
Also, if a file type is unknown, you can select the file and it appears in the Rename to: text box.
Frontline 802.11 Hardware & Software User Manual

141



TELEDYNE LECROY Chapter 4 Capturing and Analyzing Data

Data Extraction Staius - BipBppFipOppProfiles.cla

Bip dabs exhachion dated ~
File C:\Documents and Setings\ab\Deskiopldata extiaction\BipBppFip0 ppPiofeBIPE2Lipg is Dpened |
Bip data estiaction fnished

Figure 4.90 - Rename To in the bottom section of Data Extraction Status
Then you can rename the file, adding a file type to attempt to open the file.

When you are finished, select Close to close the dialogs.
4.6 Statistics
4.6.1 Statistics Window

The Statistics window supplies basic information about the data on the network. When reviewing a capture file,
the Statistics window shows a summary of the data in the file.
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& Statistics - 802,11 =

Edit View Graph Options Window Help

® B G5

Seszion | R esettabls | Capture Fi|e|

Statiztics for the seszion
Frames / Sec Chars / Sec
Curent |0 Current |0
Awerage |0 Average |0
Peak. 1] Pealk 1]
/2842015 1:08: 45 PM T/28420151:08:45 PM
D ata
Frames: |00
Charz |0
Eventz |00
Buffer Information Errors EI
Diriver Buffer Overflow 1] FCS Errarz |0
Frames dropped by device |0

For Help Press F1

Figure 4.91 - 802.11 Statistics Window
To open the Statistics window, click the Statistics icon H] on the Control window toolbar, or choose

Statistics from the View menu on the Control window.

The analyzer monitors the network and collects statistics all the time, even when data is not actively being
captured. Activate the Lock icon f'a to stop the window from updating. Click the Unlock icon :TE again to

resume updating. The analyzer continues to monitor network traffic while the Statistics window is locked, so
you may see the numbers jump right after updating has resumed, reflecting all the statistics that were gathered
while the window was locked.
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Statistics Window Menus
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Table 4.9 - 802.11 Statistics Window Menus

Menu Selection Description
Edit Copy All To Copies all statistics to the Windows clipboard.
Clipboard
Notes Opes the notes dialog for recording comments on a capture file. Only
available when view a capture file.
Copy Chars/Sec To Copies the character rate statistics to the Windows clipboard.
Clipboard
Copy Data To Copies data statistics to the Windows clipboard.
Clipboard
Copy Errors To Copies only the FSC error statistics to the Windows clipboard.
Clipboard
Copy Buffer To Copies only the data currently in the buffer to the Windows Clipboard.
Clipboard
Copy Frames/Sec To |Copies the frame rate statistics to the Windows clipboard
Clipboard
View Control Window
Event Display
Frame Displa When checked will open the window or Statistics Window bar. When
play not checked, the window or bar is closed.
Toolbar
Status Bar
Toggle Display Lock |When checked, the displayed statistics will stop updating, although
data is still being captured. Unchecking will resume statistics
updating.
Reset Available during live capture. Resets all displayed statistics and
restarts the calculations.
Graph | Graph Errors... Opens the Errors 802.11 window.
Options | 1/0 Settings... Performs the same function as the control Window Options Menu, I/O
Settings
Set Timestamping Opens the Timestamping Options window that allows for changing the
Format resolution of the timestamps.
Change the Font Size | Opens a pop-up with font size selections.
Window | Close Window Closes the Statistics Window
ComProbe Protocol
AOETER S Clicking on these selections will change the focus from the Statistics
Statistics Window to the selected window.
Errors
Help Help Topics Opens the ComProbe Help window.
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Table 4.9 - 802.11 Statistics Window Menus (continued)

Menu Selection Description
About ComProbe Provides a pop-up showing the version and release information,
Protocol Analysis Frontline contact information, and copyright information.
System
Support on the Web | Opens a browser to fte.com technical support page.

Statistics Window Toolbar

Table 4.10 - Statistics Window Toolbar Icons
Icon Description

o Changes the focus to the Control
Window

L Reset the statistics tables

S /ﬂ Display Lock/Unlock

Timestamp Format

4.6.2 Session, Resettable and Capture File Tabs

The Session, Resettable, and Capture File tabs are parts of the
Session | Resettable | Capture File Statistics and Errors windows.

Information about all data collected since the analyzer was started is

shown in the Session tab. The Session tab cannot be reset; in this
sense, it is like the odometer on a car. The odometer on a car shows you all the miles driven since the car was
built, and the Session tab shows you all the data collected since the analyzer was started.

If you think of the Session tab as the odometer, then the Resettable tab is the trip odometer. It can be reset,
and allows you to record statistics for a new "trip". In this way you can effectively start a new session without
having to restart the analyzer. If the Reset button | # was pressed during the capture, then the numbers on this

tab differs from the numbers on the Session tab.

The timestamp appearing in Session tab fields is the timestamp of when the analysis
7/2372MB 7:0452AM  pegan. The timestamp appearing in the Resettable tab fields is the timestamp either
when the analysis began or when the last Reset was initialted.

The Capture File tab shows information on the data that is currently in the capture. If the capture file had
become full, the analyzer began to overwrite the oldest data and put new data in its place. This is called
"wrapping". If the file wrapped, the numbers on the Capture File tab is smaller than those on the Session tab.

Occasionally some of the statistics read "n/a", for Not Available. This happens for various reasons. For example,
many of the items on the Capture File tab become not available if the buffer becomes full and wraps. When this
happens, the analyzer can no longer provide accurate statistics for the data in the file, because some of the data
that the statistics are based on has been lost.
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4.6.3 Copying Statistics To The Clipboard
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Any table in the Statistics window can be copied to the clipboard where it can be pasted into any application.

1. Choose the name of the table from the Edit menu.

2. To copy the contents of all the tables, choose Copy All to Clipboard.

€ Statistics - 802.11

Edit | View Graph Options Window Help

Motes

Copy All Te Clipbeard

Copy Chars / Sec Te Clipboard
Copy Data Te Clipboard
| Copy Errors Toe Clipbeard
Copy Buffer Information To Clipboard
Copy Frames / Sec To Clipboard

Figure 4.92 - 802.11 Edit Menu for Copying

4.6.4 802.11 Error Statistics

The Wi-Fi Error Statistics window appears
when you select the window from the @ icon

in the Control window toolbar or the Frame
Display toolbar. The dialog is view only; there
is no user interaction possible.

The window displays the percentage of packets
with and without errors in a pie chartand in a
table.

4.6.5 Graphs
4.6.5.1 Statistics Errors Graphs

i Wi rer ta e

. oAl = ]

ot llep ez 1

Total

Mo Errors 30085 94%
Errars

1991 &%

Open the Statistics window and click on the picture of a graph EI on the Errors table header, or choose the

graph name from the Graph menu on the Statistics window.
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The Frame Sizes Graph window has Session, Resettable and Capture File tabs that correspond to the tabs on

the Statistics window. Each tab shows the data that corresponds to the appropriate tab on the Statistics
window.

The window displays the errors in either a pie chart or bar graph format. Click the Pie icon @ to display a pie

chart, and click the Bar icon lllﬂ to display a bar graph.

4.6.5.2 Printing Error Graphs

Click the Printicon & to print the graph. The analyzer prints exactly what is shown in the window.
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Evenywhereyoulook

Chapter 5 Navigating and Searching the Data

The following sections describe how to navigate through the data and how to find specific data or packet

conditions of interest to the user.

5.1 Find

Capturing and decoding data within the ComProbe analyzer produces a wealth of information for analysis. This
mass of information by itself, however, is just that, a mass of information. There has to be ways to manage the
information. ComProbe software provides a number of different methods for making the data more accessible.

One of these methods is Find.

Search foe Beesiamp
Marth Yo
Dy Hoix Minide

(3o bo the hinectsmp
On of before the specied bme
O of slter the specified ime

Decode | Patbem | Time  GoTo | Specisl Events | Bookmark

Second

17 000000 Secords

Figure 5.1 - Find Dialog
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Find, as the name suggests, is a comprehensive search function that allows users to search for strings or patterns
in the data or in the frame decode. You can search for errors, control signal changes, bookmarks, special events,
time, and more. Once the information is located, you can easily move to every instance of the Find results.

5.1.1 Searching within Decodes

Searching within decodes lets you to do a string search on the data in the Decode Pane of the Frame Display
window.

To access the search within decodes function:

1. Open acapture file to search.

2. Open the Event Display p or Frame Display window.
3. Click on the Find icon ﬂﬂ or choose Find from the Edit menu.

4. Click on the Decode tab of the Find dialog.

Note: The tabs displayed on the Find dialog depend on the product you are running and the
content of the capture file you are viewing.

¥ Find - 5iX]

Decode | Pattesn | Time | GoTo| Special Everts | Bookmark,

':E: Caaich Fod S"..'-ng Ir D aeade [ ] Iwe LA

() Search For Al Emors Hekr

) Search For Frame En§ﬂr¢-
) Search For Infoemation Frames

Figure 5.2 - Find Decode Tab Search for String
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% Find

() Search For AN Emors

Sade Resinchon

(2 Semch only these sides

FI0TE
[FJ0CE

Decode  Patterr| Teew | GoTo| Specisl Events | Signal | Eror | Boc 4 B

(%) Search For String In Decode

() Search For Fraeme Enoes Only
() Search For Infoimation Frames

(%) Search wathout segaed ko data origin

=3

Cirene case

w Firsd Prenvaois

Figure 5.3 - Find Decode Tab Side Restriction

There are several options for error searching on the Decoder tab.

TELEDYNE LECROY

« Search For String in Decoder allows you to enter a string in the text box. You can use characters, hex or
binary digits, wildcards or a combination of any of the formats when entering your string. Every time you type
in a search string, the analyzer saves the search. The next time you open Find, the drop-down list will contain

your search parameters.

« Search for All Errors finds frame errors as well as frames with byte-level errors (such as parity or CRC

errors).

« Search for Frame Errors Only finds frame specific errors, such as frame check errors.

« Search for Information Frame only searches information frames.

1. Enter the search string.

2. Check Ignore Case to do a case-insensitive search.

3. When you have specified the time interval you want to use, click on the Find Next or Find Previous

buttons to start the search from the current event.

The result of the search is displayed in the Decode pane in Frame Display.
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Side Restrictions - Side Restriction means that the analyzer

looks for a pattern coming wholly from the DTE or DCE side. If you "4 Event Display

choose to search without regard for data origin, the analyzer looks Fla Edt View Format Opbions ‘Window Help

for a pattern coming from one or both sides. For example, if you a =R ﬁ 5 2 a3 A % go
choose to search for the pattern ABC and you choose to search Event Murber Bcﬁsm o ~

without regard for data origin, the analyzer finds all three instances
of ABC shown here.

ABC DCE

W
The first pattern, with the A and the C coming from the DTE device Evork 1610 47 of 6,425 (27 everts) ~

and the B coming from the DCE is a good example of how using a IMe Delts CRC OTE | CRC DCE
side restriction differs from searching without regard to data origin. |- o Timestamp = = No Timestamp - % 35
While searching without regard for data origin finds all three JFor Help press F1o

patterns, searching using a side restriction never finds the first
pattern, because it does not come wholly from one side or the
other.

If you choose to search for the pattern ABC, and you restrict the
=1 Event Display E“Eﬂgj search to just the DTE side, the analyzer finds the following pattern:

AR RN o e In thi le, the analyzer finds only th d patt
& A P g In this example, the analyzer finds only the second pattern
?mu H! Iﬂ S 2 ai & s | (highlighted above) because we restricted the search to just the
Cﬁ' DTE DTE side. The first pattern doesn't qualify because it is split between
B BC DCE the DTE and DCE sides, and the third pattern, though whole, comes
from just the DCE side.

W
Ewent 16 to 42 of £,425 (27 ewents)
Rate Dea CRCDTE CRCDCE
-- N Timestamp — | -- Mo Timestamp -- 9 35

| For Helo Press Fl

If we choose both the DTE and the DCE sides in the above example,
then the analyzer finds the second pattern followed by the third
pattern, but not the first pattern. This is because each side has one
instance in which the whole pattern can be found. The analyzer
completely searches the DTE side first, followed by the DCE side.

Note: Side Restriction is available for pattern and error searching.

1. Select one of the two options.
2. SelectDTE, DCE, or both.

3. When you made your selections, click on the Find Next or Find Previous buttons to start the search
from the current event.

The result of the search is displayed in the Decode pane in Frame Display.

5.1.2 Searching by Pattern

Search by Pattern lets you perform a traditional string search. You can combine any of the formats when
entering your string, and your search can include wildcards.

To access the search by pattern function:

1. Open acapture file to search.

2. Open the Event Display 6@ or Frame Display ] window.
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3. Click on the Find icon ﬂﬂ or choose Find from the Edit menu.

4. Click on the Pattern tab of the Find dialog.

Note: The tabs displayed on the Find dialog depend on the product you are running and the
content of the capture file you are viewing.

 Find EEX]

| Decode Pattemn | Time | GoTo| Special Events | Bookmark

Pt 3

Enter: Hex values as $ux [Jignore case Find Pravious
Binary values as &bbbbbbbb
Control characters as "¢
7 malches ang byte, o hex o binary digit
To enter $&77 or \, prefix with character \

Figure 5.4 - Find Pattern Tab

¥ Find E@lgl

Decods | Fattem | Time | GoTo| Special Events | Sigral | Emor | Boc € F

e -

Enter; Hex valons as fux [ igrioe caze Fired P
En:l]-'v::iﬂl-bbm i
onivol aclers i o

7 matches any bte. of hex o biary dit

To enbe $1™7 o0 \, poefoc wath chasaches

Sida Rastchon

(¥) Seaich without regaid o dsta orign

() Search only thess sides [#]DTE
[#]DCE

Figure 5.5 - Find Pattern Tab Side Restrictions

Pattern allows you to enter a string in the text box. You can use characters, hex or binary digits, control
characters, wildcards or a combination of any of the formats when entering your string. Every time you type in a
search string, the ComProbe analyzer saves the search. The next time you open Find, the drop-down list will
contain your search parameters.

1. Enter the search pattern.

2. Check Ignore Case to do a case-insensitive search.
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3. When you have specified the pattern you want to use, click on the Find Next or Find Previous buttons
to start the search from the current event.

The result of the search is displayed in the in Frame Display and Event Display.
Refer to Searching by Decode on page 150 for information on Side Restrictions
5.1.3 Searching by Time

Searching with Time allows you search on timestamps on the data in Frame Display and Event Display
window.

To access the search by time function:

1. Open acapture file to search.

2. Open the Event Display 4@ or Frame Display EI window.

3. Click on the Find icon ﬂﬂ or choose Find from the Edit menu.
4. Click on the Time tab of the Find dialog.

Note: The tabs displayed on the Find dialog depend on the product you are running and the
content of the capture file you are viewing.

LEX

Decods | Pattem | Tine | GoTo | Special Events | Bookmard

Seachfor = Absckde

() Redative S
et L
Aasguat w 2007 v

Day Houw Hinute Second 11000000 Secords
A = = 133 = |9 = | | 931000 =

-

G bo e brmestamp
(%) O of bedore the spacifiad tims
) Oinov after the wpecified tme

Figure 5.6 - Find by Time tab
The analyzer can search by time in several different ways.

Search for Absolute/Relative timestamp.
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o Absolute - An absolute timestamp search means that the analyzer searches for an event at the exact date and
time specified. If no event is found at that time, the analyzer goes to the nearest event either before or after
the selected time, based on the "Go to the timestamp" selection.

« Relative - A relative search means that the analyzer begins searching from whatever event you are currently
on, and search for the next event a specific amount of time away.

1. Select Absolute or Relative

2. Select the date and time using the drop-down lists for Month, Year, Day, Hour, Minute, Second,
1/10000000.

Note: Month and Year are not available if you select Relative.

3. When you have specified the time interval you want to use, click on the Go To, Move Forward or Move
Backward buttons to start the search from the current event.

Note: When you select Absolute as Search for, Go To is available. When you
select Relative as Search for, Move Forward or Move Backwardis available.

Go to the timestamp: On or before/ On or after

The analyzer searches for an event that matches the time specified. If no event is found at the time specified, the
analyzer goes to the nearest event either before or after the specified time. Choose whether to have the analyzer
go to the nearest event before the specified time or after the specified time by clicking the appropriate radio
button in the Go to the timestamp box.

If you are searching forward in the buffer, you usually want to choose the On or After option. If you choose the
On or Before option, it may be that the analyzer finishes the search and not move from the current byte, if that
byte happens to be the closest match.

When you select Absolute as Search for, the radio buttons are On or before the specified time or On or
after the specified time. When you select Relative as Search for, the radio buttons are On or before the
specified time relative to the first selected item or On or after the specified time relative to the last
selected item.

1. Select On or before the specified time or On or after the specified time.

2. When you have specified the time interval you want to use, click on the Go To, Move Forward or Move
Backward buttons to start the search from the current event.

When you select Absolute as Search for, Go To is available. When you select Relative as Search for,
Move Forward or Move Backwardis available.

There are a couple of other concepts to understand in respect to searching with timestamps.

o The analyzer skips some special events that do not have timestamps, such as frame markers. Data events that
do not have timestamps because timestamping was turned off either before or during capture are also
skipped.
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« Timestamping can be turned on and off while data is being captured. As a result, the capture buffer may have
some data with a timestamp, and some data without. When doing a search by timestamp, the analyzer ignores
all data without a timestamp.

o The raw timestamp value is the number of 100-nanosecond intervals since the beginning of January 1, 1601.
This is standard Windows time.

5.1.4 Using Go To

Searching with Go To allows you to go to a particular frame or event, or to move through the data X number of
events or frames at a time. You can move either forward or backwards through the data.

To access the Go To function:

1. Open acapture file to search.

2. Open the Event Display 6@ or Frame Display window.

3. Click on the Find icon ﬂﬂ or choose Find from the Edit menu.

4. Click on the Go To tab of the Find dialog.

5. The system displays the Find dialog with the Go To tab selected.

Note: The tabs displayed on the Find dialog depend on the product you are running and the
content of the capture file you are viewing.

Decods | Pattesn | Tene | G0 To | Specasl Events | Bockemark

(%) Frasre Husmbees 1 &. covand

() Drats E vk Murnbses | Meve Back
........... J

() A Everts Nussber

*f{E _H,_.‘? —

Figure 5.7 - Find Go To tab

To go to a particular frame :
1. Select the Frame Number radio button
2. Type the frame number in the box.

3. Click the Go To button.
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4. To move forward or backward a set number of frames, type in the number of frames you want to move

5.

Then click the Move Forward or Move Back button.

To go to a particular event :

1.

2.

Select the Data Event Number or All Events Number radio button.
Type the number of the event in the box.
Click the Go To button.

To move forward or backwards through the data, type in the number of events that you want to move
each time.

Then click on the Move Forward or Move Backward button.

For example, to move forward 10 events, type the number 10 in the box, and then click on Move
Forward. Each time you click on Move Forward, Frontline moves forward 10 events.

See Event Numbering for why the Data Event Number and All Events Number may be different. As a
general rule, if you have the Show All Eventsicon | depressed on the Event Display window or Frame

Display Event pane, choose All Events Number. If the Show All Events button is up, choose Data Event
Number.

5.1.5 Searching for Special Events

Frontline inserts or marks events other than data bytes in the data stream. For example, the analyzer inserts start-
of-frame and end-of-frame markers into framed data, marking where each frame begins and ends. If a hardware
error occurs, the analyzer shows this using a special event marker. You can use Find to locate single or multiple
special events.

To access the search for special events function:

1.

2.

Open a capture file to search.

Open the Event Display p or Frame Display EI window.

Click on the Find icon ﬂﬂ or choose Find from the Edit menu.

Click on the Special Events tab of the Find dialog.

Note: The tabs displayed on the Find dialog depend on the product you are running and
the content of the capture file you are viewing.
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Figure 5.8 - Find Special Events tab

5. Check the event or events you want to look for in the list of special events. Use Check All or Uncheck

All buttons to make your selections more efficient.

6. Click Find Next and Find Previous to move to the next instance of the event.

Not all special events are relevant to all types of data. For example, control signal changes are relevant only to

serial data and not to Ethernet data.

For a list of all special events and their meanings, see List of all Event Symbols on page 137.

5.1.6 Searching by Signal

Searching with Signal allows you to search for changes in control signal states for one or more control signals. You
can also search for a specific state involving one or more control signals, with the option to ignore those control
signals whose states you don’t care about.

The analyzer takes the current selected byte as its initial condition when running searches that rely on finding
events where control signals changed.

To access the search by time function:

1. Open acapture file to search.

2. Open the Event Display P or Frame Display EI window.

3. Click on the Find icon ﬂﬂ or choose Find from the Edit menu.

4. Click on the Signal tab of the Find dialog.
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Note: The tabs displayed on the Find dialog depend on the product you are running and the
content of the capture file you are viewing.
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Figure 5.9 - Find Signal tab.
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Figure 5.10 - Find Signal Tab
You will choose one qualifier—Searching for event where, then choose one or more control signals
Control Signals

The section with the check boxes allows you to specify which control signals the analyzer should pay attention to
when doing the search. The analyzer pays attention to any control signal with a check mark.

o Click on a box to place a check mark next to a control signal
o Click again to uncheck the box
« By default, the analyzer searches all control signals, which means all boxes start out checked.

For example, if you are only interested in finding changes in RTS and CTS, you would check those two boxes
and uncheck all the other boxes. This tells the analyzer to look only at the RTS and CTS lines when running the
search. The other signals are ignored.

The control signals types include:
« USB-Pin1
« USB-Pin2
« USB-Pin3
« USB-Pin4

« RS232-Requestto Send (RTS)

« RS232-Clearto Send (CTS)

o RS232-Data Set Ready (DSR)

o RS232-Data Terminal Ready (DTR)
« RS8232 - Carrier Detect (CD)

« RS232 - Ring Indicator (RI).

Click here to learn more about the Breakout Box and Pins 1 - 4.

Searching for event where:

o The first three options are all fairly similar, and are described together. These options are searching for an
event where:

o One or more control signals changed
o One or more control signals changed from off to on
o One or more control signals changed from on to off

o Searching for an event where one or more signals changed means that the analyzer looks at every control
signal that you checked, and see if any one of those signals changed state at any time.
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o If you want to look at just one control signal:

m Check the box for the signal.
m Uncheck all the other boxes.
m Choose to search for an event where one or more signals changed.

m The analyzer notes the state of the selected signal at the point in the buffer where the cursor is,
search the buffer, and stop when it finds an event where RTS changed state.

m If the end of the buffer is reached before an event is found, the analyzer tells you that no matches
were found.

« Searching for events where control signals changed state from off to on, or vice versa, is most useful if the
signals are usually in one state, and you want to search for occasions where they changed state.

For example:

(o}

o

o

o

If DTR is supposed to be on all the time but you suspect that DTR is being dropped
Tell the analyzer to look only at DTR by checking the DTR box and unchecking the others
Do a search for where one or more control signals changed from on to off.

The analyzer would search the DTR signal and stop at the first event where DTR dropped from on to off.

o Searching for an Exact State

To search for an exact state means that the analyzer finds events that match exactly the state of the control
signals that you specify.

[0}

First, choose to search for an event where your choices exactly describe the state.

This changes the normal check boxes to a series of radio buttons labeled On, Off and Don’t Care for
each control signal.

Choose which state you want each control signal to be in.
Choose Don’t Care to have the analyzer ignore the state of a control signal.

When you click Find Next, the analyzer searches for an event that exactly matches the conditions
selected, beginning from the currently selected event.

If the end of the buffer is reached before a match is found, the analyzer asks you if you want to
continue searching from the beginning.

If you want to be sure to search the entire buffer, place your cursor on the first event in the buffer.
Select one of the four radio buttons to choose the condition that must be met in the search
Select one or more of the checkboxes for Pin 1, 2, 3, or 4.

Or, Select one or more of the checkboxes for Request to Send (RTS), Clear to Send (CTS), Data Set
Ready (DSR), Data Terminal Ready (DTR), Carrier Detect (CD), and Ring Indicator (RI).

Click Find Next to locate the next occurrence of the search criteria or Find Previous to locate an
earlier occurrence of the search criteria.
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5.1.7 Searching for Data Errors

The analyzer can search for several types of data errors. Searching for data error sallows you to choose which
errors you want to search for and whether to search the DTE or DCE data or both. Bytes with errors are shown in
red in the Event Display window, making it easy to find errors visually when looking through the data.

To access the search by time function:

1. Open acapture file to search.

2. Open the Event Display p or Frame Display window.
3. Click on the Find icon ﬂﬂ or choose Find from the Edit menu.
4. Click on the Errors tab of the Find dialog.

Note: The tabs displayed on the Find dialog depend on the product you are running and the
content of the capture file you are viewing.

€ Find - BPAS00.cfa =B %
| Decode ! Pattern E Time E GaTo E Special Eventsi Error ! Bookmark|
Search for event where: 3
@ One or more of these changed

& ~. This exactly
: One or more of these occured e
() One or more of these waz off

Side Festriction

 Search without regard to
~ data origin

[ Reservedl

@) Search only these sides:

[ 5lave
[ M aster

Figure 5.11 - Find Error tab.
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Searching for event where

The first three options are all fairly similar, and are described together. These options are searching for an event
where:

e one or more error conditions changed

« one or more error conditions occurred

e one or more error conditions were off (i.e. no errors occurred)
Selecting Which Errors to Search

The section with the check boxes allows you to choose which errors the analyzer should look for. Click on a box
to check or un-check it.

If you want to search only for overrun errors
o check the box if shown
o un-check the other boxes.
To search for all types of errors
o check all boxes
The most common search is looking for a few scattered errors in otherwise clean data.
To do this type of search:
« choose to Search for an event where one or more error conditions occurred
« choose which errors to look for
« By default, the analyzer looks for all types of errors.

In contrast, searching for an event where one or more error conditions were off means that the analyzer looks for
an event where the errors were not present.

For example, if you have data that is full of framing errors, and you know that somewhere in your 20 megabyte
capture file the framing got straightened out, you could choose to search for an event where one or more error
conditions were off, and choose to search only for framing. The analyzer searches the file, and finds the point at
which framing errors stopped occurring.

Searching for an event where the error conditions changed means that the analyzer searches the data and stop at
every point where the error condition changed from on to off, or off to on.

For example, if you have data where sometimes the framing is wrong and sometimes right, you would choose to
search framing errors where the error condition changed. This first takes you to the point where the framing
errors stopped occurring. When you click Find Next, the analyzer stops at the point when the errors began
occurring again. Clicking Find Previous will search backwards from the current postion.

The analyzer takes the current selected byte as its initial condition when running searches that rely on finding
events where error conditions changed. The analyzer searches until it finds an event where error conditions
changed or it reaches the end of the buffer, at which point the analyzer tells you that there are no more events
found in the buffer. If you are searching for an exact match, the analyzer asks you if you want to continue
searching from the beginning of the buffer.

Searching for Exact Error Conditions
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« Select the appropriate state for each type of error.
Example:

If you need to find an event where just an overrun error occurred, but not any other type of error, you would
choose overrun error to be On, and set all other errors to Off. This causes the analyzer to look for an event where
only an overrun error occurred.

If you want to look for events where overrun errors occurred, and other errors may have also occurred but it
really doesn’t matter if they did or not, choose overrun to be On, and set the others to Don’t Care. The analyzer
ignores any other type of error, and find events where overrun errors occurred.

To find the next error, click the Find Next button. To find an error that occurred earlier in the buffer to where you
are, click the Find Previous button.

5.1.8 Find - Bookmarks

Searching with Bookmarks allows you search on specific bookmarks on the data in Frame Display and Event
Display window. Bookmarks are notes/reminders of interest that you attach to the data so they can be accessed
later.

To access the search for bookmarks

1. Open acapture file to search.

2. Open the Event Display p or Frame Display EI window.
3. Click on the Find icon ﬂ!ﬂ or choose Find from the Edit menu.

4. Click on the Bookmarks tab of the Find dialog.

Note: The tabs displayed on the Find dialog depend on the product you are running and the content of the
capture file you are viewing.
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Figure 5.12 - Find Bookmark tab.
There are several ways to locate bookmarks.
o Select the bookmark you want to move to and click the Go To button.
o Simply double-click on the bookmark.

« Click the Move Forward and Move Back buttons to move through the frames to the bookmarks shown in
the window. When the bookmark is found it is highlighted in the window.

There are three ways to modify bookmarks:

1. Click on Delete to remove the selected bookmark.

2. Click on Modify... to change the selected Bookmark name.

3. Remove All will delete all bookmarks in the window.
The Find window Bookmark tab will also appear when using functions other than Find such as when clicking on
the Display All Bookmarks L"J
5.1.9 Changing Where the Search Lands

icon.

When doing a search in the analyzer, the byte or bytes matching the search criteria are highlighted in the Event
Display. The first selected byte appears on the third line of the display.

[CVEventDisplay] To change the line on which the first selected byte appears:

SelectionOffset=2

1. Open fts.ini (located in the C:\User\Public\Public Documents\Frontline Test
Equipment))

2. Go to the [CVEventDisplay] section
3. Change the value for SelectionOffset.

4. If you want the selection to land on the top line of the display, change the SelectionOffset to 0 (zero).
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5.1.10 Subtleties of Timestamp Searching

Chapter 5 Navigating and Searching the Data

Timestamping can be turned on and off while data is being captured. As a result, the capture buffer may have
some data with a timestamp, and some data without. When doing a search by timestamp, the analyzer ignores all

data without a timestamp.

Note: The raw timestamp value is the number of 100-nanosecond intervals since the
beginning of January 1, 1601. This is standard Windows time.

5.2 Bookmarks

Bookmarks are electronic sticky notes that you attach to frames of interest so they can be easily found later. In
Frame Display bookmarked frames appear with a magenta triangle icon next to them.

B... Framail Command Erct Code =~ FID MID FiD Sewrca TID 11u] Fra... Dlekts Tinethamp s
[ 126201011:25.
2 168 00C00:00.0.. T2/67200011:25.
> E3 124 0000-00.3 12/E/2M011:25
1 [ 00000:00.1 12652000 11:25.

Figure 5.13 - Bookmarked Frame (3) in the Frame Display

00 00 00 00 00
21 M ifoo 15
00 4500 00 47

marker.

In the Event Display bookmarks appear as a dashed line around the start of frame

When you create or modify a bookmark, you have up to 84 characters to explain a

problem, leave yourself a reminder, leave someone else a reminder, etc. Once you create a bookmark it will be

saved with the rest of the data in the .cfa file. When you open a .cfa file, the bookmarks are available to you.

Once you have created a bookmark, you can use the Find function or other navigation methods to locate and

move among them.

5.2.1 Adding, Modifying or Deleting a Bookmark

You can add, modify, or delete a bookmarks from Frame Display and Event Display

Add:
1. Select the frame or event you want to bookmark.

2. There are three ways to access the Add Bookmark dialog.

a. Select Add or Modify Bookmark from the Bookmarks menu on the Frame Display and

Event Display,

b. Selectthe Add or Modify Bookmark L'-li icon on one of the toolbars, or

c. Right-click on the frame/event and choosing Add Bookmark....

3. In the dialog box, add a comment (up to 84 characters) in the text box to identify the bookmark.

4. Click OK.

Bookmarks are easy to create and maintain, and are a very valuable tool for data analysis.

Once you create a bookmark it will be saved with the rest of the data in the .cfa file. When you open a .cfa file, the

bookmarks are available to you.
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Modify
1. Select the frame or event with the bookmark to be edited.
2. There are three ways to access the Add/Modfy Bookmark dialog.

a. Select Add or Modify Bookmark from the Bookmarks menu on the Frame Display and
Event Display'

b. Selectthe Add or Modify Bookmark Ln icon on one of the toolbars, or

c. Right-click on the frame/event and choosing Modify Bookmark... on the selection.
3. Change the comment in the dialog box
4. Click OK. The edited bookmark will be saved as a part of the .cfa file.
5. You can also select Display All Bookmarks [ from the Frame Display and Event Display toolbar

or the Bookmarks menu. the Find window will open on the Bookmark tab. Select the bookmark you
want to modify and click the Modify... button. Change the comment in the dialog box, and click OK.

Delete
1. Select the frame or event with the bookmark to be deleted.
2. There are three ways to access the Add/Modfy Bookmark dialog.

a. Select Add or Modify Bookmark from the Bookmarks menu on the Frame Display and
Event Display,

b. Selectthe Add or Modify Bookmark Ln icon on one of the toolbars, or

c. Right-click on the frame/event and choosing Modify Bookmark... on the selection.
3. Click on the Delete button. The bookmark will be deleted.
4. You can also select Display All Bookmarks 3 from the Frame Display and Event Display toolbar

or the Bookmarks menu. the Find window will open on the Bookmark tab. Select the bookmark you
want to delete and click the Delete button.

5.2.2 Displaying All and Moving Between Bookmarks
There are three ways to move between bookmarks.
1. Pressthe F2 key to move to the next frame or event with a bookmark.
2. Select Go to Next Bookmark from the Bookmarks menu.
3. Click the Display All Bookmarks icon L'J . Select the bookmark you want to move to and click the Go To

button, or simply double-click on the bookmark. Click the Move Forward and Move Back buttons to cycle
through the bookmarks.
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¥ Find - dual_maode_capture_01.cfa
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Figure 5.14 - Find Window Bookmark tab Used to Move Around With Bookmarks
To delete a bookmark, select it and click the Delete button.
To modify a bookmark, select it and click the Modify button.

Click Remove All to delete all the bookmarks.
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Chapter 6 Saving and Importing Data
6.1 Saving Your Data

You can save all or part of the data that you have captured. You can also load a previously saved capture file, and
save a portion of that file to another file. This feature is useful if someone else needs to see only a portion of the
data in your capture file.

On the Control window toolbar you can set up to capture a single file. Click here to see those settings.

There are two ways to save portions or all of the data collected during a data capture. Click here to see how to
capture data to disk.

6.1.1 Saving the Entire Capture File

This option is only available when you select Single File from the Capture Mode on System Settings. Click
here to learn more about selecting Save options from System Settings.

1. If you are capturing data, click on the Stop Capture [ icon to stop data capture. You cannot save data to
file while it is being captured.

2. Openthe Event Display P or Frame Display ‘ window.

3. Click the SaveE icon, or select Save from the File menu.
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Figure 6.1 - Windows Save dialog

4. Type afile name in the File name box at the bottom of the screen.

5. Browse to select a specific directory. Otherwise your file is saved in the default capture file directory.

6. When you are finished, click OK.

6.1.2 Saving the Entire Capture File with Save Selection

170

1. Ifyou are capturing data, click on the Stop icon [g to stop data capture. You cannot save data to file while

it is being captured.

2. Open the Event Display por Frame Display I\ window.

3. Rightclickin the data

4. Select Save Selection or Save As from the right click
menu.

5. Click on the radio button labeled Entire File.

6. Choose to save Events or Frames . Choosing to save
Events saves the entire contents of the capture file.
Choosing to save Frames does not save all events in the
capture file.

7. Type afile name in the As box at the bottom of the screen.

Click the Browse icon to browse to a specific directory.
Otherwise your file is saved in the default capture file
directory.

8. When you are finished, click OK.
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6.1.3 Saving a Portion of a Capture File

1.

If you are capturing data, click on the Stop icon [ to pause data capture.You cannot save data to afile
while it is being captured.

Open the Event Display éﬁj or Frame Display window, depending on whether you want to
specify a range in bytes or in frames.

Select the portion of the data that you want to save. Click and drag to select data, or click on the first item,
move to the last item and Shift+Click to select the entire range, or use the Shift key with the keyboard
arrows or the navigation icons in the Frame Display toolbar. If the range you want to save is too large to
select, note the numbers of the first and last item in the range.

Right click in the data

Select Save Selection or Save As from the right click

menu soess &

Click on the radio button labeled Selection. If you selected | Save
arange, make sure the starting and ending numbers are (} Entits Fis ol
correct. To specify a range, type the numbers of the first () Selection g
and last items in the range in the boxes. () Eventz  (5) Frames
Select either Events or Frames to indicate whether the ] i’
numbers are event or frame numbers.

&z | Type e names heid Q

Ty.pe a file name |rf the As box at the botto‘r’r? of.the screen. Hote: No cepiuring vl be v whio the
Click the Browse icon to browse to a specific directory. fibe: i bty vl

Otherwise your file is saved in the default capture file
directory.

Click OK when you are finished.

6.2 Adding Comments to a Capture File

The Notes feature allows you to add comments to a CFA file. These comments can be used for many purposes.
For example, you can list the setup used to create the capture file, record why the file is useful to keep, or include

notes to another person detailing which frames to look at and why. (Bookmarks are another useful way to record

information about individual frames.)

To open the Notes window :

TELEDYNE LECROY

1. Click the Show Notes icon LPJ . This icon is present on the toolbars of the Frame Display @, as well

as the Event Display éﬁj . Notes can be selected from the Edit menu on one of these windows.
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2. Type your comments in the large edit box on the Notes window. The Cut, Copy, Paste features are

A & @

are all supported from Edit menu and the toolbar A at the current cursor location.

supported from Edit menu and the toolbar when text is selected. Undo and Redo features

3. Click the thumbtack icon 49 to keep the Notes window on top of any other windows.

4. When you're done adding comments, close the window.

5. When you close the capture file, you are asked to confirm the changes to the capture file. See Confirming
Capture File (CFA) Changes for more information.

6.3 Confirm Capture File (CFA) Changes

This dialog appears when you close a capture file after changing the Notes, the protocol stack, or bookmarks. The
dialog lists information that was added or changed and allows you to select which information to save, and
whether to save it to the current file or to a new one.

Changes made to the file appear in a list in the left pane. You can click on each item to see details in the right pane
about what was changed for each item. You simply check the boxes next to the changes you want to keep. Once
you decide what changes to keep, select one of the following:

« Save To This File — Saves the changes you have made to the current capture file.
o Save As - Saves the changes to a new file.
« Cancel the Close Operation — Closes the file and returns you back to the display. No changes are saved.

« Discard Changes - Closes the file without saving any of the changes made to the notes, bookmarks, or
protocol stack.

6.4 Loading and Importing a Capture File
6.4.1 Loading a Capture File

From the Control Window:
1. Go to the File menu.
2. Choose afile from the recently used file list.
3. If the file is not in the File menu list, select Open Capture File from the File menu or simply click on the
Open icon g on the toolbar.

4. Capture files have a .cfa extension. Browse if necessary to find your capture file.

5. Click on your file, and then click Open.
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6.4.2 Importing Capture Files

1. From the Control window .@, go to the File menu and select Open Capture File or click on the Open
icon on the toolbar.

2. Left of the File name text box, select from the drop-down list Supported File Types box to All
Importable File Types or All Supported File Types (*.cfa, *.log, *.txt, *.csv, *.cap). Select the file
and click Open.

The analyzer automatically converts the file to the analyzer's format while keeping the original file in its original
format. You can save the file in the analyzer's format, close the file without saving it in the analyzer's format, or

have the analyzer automatically save the file in the analyzer's format (see the System Settings to set this option).
All of these options keep your original file untouched.

When you first open the file, the analyzer brings up the Protocol Stack window and ask you what protocol
decodes, if any, you want to use. You must choose a protocol decode at this point for the analyzer to decode the
data in the file. If you open a file without using any decodes, and decide later that you want to apply a decode,
choose Reframe from the File menu on the Control window.

At present, the analyzer supports the following file types:

« Frontline Serialtest* Async and Serialtest ComProbe® for DOS — requires the .byt for data and the .tim for
timestamps (see note on importing DOS timestamps).

« Greenleaf ViewComm?* 3.0 for DOS - requires the .byt for data and the .tim for timestamps (see note on
importing DOS timestamps).

o Frontline Ethertest* for DOS — requires 3 files: filename.cap, filename.ca0 and filename.cal.
« Sniffer Type 1 — supports files with the .enc extension. Does not support Sniffer files with a .cap extension.

o Snoop or Sun Snoop — files with a .cap extension based on RFC 1761. For file format, see
http://www.fags.org/rfcs/rfc1761.html.

« Shomiti Surveyor files in Snoop format — files with a .cap extension. For file format, contact Technical Support.

o CATC Merlin - files with a .csv extension. Files must be exported with a specific format. See File Format for
Merlin Files for information.

e CATC Chief - files with a .txt extension.

6.5 Printing
6.5.1 Printing from the Frame Display/HTML Export

The Frame Display Print dialog and the Frame Display HTML Export are very similar. This topic discusses
both dialogs.

Frame Display Print

The Frame Display Print feature provides the user with the option to print the capture buffer or the current
selection. The maximum file size, however, that can be exported is 1000 frames.

When Print Preview is selected, the output displays in a browser print preview window, where the user can
select from the standard print options. The output file format is in html, and uses the Microsoft Web Browser
Control print options for background colors and images.
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Print Background Colors Using Internet Explorer
1. Open the Tools menu on the browser menu bar
2. Select “Internet Options...” menu entry.
3. Click Advanced tab.
4. Check “Print background colors and images” under the Printing section
5. Click the Apply button, then click OK
Configure the Print File Range in the Frame Display Print Dialog

Selecting more than one frame in the Frame Display window defaults the radio button in the Frame Display Print
dialog to Selection and allows the user to choose the All radio button. When only one frame is selected, the All
radio button in the Frame Display Print dialog is selected.

How to Print Frame Display Data

1. Select Print or Print Preview from the File menu on the Frame Display window to display the Frame
Display Print dialog. Select Print if you just want to print your data to your default printer. Select Print
Preview if you want access to printer options.

2. Choose to include the Summary pane (check the box) in the print output. The Summary pane appears at
the beginning of the printed output in tabular format. If you select All layers in the Detail Section, the
Data Bytes option becomes available.

3. Inthe Detail Section, choose to exclude—No decode section—the decode from the Detail pane in
the Frame Display, or include All Layers or Selected Layers Only. If you choose to include selected
layers, then select (click on and highlight) the layers from the list box.

4. Click on selected layers in the list to de-select, or click the Reset Selected Layers button to de-select all

selected layers.
Frame Display Print E]

Prowade mformation 1o export data lrom the cusently selacted fiter tab

Inechidle Uietad 5echon
[+] Summary (%) Mo decode techon
(0l layers
() Seleched Lypess cnly
Frame Fangs
B02.11 AMP -
802h -5TP
(%) Selacton 0214
B2DP
AMP Manager =
Ao
[+#] Dot File

Miobe: Biowwses pand aptions mayp alfect whether arg gray
backgound iz prnded. See Help lod mia

Lok _J [ Cocel | [ Heo |

Figure 6.2 - Frame Display Print Dialog
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5. Select the range of frames to include All or Selection in the Frame Range section of the Frame
Display Print dialog.

Choosing All prints up to 1000 frames from the buffer.

Choosing Selection prints only the frames you select in the Frame Display window.
6. Selecting the Delete File deletes the temporary html file that was used during printing
7. Click the OK button.
Frame Display Print Preview

The Frame Display Print Preview feature provides the user with the option to export the capture buffer to an
.html file. The maximum file size, however, that can be exported is 1000 frames.

If you chose Print Preview, the system displays your data in a browser print preview display with options for
printing such as page orientation and paper size. You can also use your Printer Preferences dialog to make some
of these selections. When printing your data, the analyzer creates an html file and prints the path to the file at the
bottom of the page. This file can be opened in your browser, however, it may appear different than the printed
version.

1. Select Print Preview from the File menu on the Frame Display window to display the Frame Display
Print Preview.

2

Frame Display Print Preview

Provide information to export data from the currently selected filker tab.

Include [retail Section
| Summary Mo decode section
D ata Bytes Al layers

@ Selected layers only:

Frame Fange

S &pplication -
Al P
@ Selection SMB
SMTP e
ChAD
V| Delete Fils | Reset The Selected Layer |

Mote: Browser print options may affect whether any gray
background iz printed. See Help for info.

| Ok, | |Eance|| | Help |

Figure 6.3 - Frame Display Print Preview Dialog

2. From this point the procedure is the same as steps 2 through 5 in "How to Print Frame Display Data" above.

3. Click the OK button, and after a brief wait a browser window will appear.
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6.5.2 Printing from the Event Display

The Event Display Print feature provides the user with the option to print either the entire capture buffer or the
current selection. When Print Preview is selected, the output displays in a browser print preview window where
the user can select from the standard print options. The output file format is in html, and uses the Microsoft Web
Browser Control print options for background colors and images (see below).

Print Background Colors Using Internet Explorer
1. Open the Tools menu on the browser menu bar
2. Select “Internet Options...” menu entry.
3. Click Advanced tab.
4. Check “Print background colors and images” under the Printing section
5. Click the Apply button, then click OK
The Event Display Print feature uses the current format of the Event Display as specified by the user.

See About Event Display for an explanation on formatting the Event Display prior to initiating the print feature.

Configure the Print File Range in the Event Display Print dialog

Selecting more than one event in the Event Display window defaults the radio button in the Event Display
Print dialog to Selection and allows the user to choose the All radio button. When only one event is selected ,
the All radio button in the Event Display Print dialog is selected.

How to Print Event Display Data to a Browser

1. Select Print or Print Preview from the File menu on the Event Display window to display the Event
Display Print dialog. Select Print if you just want to print your data to your default printer. Select Print
Preview if you want preview the printin your browser.

2. Select the range of events to include from either All or Selection in the Event Range section . Choosing
All prints all of the events in the capture file or buffer. Choosing Selection prints only the selected events
in the Event Display window.

Note: Inorderto prevent a Print crash, you cannot select All if there are more than
100,000 events in the capture buffer.

Note: See "Configure the Print File Range in the Event Display Print Dialog" above for
an explanation of these selections
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Figure 6.4 - Event Display Print Dialog

3. Click the OK button.

If you chose Print Preview, the system displays your data in a browser print preview display with options for
printing such as page orientation and paper size. You can also use your Printer Preferences dialog to make some
of these selections. When printing your data, the analyzer creates an html file and prints the path to the file at the
bottom of the page. This file can be opened in your browser, however, it may appear different than the printed
version.

6.6 Exporting
6.6.1 Frame Display Export
You can dump the contents of the Summary pane on the Frame Display into a Comma Separated File (.csv).
To access this feature:
1. Right click on the Summary pane or open the Frame Display File menu.
2. Select the Export... menu item.
3. Select a storage location and enter a File name.

4. Select Save.

6.6.2 Exporting a File with Event Display Export

With the Event Display Export dialog you can export the contents of the Event Display dialog as a test (.txt),
CSV (.csv.), HTML (.htm), or Binary File (.bin). You also have the option of exporting the entire capture buffer or
just the current selection of the Event Display dialog.
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Event Display Export 29
File name:  C\Users\Frontine\D eskiophNFC - wifi B
Save az type: | C5V File [*.oev] -

Event range Side
All @ Selection Both
DTE
1 to 2000
DCE
Ewvents Per Row C5Y Headers
Multiple Events Per Row [Mo Timestamps] Show Preamble
@ Ore Event Per Row [Show Timestamps) | Show Column Headings
Help | Cancel | | Save |

Figure 6.5 - Event Display Export Example: .csv file.

How to Export Event Display Data to a File

1. Select Export Events from the File menu on the Event Display window to display the Event Display
Export dialog.

2. Enter afile path and name, or click the browser button to display the Windows Save As dialog and
navigate to the desired storage location.

3. Select a file type from the Save as type: drop-down List Menu on the Event Display Export dialog.
Select from among the following file formats:

Text File (*.txt)
CSV File (*.csv)
HTML File (*.html)
Binary File (*.bin)

4. Select the range of events to include in the file from either All or Selection in the Event Range section
of the Event Display Export dialog.

« Selecting more than one event in the Event Display window defaults the radio button in the Event
Display Export dialog to Selection and allows the user to choose the All radio button.

« When only one event is selected (something must be selected), the All radio button in the Event
Display Export dialog is selected by default.

5. Next you need to select the Side variable for serial communications.

o is used to determine whether you want to export data from , or both.

o Choose Host, Function\Control or Both to determine how you want to export the data.
5. Choose Host, Function\Control or Both to determine how you want to export the data.

6. Choose whether you want to display multiple events or single events per row.
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Events Per Row: You can choose to display Multiple Events Per Row, but this method contains no
timestamps. If you select One Event Per Row, you can display timestamps. multiple events or single
events per row.

Note: The raw timestamp value is the number of 100-nanosecond intervals since the
beginning of January 1, 1601. This is standard Windows time.

The timestamp data types displayed in columns for One Event Per Row.
Timestamp
Delta

Event Number
Byte Number
Frame Number
Type

Hex

Dec

Oct

Bin

Side

ASCII | 7-bit ASCII | EBCDIC | Baudot
RTS

CTS

DSR

DTR

CcD

RI

UART Overrun
Parity Error
Framing Error

7. If you select .csv as the file type, choose whether you want to hide/display Preambles or Column
Headings in the exported file

8. Click Save. The Event Display Export file is saved to the locations you specified in File name.
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A B 5 D E F G H | J K
1 Timestamp Delta Event Number Byte Number Frame Number Type Hex {Dec Oct Bin ASCII
632 11/30/2012 12:20:02.895166 PM  0:00:00.00 631 626 3 Data 0; 0 0 0.
633 11/30/2012 12:20:02.895166 PM  0:00:00.00 632 627 3 Data 0} 0 0 0.
634 11/30/2012 12:20:02.895166 PM  0:00:00.00 633 628 3 Data 0 0 0 0.
635 11/30/2012 12:20:02.895166 PM  0:00:00.00 634 629 3 Data 98 152 230 10011000 .
636 11/30/2012 12:20:02.895166 PM  0:00:00.00 635 630 3 Data 70{ 112 160 1110000 p
637 11/30/2012 12:20:02.895166 PM  0:00:00.00 636 631 3 Data 94{ 148 224 10010100 .
638 11/30/2012 12:20:02.895166 PM  0:00:00.00 637 632 3 Data 22{ 34 42 100010 "
639 11/30/2012 12:20:02.895166 PM  0:00:00.00 638 633 3 Data 21{ 33 41 100001!
640 11/30/2012 12:20:02.895166 PM  0:00:00.00 639 634 3 Data 1c 28 34 11100 .
641 11/30/2012 12:20:02.895166 PM  0:00:00.00 640 635 3 Data 80{ 128 200 10000000 .
642 11/30/2012 12:20:02.895166 PM  0:00:00.00 641 636 3 Data 80i{ 128 200 10000000 .
643 11/30/2012 12:20:02.895166 PM  0:00:00.00 642 637 3 Data 80i{ 128 200 10000000 .
644 11/30/2012 12:20:02.895166 PM  0:00:00.00 643 638 3 Data 80{ 128 200 10000000 .

Figure 6.6 - Example: .csv Event Display Export, Excel spreadsheet

6.6.2.1 Export Filter Out

You can filter out data you don't want or need in your text file.

(This option is available only for serial data.) In the Filter Out box, choose which side to filter out: the DTE data,
the DCE data or neither side (don't filter any data.) For example, if you choose the radio button for DTE data, the
DTE data would be filtered out of your export file and the file would contain only the DCE data.

You can also filter out Special Events (which is everything that is not a data byte, such as control signal changes and
Set I/0 events), Non-printable characters or both. If you choose to filter out Special Events, your export file would
contain only the data bytes. Filtering out the non-printable characters means that your export file would contain
only special events and data bytes classified as printable. In ASCII, printable characters are those with hex values
between $20 and $7e.

6.6.2.2 Exporting Baudot

When exporting Baudot, you need to be able to determine the state of the shift character. In a text export, the
state of the shift bit can be determined by the data in the Character field. When letters is active, the character
field shows letters and vice versa.
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7.1 System Settings and Progam Options
7.1.1 System Settings

Open the System Settings window by choosing System Settings from the Options menu on the Control
window. To enable a setting, click in the box next to the setting to place a checkmark in the box. To disable a
setting, click in the box to remove the checkmark. When viewing a capture file, settings related to data capture
are grayed out.
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Single File

-

System Settings

Capture Mode: | Single File
Hestgrt Capturing .-’:'-.fter Saving ar
Clearing Capture File
YWrap File
File Size [in k) | 81979 FIAREES

Startup...

Advanced...

Figure 7.1 - System Settings Single File Mode

This option allows the analyzer to capture data to a file. Each time you capture the file you must provide a file
name. The size of each file cannot larger than the number given in File Size (in K). The name of each file is the
name you give it in the Name box followed by the date and time. The date and time are when the series was
opened.

« Restart Capturing After Saving or Clearing Capture File

If the Automatically Restart feature is enabled, the analyzer restarts capture to the file immediately after the
file is closed.

« Wrap File

When enabled, the analyzer wraps the file when it becomes full. The oldest events are moved out of the file
to make room for new events. Any events moved out of the file are lost. When disabled, the analyzer stops
capture when the file becomes full. Either reset the file or close your capture file to continue.

o File Size: The size of the file will depend of the available hard disk space.
1. Click the Min button to see/set the minimum acceptable value for the file size.

2. Click the Max button to see/set the maximum acceptable value for the file size.
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You can accept these values, or you can enter a unique file size.
But if you try to close the dialog after entering a value greater
1 \ Eniter an integer between 1096 and 1848257, than the maximum or less than the minimum, you will see the
.

following dialog.

« Start up

Opens the Program Start up Options window. Start up options let you choose whether to start data capture
immediately on opening the analyzer.

« Advanced

Opens the Advanced System Options window. The Advanced Settings should only be changed on advice of
technical support.

7.1.1.1 System Settings - Disabled/Enabled Options

Some of the System Settings options are disabled depending upon the status of the data capture session.
o Asthe default, all the options on the System Settings dialog are enabled.

e Once the user begins to capture data by selecting the Start Capture button, some of the options on the System
Settings dialog are disabled until the user stops data capture and either saves or erases the captured data.

o The user can go into the Startup options and Advanced system options on the System Settings dialog and
make changes to the settings at any time.

7.1.1.2 Advanced System Options

These parameters affect fundamental aspects of the software, and it is unlikely that you ever have to change
them. If you do change them and need to return them to their original values, the default value is listed in
parentheses to the right of the value box.

Most technical support problems are not related to these parameters, and as changing them could have serious
consequences for the performance of the analyzer, we strongly recommend contacting technical support before
changing any of these parameters.

To access the Advanced System Options:

1. Go to the Control @ window.

2. Choose System Settings from the Options menu.

3. Onthe System Settings window, click the Advanced button.
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Figure 7.2 - Advanced System Options dialog

« Driver Receive Buffer Size in Kbytes - This is the size of the buffer used by the driver to store incoming
data. This value is expressed in Kbytes.

« Driver Action Queue Size In Operating System Pages - This is the size of the buffer used by the driver
to store data to be transmitted. This value is expressed in operating system pages.

« Frame Completion Timeout in Seconds - This is the number of seconds that the analyzer waits to receive
data on a side while in the midst of receiving a frame on that side.

If no data comes in on that side for longer than the specified number of seconds, an "aborted frame" event is
added to the Event Display and the analyzer resumes decoding incoming data. This can occur when capturing
interwoven data (DTE and DCE) and one side stops transmitting in the middle of a frame.

The range for this value is from 0 to 999,999 seconds. Setting it to zero disables the timeout feature.

Note: This option is currently disabled.

7.1.1.3 Selecting Start Up Options
To open this window:

1. Choose System Settings from the Options menu on the Control ﬁ window.

2. On the System Settings window, click the Start Up button.

3. Choose one of the options to determine if the analyzer starts data capture immediately on starting up or
not.

184 Frontline 802.11 Hardware & Software User Manual



Chapter 7 General Information TELEDYNE LECROY

Program Start Up Options @
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Figure 7.3 - Start Up Options dialog

« Don't start capturing immediately - This is the default setting. The analyzer begins monitoring data but
does not begin capturing data until clicking the Start Capture [ icon on the Control, Event Display or

Frame Display windows.

« Start capturing to a file immediately - When the analyzer starts up, itimmediately opens a capture file
and begins data capture to it. This is the equivalent of clicking theStart Capture ' icon. The file is given a

name based on the settings for capturing to a file or series of files in the System Settings window.

« Start capturing immediately to the following file: - Enter a file name in the box below this option. When
the analyzer starts up, it immediately begins data capture to that file. If the file already exists, the data in it is
overwritten.

7.1.2 Changing Default File Locations

The analyzer saves user files in specific locations by default. Capture files are placed in the My Capture Files
directory and configurations are put in My Configurations. These locations are set at installation.

Follow the steps below to change the default locations.

1. Choose Directories from the Options menu on the Control window to open the File Locations
window.
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File Locations M
File Types Location =
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Figure 7.4 - File Locations dialog

2. Select the default location you wish to change.
3. Click Modify.

4. Browse to a new location.

’
Browse for Folder ﬁ

Spedfy My Decoders directary. ..

4 | Public *
> | Desktop
4 || Public Documents
4 | Frontline Test Equipment
|| My Capture Files
| My Configurations |_

m

| My Decoders

. My Log Files
> 1 My Methods
| My Mode Databases

Figure 7.5 - File Locations Browse dialog
5. Click OK.

6. Click OK when finished.
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If a user sets the My Decoders directory such that it is up-directory from an installation path, multiple instances of
a personality entry may be detected, which causes a failure when trying to launch Frontline. For example, if an
Frontline product is installed at C:\Users\Public\Public Documents\Frontline Test Equipment\My Decoders\ then
"My Decoders" cannot be set to any of the following:

o C:\ My Decoders\

o C:\Users\ My Decoders\

o C:\Users\\Public\My Decoders\

o C:\Users\Public\Public Documents\My Decoders\

o or to any directory that already exists in the path C:\Users\Public\Public Documents\Frontline Test
Equipment\My Decoders\

Default Capture File Folder Checkbox

If the Use Last Opened Folder for Capture Files checkbox is checked, then the system automatically
changes the default location for saving capture files each time you open a file from or save a file to a new location.
For example, let's say the default location for saving capture files is Drive A > Folder A. Now you select the Use
Last Opened Folder for Capture Files checkbox. The next time, however, you open a capture file from a
different location, Folder B > Removable Flash Drive for example. Now when you save the capture file, it will be
saved to Folder B > Removable Flash Drive. Also, all subsequent files will be saved to that location. This remains
true until you open a file from or save a file to a different location.

There is one caveat to this scenario, however. Let's say you have selected Use Last Opened Folder for
Capture Files and opened a file from a location other than the default directory. All subsequent capture files
will be saved to that location. Suppose, however, the next time you want to save a capture file, the new file
location is not available because the directory structure has changed: a folder has been moved, a drive has been
reassigned, a flash drive has been disconnected, etc. In the case of a "lost" directory structure, subsequent
capture files will be saved to the default location. ComProbe software will always try to save a file to the folder
where the last file was opened from or saved to, if Use Last Opened Folder for Capture Files is checked. If,
however, the location is not accessible, files are saved to the default directory that is set at installation.

If the checkbox is unchecked, then the system always defaults to the directory listed in the File Locations dialog.

7.1.3 Side Names

The Side Names dialog is used to change the names of objects and events that appear in various displays. The
Side Names dialog will change depending on the sniffing technology in use at the time the software was loaded.

Changes to the Names are used throughout the program.
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Side Mames I&
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Figure 7.6 - Example: Side Names Where "Slave" and "Master" are current

1. To open the Side Names dialog, choose Side Names... from the Options menu on the Control
window.

2. To change a name, click on the name given in the Current Names column, and then click again to modify
the name (a slow double-click).

3. Select OK to initiate the changes. The changes that have been made will not fully take effect for any views
already open. Closing and reopening the views will cause the name change to take effect.

4. To restore the default values, click the Set Defaults button.

7.1.4 Timestamping

Timestamping is the process of precise recording in time of packet arrival. Timestamps is an optional parameter in
the Frame Display and Event Display that can assist in troubleshooting a network link.

7.1.4.1 Timestamping Options

The Timestamping Options window allows you to enable or disable timestamping, and change the resolution of
the timestamps for both capture and display purposes.

To open this window:

Choose Set Timestamp Format... from the Options menu on the Frame Display and Event Display window or
click on the Timestamping Option EE!B icon in the Event Display toolbar. The Timestamping Options window

will open.

188 Frontline 802.11 Hardware & Software User Manual



Chapter 7 General Information TELEDYNE LECROY

Timestamping Options I&
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Figure 7.7 - Timestamping Options dialog
Enabling/Disabling Timestamp

To enable timestamping click to make a check appear in the check box Store Timestamps (This time takes
effect immediately). Removing the check will disable timestamping.

Changing the Timestamp Resolution

This option affects the resolution of the timestamp stored in the capture file. The default timestamp is 10
milliseconds. This value is determined by the operating system and is the smallest "normal" resolutions possible.

Note: The raw timestamp value is the number of 100-nanosecond intervals since the
beginning of January 1, 1601. This is standard Windows time.

It is also possible to use "high resolution”

timestamping. High resolution timestamp Stare Timestamps [This item takes effect immediately)]
values are marked by an asterisk as high Capture Uptions
reSO|UtI0n |n the drOp dOWn |i5t. TO Change Stﬂ[age HESDIU“DH: |:|5|:| MiCIDSECDndS [h|gh resnlutiun] -

timestamping resolutions:

. . Maote 1: To apply resolution changes, you must restart the program.
1. Go to the Capture Options section
of the window. Mate 2 Finer resolutions increaze the capture file size.

2. Change the resolution listed in the
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Storage Resolution box.

Note: If you change the resolution, you need to exit the analyzer and restart in order for
the change to take effect.

Performance Issues with High Resolution Timestamp

There are two things to be aware of when using high resolution timestamps. The first is that high resolution
timestamps take up more space in the capture file because more bits are required to store the timestamp. Also,
more timestamps need to be stored than at normal resolutions. The second issue is that using high resolution
timestamping may affect performance on slower machines

For example, if 10 bytes of data are captured in 10 milliseconds at a rate of 1 byte per millisecond, and the
timestamp resolution is 10 milliseconds, then only one timestamp needs to be stored for the 10 bytes of data. If
the resolution is 1 millisecond, then 10 timestamps need to be stored, one for each byte of data. If you have two
capture files, both of the same size, but one was captured using normal resolution timestamping and the other
using high resolution, the normal resolution file has more data events in it, because less room is used to store
timestamps.

You can increase the size of your capture file in the System Settings.
Switching Between Relative and Absolute Time
With Timestamping you can choose to employ Relative Time or Absolute time.

1. Choose System Settings from the Options menu on the Control window, and click the
Timestamping Options button, or click the click the Timestamping Options icon ) from the

Event Display p window.

2. Go to the Display Options section at the bottom of the window and find the Display Relative
Timestamps checkbox.

3. Check the box to switch the display to relative timestamps. Remove the check to return to absolute

timestamps.

Note: The options in this section affect only how the timestamps are displayed on the screen,
not how the timestamps are recorded in the capture file.

« Display Raw Timestamp Value shows the timestamp as the total time in hundred nanoseconds from a
specific point in time.

« Display Relative Timestamps shows the timestamp as the amount of time that has passed since the first
byte was captured. It works just like a stop watch in that the timestamp for the first byte is 0:00:00.0000 and
all subsequent timestamps increment from there. The timestamp is recorded as the actual time, so you can
flip back and forth between relative and actual time as needed.

« Selecting both values displays the total time in nanoseconds from the start of the capture as opposed to a
specific pointin time.

« Selecting neither value displays the actual chronological time.
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When you select Display Relative Timestamp you can set the number of digits to display using the up or down
arrows on the numeric list.

Displaying Fractions of a Second
1. Choose System Settings from the Options menu on the Control @ window, and click the
Timestamping Options button, or click the click the Timestamping Options icon E& from the

Event Display p window.

2. Go to the Display Options section at the bottom of the window, and find the Number of Digits to
Display box.

3. Click on the arrows to change the number. You can display between 0 and 6 digits to the right of the
decimal point.

7.2 Technical Information

7.2.1 Performance Notes

As a software-based product, the speed of your computer’s processor affects the analyzer’s performance. Buffer
overflow errors are an indicator that the analyzer is unable to keep up with the data. The information below
describes what happens to the data as it arrives, what the error means, and how various aspects of the analyzer
affect performance. Also included are suggestions on how to improve performance.

The analyzer's driver takes data from the driver and counts each byte as they are put into the driver’s buffer. The
analyzer's driver tells the user interface that data is ready to be processed. The analyzer takes the data from the
driver’s buffer and puts the data into the capture buffer.

Driver Buffer Overflows occur when the user interface does not retrieve frames from the driver quickly
enough. Buffer overflows are indicated in the Event Display window by a plus sign within a circle. Clicking on
the buffer overflow symbol displays how many frames have been lost.

There are several things that you can do to try and solve this problem.

o Use capture filters to filter out data you don't need to see. Capture filters reduce the amount of data
processed by the analyzer. (Ethernet Only)

o Close all other programs that are doing work while the analyzer is running. Refrain from doing searches in the
Event Display window or other processor intensive activities while the analyzer is capturing data.

« Timestamping takes up processor time, primarily not in timestamping the data, but in writing the timestamp to
the file. Try turning off timestamping from the Timestamping Options window.

o For Driver Buffer Overflows, change the size of the driver buffer. This value is changed from the
Advanced System Settings. Go to the Control window and choose System Settings from the Options
menu. Click on the Advanced button. Find the value Driver Receive Buffer Size in Operating System
Pages. Take the number listed there and double it.

o The analyzer’s number one priority is capturing data; updating windows is secondary. However, updating
windows still takes a certain amount of processor time, and may cause the analyzer to lose data while the
window is being updated. Some windows require more processing time than others because the information
being displayed in them is constantly changing. Refrain from displaying data live in the Event Display and
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Frame Display windows. The analyzer can capture data with no windows other than the Control window
open.

« If you are still experiencing buffer overflows after trying all of the above options, then you need to use a faster
PC.

7.2.2 Progress Bars

The analyzer uses progress bars to indicate the progress of a number of different processes. Some progress bars
(such as the filtering progress bar) remain visible, while others are hidden.

The title on the progress bar indicates the process underway.

7.2.3 Event Numbering

This section provides information about how events are numbered when they are first captured and how this
affects the display windows in the analyzer. The information in this section applies to frame numbering as well.

When the analyzer captures an event, it gives the event a number. If the event is a data byte event, it receives a
byte number in addition to an event number. There are usually more events than bytes, with the result is that a
byte might be listed as Event 10 of 16 when viewing all events, and Byte 8 of 11 when viewing only the data bytes.

The numbers assigned to events that are wrapped out of the buffer are not reassigned. In other words, when
event number 1 is wrapped out of the buffer, event number 2 is not renumbered to event 1. This means that the
first event in the buffer may be listed as event 11520 of 16334, because events 1-11519 have been wrapped out
of the buffer. Since row numbers refer to the event numbers, they work the same way. In the above example,
the first row would be listed as 2d00 (which is hex for 11520.)

The advantage of not renumbering events is that you can save a portion of a capture file, send it to a colleague,
and tell your colleague to look at a particular event. Since the events are not renumbered, your colleague’s file
use the same event numbers that your file does.

7.2.4 Useful Character Tables

7.2.4.1 ASCII Codes

hes| =0 | x1 | x2 | x3 | x4 | =5 | o6 | x7 | xB | «9 | xA [ 2B | xC | =D | xE | »F
Ox |NUL|SOH| STX| ETX [ECT |[ENQIACKIBEL| BS | HT | LF [ VT | FF JCR | S0 | SI
1x |ODLE[DC1|DC2|DC3 | DCY |NAKISYN| ETB|CAM| EM |SUB|ESC]) FS | GS | RS | US
2 |SP] 1 ) #l5 | %] & ' { } G + ) - !

x| 0 1 213|456 ]|7 |88 . < | = ?

xl@ | AlBJC[DIEJF|]G|H ] J K [ LIM]IN] O

5Sx P Q R S T 0] Wl W[ X i Fi [ \ ] A

B ) E b & d a f | alh i i k I m | o

i)l p q f 3 t u ¥ | w | x ¥ z { | ] ~ |DEL
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7.2.4.2 Baudot Codes

[DEC [ HEX | LETTERS | FIGURES |
0 | 00 |BLANK (NUL)| BLANK MNUL)
1 | @ E 3
7 | o2 LF LF
ElE A :

4 | o4 SP sP
5 | 05 5 BEL
E | 06 [ B
7 | o7 1] 7
g | o8 CR CR
9 ] ] §
10 | 0A R 4
i1 | 08 J :
[FE N .
13 | 0D F I
14 | O C :
15 | OF K {
16 10 T 5
17 1 Fd -
18 | 12 L ]
19 | 13 ] 2
20 | 14 H #
21 | 15 ] 3
2 | 18 P 0
el EE Q 1
24 | 18 Q g
25 | 19 B H
% | 1A G L
27 | 18 | FIGURES | FIGURES
28 1C M
29 10D X /
2 | 1E v .
31 | IF | LETTERE | LETIERS

7.2.4.3 EBCDIC Codes

hex] x0 | x1 | 52 | %3 | x4 | x5 | a6 | %7 | %B | «3 | xA | B | xC | %D | xE | sF
Dx | WUL|SOH] S| ET¢| PF | HT | LC |DEL SHMM YT [FF JCRI SO ([ S
1 JOLE(DCIIDC2) TM |RES| NL | BS | IL |CAMIEM | CC |CUT|IFS JIGS | IRS | IUS
2x | DS |S08]| FS BYF| LF |ETB|ESC S | CU2 |ENG|ACK[BEL
3x SYM| PN | RS | UC |EOT CU3 | DCA |NAK SUB
4x | 3P . < { +

Sx | & ! 2 1 i .

By | - ! | HE » [ ?

7x : # | @ = "

Bix 3 b C d | & flalh i

Gx i k | m o |l pl g r

A = 5 t u w | x ¥ 2 |

B |

Cx|l { |AlBJC]DIJEJF|G|H I

D]l 1 |J I K] L|M|N[O|P|O|R

Ex | S|ITlIUlVvIW]|X|Y]|Z

Fx| D 1 2134|567 |89

7.2.4.4 Communication Control Characters

TELEDYNE LECROY

Listed below in alphabetical order are the expanded text meanings for common ANSI communication control
characters, and two-character system abbreviation for each one. Some abbreviations have forward slash
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characters between the two letters. This is to differentiate the abbreviations for a control character from a hex
number. For example, the abbreviation for Form Feed is listed as F/F, to differentiate it from the hex number FF.

Table 7.1 - Communications Control Characters

Abbreviation | Control Character Text
AK ACK Acknowledge
BL BEL Bell
BS BS Backspace
CN CAN Cancel
CR CR Carriage Return
D/1-4 DC1-4 Device Control 1-4
D/E DEL Delete
DL DLE Data Link Escape
EM EM End of Medium
EQ ENQ Enquiry
ET EOT End of Transmission
E/C ESC Escape
E/B ETB End of Transmission Block
EX ETX End of Text
F/F FF Form Feed
FS FS File Separator
GS GS Group Separator
HT HT Horizontal Tabulation
LF LF Line Feed
NK NAK Negative Acknowledge
NU NUL Null
RS RS Record Separator
SI SI Shift In
SO SO Shift Out
SH SOH Start of Heading
SX STX Start of Text
SB SuUB Substitute
SY SYN Synchronous Idle
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Table 7.1 - Communications Control Characters(continued)

Abbreviation Control Character Text
us us Unit Separator
VT VT Vertical Tabulation

7.2.5 DecoderScript Overview

The main purpose of this manual is to describe DecoderScript™, the language used in writing decoders.
DecoderScript allows you to create new decoders or modify existing decoders to expand the functionality of your
ComProbe protocol analyzer. DecoderScript displays protocol data, checks the values of fields, validates
checksums, converts and combines field values for convenient presentation. Decoders can also be augmented
with custom C++-coded functions, called "methods", to extend data formatting, validation, transformations, and so
on.

A decoder defines field-by-field how a protocol message can be taken apart and displayed. The core of each
"decoder" is a program that defines how the protocol data is broken up into fields and displayed in the Frame
Display window of the analyzer software.

This manual provides instruction on how to create and use custom decoders. When reading the manual for the
first time, we encourage you to read the chapters in sequence. The chapters are organized in such a way to
introduce you to DecoderScript writing step- by- step.

Screenshots of the ComProbe protocol analyzer have been included in the manual to illustrate what you see on
your own screen as you develop decoders. But you should be aware for various reasons, the examples may be
slightly different from the ones that you create. The differences could be the result of configuration differences or
because you are running a newer version of the program. Do not worry if an icon seems to be missing, a font is
different, or even if the entire color scheme appears to have changed. The examples are still valid.

Examples of decoders, methods, and frame recognizers are included in this manual. You can cut and paste from
these examples to create your own decoders.

A quick note here: Usually the pasted code appears the same as the original in your editor. Some editors,
however, change the appearance of the text when it is pasted (something to do with whether it is ASCIl or
Unicode text). If you find that the pasted text does not appear the same as the original, you can transfer the code
into a simple text editor like Notepad, save it as an ANSI (ASCII) file, then use it in your decoder.

These files are installed in the FTE directory of the system Common Files directory. The readme file in the root
directory of the protocol analyzer installation contains a complete list of included files. Most files are located in My
Decoders and My Methods.

We will be updating our web site with new and updated utilities, etc, on a regular basis and we urge decoder
writers to check there occasionally.

7.2.6 Bluetooth low energy ATT Decoder Handle Mapping

Low energy device attributes contain a 16-bit address called the attribute handle. Each handle is associated with
an attribute Universally Unique Identifier (UUID) that is 128-bits long. In the attribute database, the handle is
unique while the UUID is not unique.

The ComProbe software detects and stores the relationships (mappings) between handle and UUID during the
GATT discovery process. But sometimes, there is no GATT discovery process because
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« The discovery has previously taken place and both devices stored the mappings and the discovery will not
repeat at every subsequent connection.

« The developer owns both devices in the conversation and chose to ignore discovery because the mappings
are known.

e The devices are in development and the code to perform the mappings has not been written yet.
The solution to this problem is to
1. define the mappingsin a file and
2. then pre-loading the mapping using the ComProbe software.
Creating handle-UUID mapping file

Create a file named "ATT_Handle_UUID_Preload.ini' in the root directory of "C:\Users\Public\Public
Documents\Frontline Test Equipment\My Decoders\", but the file can be located anywhere.

Assume that you want to create a GATT service starting at handle 1.
Create a section in the ini file called

[Service Base Handles]
A=1

"A" will be your first service. Make the base handle equal to the handle of your service. You can use all upper and
lower case letters so you can have up to 52 service handles.

Next add the following section.

[Advertiser Handles]

; Generic Access Profile (GAP)
A0 = 1800

A1=2803

A2 = 2a00

A3 =2803

A4 = 2a01

A5 = 2803

A6 = 2a04

A few things of note:
« Inthe code above, lines begging with a semi-colon are comments.
« If you want to change the base handle of the GAP service, change the "1" to some other number.

« If you want to comment out the entire service, comment out the base handle. If no "A" is defined, the
software will ignore "A1", "A2" and so on.

Contacting Technical Support

Technical support is available in several ways. The online help system provides answers to many user related
questions. Frontline's website has documentation on common problems, as well as software upgrades and utilities
to use with our products.

On the Web: http://fte.com/support/supportrequest.aspx

Email: tech_support@fte.com
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If you need to talk to a technical support representative about your Frontline 802.11 product, support is available
between 9 am and 5 pm, U.S. Eastern Time zone, and between 9 am and 5 pm, Pacific Time zone, on Monday
through Friday. Technical support is not available on U.S. national holidays.

Phone: +1 (434) 984-4500
Fax: +1 (434)984-4505
Instructional Videos

Teledyne LeCroy provides a series of videos to assist the user and may answer your questions. These videos can
be accessed at fte.com/support/videos.aspx. On this web page use the Video Filters sidebar to select
instructional videos for your product.
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A.1 ComProbe Automation Server: Why use it?

."~‘ TELEDYNE LECROY

Everywhereyoulook

Frontline provides a full line of wireless sniffing devices for /oo

developers that include ComProbe BPA 600 for e

Bluetooth® Classic, low energy, and coexistence; e e

ComProbe 802.11 for Wi-Fi and Bluetooth coexistence.
Normal ComProbe protocol analyzer use is through a GUI
on a personal computer In this operation mode the user
has direct control of the setup and data capture through
the keyboard and mouse. User specific ComProbe
analyzer configuration and capture decisions may come
from user prescribed test documents or applied ad hoc or
on-the-fly.

The ComProbe software GUI is sufficient for many
development projects. But situations may arise where a
more automated process is desirable. For example, if a
company wants to ensure exact test processes,
automating those processes is one answer. When testing

Figure 1 - ComProbe GUI

multiple devices long test runs can occur, and automating can free up personnel to perform additional tasks. This
is a list of possible situations when automation would improve testing and developments operations and save

money.

o Automate long test runs — free up personnel for other tasking or run overnight.

« Automatic bookmarking capture data for specific events — helps developers focus on specific rest results.

« Automatic adherence to test procedures — ensures test repeatability and eliminates human error.

o Automatic exporting captured data — extracting specific data for post testing analysis outside of the ComProbe

software, e.g. export to CSV.

« Automate other Windows — based applications while capturing data — for example, controlling other testing

equipment related to the test.

« Automate regression testing.
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The larger your task size the more benefit realized in cost avoidance and efficient resource usage through
automation of the Frontline ComProbe protocol analyzers. The extra effort to program the test automation is
minimal compared to the time saved to manually test.

Frontline's Automation Server provides the means to programmatically control ComProbe software and hardware
in a client-server configuration. The Automation Server is provided when you purchase your ComProbe analyzer,
and is stored in the Frontline ComProbe Protocol Analysis System directory. The ComProbe Automation Server
Protocol Programmers Guide is located in this same directory. The process for automating your data capture is
accomplished in three steps.

1. Connectthe ComProbe hardware to a computer running ComProbe software and the Automation Server.

2. Launch the Automation Server program. The program will listen to the commands from the Automation
Client program and according control the ComProbe software.

3. Write your Automation Client program (use the template provided with the installation package) and run
it.

As long as there is no change in the programmed capture process, step 3 can be repeated reliably and without
deviation. Should the test plan change, the program written in step 1 can serve as a template to minimze
development timeand to provide quality control tracability.

A.1.1 Automation Server Topology

The Automation Server executes the commands issued by a user-created
Automation client script. The client script can run either on the local PCor on |
aremote over a TCP/IP connection. The Automation Client program can be

written in any language and uses the syntax defined in the ComProbe

Automation Server Protocol Programmers Guide. The client will bypass the PC
local Microsoft Windows interface and interacts directly with ComProbe

software. One or more instances of the ComProbe software must be running

along with one instance of the Automation Server.

- Figure 2 - Automation Server on a
Jow Lo a0 Serven el ..‘JI (R T I 'y

P Single PC

ComProke hardware

Figure 3 - Automation Server Using Two PCs

A.1.2 Writing Automation Script

Automation scripting is done by persons with knowledge of TCP socket communications. The process automation
is achieved by writing a client application which talks over a TCP network socket connection with the ComProbe
Automation Server.

Delivered in your ComProbe installation package is a sample script SampleClient.tcl. This script is located in your
installation directory. This is typically located at C:\Program Files (x86)\Frontline Test System II\Frontline
ComProbe Protocol Analysis System [your version]\Development Tools\. On 32-bit Windows or Windows XP the
root installation folder is "C:\Program Files\".
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The sample script is written in TCL (Tool Command Language). TCL is an open-source, cross-platform programming
language. More information is available at www.tcl.tk. The script can be translated to any general purpose
programming language such as C# as long as you retain the program structure.

The sample script is divided into the
following sections identified by FEEE 35414 R E 4R R R EEE S REEER R EA RS EEEH AR ERHEE
o # Procedures
comments "#". FEEEEEEE AR AR R R IR E AR F R AR LR R ERL SRR AR R R 20202
1. Procedures
2. Command Wrappers
3. FTE_Base namespace vars
4. Start of Sample Script
Do not change any scriptin Procedures and Command Wrappers.

FTE_Base namespace vars Modifications

In the "FTE_Base namespace vars" section you will need to identify the connections for the host and the port.
Near the top of this section locate the following code at or near line number 747 - 748.

set Connections(Host) 0.0.0.0;
set Connections(Port) 22901;

For the Host, change 0.0.0.0 to the IP address of the computer running Automation Server. For example
192.168.10.94.

For the Port number, the default is set to 22901, which is not a common TCP port. It is unlikely that another
application is using this port, so you can leave the Port set to default 22901.

Note: Before launching the Automation Server, the IP address and IP port—the same as the
script Host and Port values—must be modified in the XML configuration file
FTSAutoServer.exe.config. This file is located in C:\Program Files\Frontline Test System
I\Frontline ComProbe Protocol Analysis System [your version]\Executable\Core\ directory.
The code to modify is <add key="IPAddr" value="0.0.0.0"/> and <add key="Port"
value="22901"/>

Start of Sample Script Modifications

This section is the main part of the program and several lines in the template need to be changed to support your
unique data capture environment. First at or around line 792 we need to input the Host IP address again. Locate
the following code and enter your Host IP address. FTEBaselnit is a procedure that sets up the TCP connection.

FTEBaselnit 192.168.0.90

At or around line 803 change "13.1.830.1052" in the following code to the version of your ComProbe software.
The version number can be found listed with your Frontline installation directory at C:\Program Files
(x86)\Frontline Test System II\. CPASVersion is a varible used in the program to locate your installed version of the
ComProbe software.

set CPASVersion "C:\\Program Files\\Frontline Test System [I\\Frontline ComProbe Protocol Analysis
System 13.1.830.1052\\Executables\\Core"

Lastly, you need to identify the "personality" of the ComProbe hardware. On or about line 823 you will change the
following code to replace the text within the quotes with the personality key that matches your sniffing hardware
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configuration. Within the sample script are a few examples of commonly used personalities or "profiles". The
Programmers Guide provides a complete list of personalities.

set Profile "BPA600_Coex"

This code is the personality for using a ComProbe BPA 600 for Classic Bluetooth and a ComProbe 802.11 for Wi-Fi
with the software operating in Coexistence View. If you wanted to use just the ComProbe BPA 600 for captureing
Classic Bluetooth and Bluetooth low energy then you would change the value in quotes to "BPA600".

Having made these changes to the sample script template you are ready to capture data using your client-server
configuration, TCP connection, and capture hardware. At this point you shouild save the sample script as your own
template. As long as you maintain this test setup you will not need to change these settings making your unique
template reusable. However you may want to build a library of templates to cover a variety of automation
configurations. Once your unique template is coded you will find that development time for variations to the
template is insignificant.

In the next section we will step through the remainder of the sample script program to show how the Automation
Server converts the sniffing process to a largely self -acting process.

A.1.3 Running Automation Server Script

In this section we will make a comparison between the main program code and the manual operation at the GUI
in a sniffing and capture session. This approach will show that the Automation Server will duplicate the manual
processes but automation offers reliable repetition of those manual process and will save time in development
and regression testing.

Note: Note that this is sample script and that you will have to change the code in the main
program to suit your specific sniffing and capture needs. The command set is outlined in the
Programmers Guide in Chapter 3.

On or about line 824 of the sample script you will see the following code. StaertFTS tells the
Automation Server to launch the ComProbe software by opening your version of Frontline
ComProbe Protocol Analysis System and to use a specific personality. '

iasnilisge
StartFTS [format "%s;%s" $CPASVersion $Profile] “m}ﬁ“
In the code above from the sample script SCPASVersion was defined at line 803, and the S$Profile ';g;ﬂ”m

SLEMT
was set at line 823 to use ComProbe BPA 600 and ComProbe 802.11 in coexistence. This is “‘”ﬁfm‘“’

equivalent to 1) double clicking on the Frontline desktop folder and starting the software and 2)
selecting a capture method.
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Select Data Capture Method....

| =

-4 HCI - HE
43 HCI - BCSP

48 HCI - H4
-4 HCI - H4DS
48 HCI - HE

-4 H5U

-4 H5L
A MW W2

AN MWS W2

=43 Multiple Technologies Aogregated

-4 B02.11 AMP

{:’ 80211 AMP, Interlaced Page Scan
4B 80211 and NFC

-4 802711 and 5D

4B 80211 and USE

{:’ 30211, Interlaced Page Scan

48 80211, 5D and USE

{:’ 802.11/Eluetacth Coexistence

{:’ Bluetooth Classic/LE [BPA 500) & 802,11
{:’ Bluetooth Claszic/LE [BPa 500] & NFC
{:’ Bluetaath Classic/LE [BPA 500) & USE
a Bluetooth Clazsic/LE [BPA BOOD) & 802,11
{:’ Bluetooth Classic/LE [BPa B00] & NFC
{:’ Bluetaath Classic/LE [BPA B00) & USE
{:’ Twao 80211 and One BFA 500

{:’ Twio 80211 and One BFA GO0

m

] [ Cancel ] [ Help ]

Requires ane CamProbe BPA 600 hardware and one ComProbe 802,11
hardweare.

For Clazzic/low energy/202.11 coexiztence analysis.

Captures Bluetooth Clazsic, low energy and 802,11 data and dizplays in
the Frame Dizplay and Coexistence Yiew.

BOZ. 11 &/kfR/n PRCTODOL ARMYIER

L] ouT

DIEMAL L3 use POWER

[ Create Shortcut wWhen Fun

Figure 4 - SProfile = BPA600_Coex", BPA600 and 802.11 in Coexistence

Moving to line 831 in the sample script we see a configuration setting command for the ComProbe BPA 600. The

only parameters shown in this code are the address of the Master and Slave devices. If other parameters are
omitted from the code the default values are selected. This line of code is equivalent to setting the BPA 600

datasource for Classic Bluetooth.

ConfigSettings [format "IOParameters;BPA600; Master=0x00025b01cb8b; Slave=0x00025b01cbe1"]

Frontline 802.11 Hardware & Software User Manual

206



TELEDYNE LECROY Appendicies

ﬁ BPA 600 datasource =
File View BPAG00 Help

@ UBDIEHO

Devices Under Test | Device Database I LE Device Database | BPA 600 Information

(71 LE Only (@) Classic Only Single Connection () Dual Mode () Classic Only Multiple Connections

E Clagsic Device: (x703=2ac1ladbc) John Trinkle.. s if

Stopped LE Device: |(Ix703eac11adbc) John Trinkle. s it
Classic Device: (1000250020} UGO. -
Classic Encryption LE Encryption
Enter Mew Long Tem Key:
|Link Key -
Enter New Value: Enter New PIN/OOB data:
Cumrent Link Key: Cument Long Tem Key:

E

(o) ©

Clear

Figure 5 - ConfigSettings equivalent: ComProbe BPA 600 Configuration Settings Dialog
Similar ConfigSettings code will appear in the sample script for the ComProbe 802.11.
At line 853 the StartSniffing command appears. This is equivalent to clicking the Start Sniffing button @ o the

BPA 600 datasource toolbar. Start Sniffing will start synchronization of the BPA 600 with the Bluetooth Devices.
Once synchronization is acheived the arrow between the Classic devices will turn green with the arrow head
point to the master device.

StartSniffing
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Note: StartSniffing is unique to Bluetooth ComProbe devices, and it will automatically
execute the Automation Server StartCapture command once synchronized. For non-Bluetooth

devices use the StartCapture command that is equivalent to the Start Capture button @ in

the Control window.

At line 874 the following code will halt the capture after 10 seconds. This bit of code illustrates the control that
you can have over the capture process.

after 10000

At line 879 we have another Bluetooth-unique command that stops the sniffing and is equivalent to clicking the
Stop Sniffing button [ on the BPA 600 datasource.

StopSniffing

Here is one of those Bluetooth-unique situations. At line 889 the Stop Capture command is issued. Unlike the Start
Sniffing command , the Stop Sniffing command does not automatically execute the Stop Capture command so it
must be in the program if using ComProbe Bluetooth hardware. Stop Capture will stop the capture of data. This
command is equivalent to clicking on the Stop Capture button[] on the Contrtol window.

StopCapture
&3 ComProbe Protocol Analysis System - BPA 600 = P
File View Live Options Window Help

Z00HYPEEHIBMUYLS L wmB 6

Configuration: ; Bluetooth low energy

Capture Status: @) Not Active (Capture to Single File) NfA used Packets on hyw: 0 Events: 0 0% Slave 0% Master Events: 0
For Help Press F1

Figure 6 - BPA 600 Control window; Stop Capture is to the right of the red button.

At the end of the program you will want to stop the ComProbe software, so at line 900 we have the following
code.

StopFTS

Finally good programming housekeeping dictates that you should clear all connections. The following procedure
will disconnect the client-server and breakdown the TCP connection.

FTEBaseCleanup

This section has hit only the highlights of the sample script, but it has illustrated the connection between
Automation and the manual sniffing and capture of data. Your programs may be more detailed and will certainly
use many more commands. Refer to the ComProbe Automation Server Protocol Programmers Guide for more
information on the command set.

A.1.4 Saving Automation Captured Data

The Automation Server sample script gives you a building block for building your ComProbe hardware and
software sniffing and data capture process. Of course the primary purpose for using ComProbe products may be
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to analyze the captured data to solve design and development issues, and to test your products. The sample script
does not provide sample code for the saving and exporting of the captured data.

The Save Capture command is equivalent to clicking on the ComProbe software Control window File menu
Save selection. The Save selection opens a Save as dialog where you would enter the location and file name for
your capture data—a .cfa file. The Save Capture command contains parameters that perform the same operation
only automatically.

Save Capture;c:Users\Public\Public documents\Frontline Test Equipment\My Capture Files\mycap.cfa

&) ComProbe Protocol Analysis System - BPA 600 l = -S_."h]

1m’iew Live Options Window Help

Open Capture File... Ctrl+0 $ I_l Hl

Close

Save Ctrl+5  BcCapture-2014-04-28_080138.cfa

1 Capture-2014-04-28_080138.cfa : 0 Utilization: 0% Slawe 0% Master Ewvents: 1

2 Lumia-SamsungWEP469-SCO- details-2.cfa cooliino i i #) - 100%

Figure 7 - ComProbe Software File Save

Save Capture command will save the entire capture file, which can be reloaded into the ComProbe software for
later analysis. To reload the capture file you use the Automation Server Open Capture File command that has
similar parameters to the Save Capture command.

Open Capture File;c:\Users\Public\Public documents\Frontline Test Equipment\My Capture
Files\mycap.cfa

While the Save Capture automatically archives everything that happened during the capture session your may
want to write a script that focuses on specific protocols. To do that you use the Automation Server Export
command that tells ComProbe software to invoke the Frame Display and then automatically selects the File
Export menu option. In the example code below the data is exported to the identified path/file, is waiting for the
frame to complete, and is selecting the 802.11 MAC protocol tab..

Export;c:\Users\Public\Public documents\Frontline Test Equipment\My Capture
Files\mycap.csv;Mode=0;Tab=802.11:802.11 MAC

&) Frame Display - NFC - Wifi.cfa

File Edit View Format Filter Bookmarks Options Window Help

@ ~ “3l i

AR A AT T T

- Frame 1: Len=304 - - P -

i [ \ Find: -

In]mfi=] QD R,
- Header Size: 42 =|| Unfiltered ] Configured BT low energy devices ] Data ] Emors 1
-~ Data length: 255 802.11 Radio ]Lu: B02.2 | SNAP | IP¥4 | 802.1X | IPX SPX | Data |
- Channel Frequency [MHz] 2422
- Channel Mumber: 3 B.. Frame#f 55l Type Subbype  Seqh Addre...  Receive Addr Trar
- phannel Tape: 85211 1 3% Mgt Beacon 745 IBSS MMM DA Cise
- Hardware Clock: D+0000000000330545 3 gi mgm: gea“'” ;:g :ggg g:mm”i [gi] Ef“
-~ Radio Clock: 0422315034 am sacan AR DA] - Cise
 Antenna O Control Charmel RS 32 4 5 Mgt Beacon 748 IBSS  GRFEERFF (DA)  Cisc

5 28 Data QoS5 M. 2778 TodP  Cisco-linksys, L., Intel

-~ Antenna 1 Control Channel BS51: 26

Figure 8 - Export Command equivalent: Frame Display 802.11 MAC tab selected
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Refer to the ComProbe Automation Server Protocol Programmers Guide for detail of the Export command Mode
and Tab parameters.

Export provides you with the ability to automatically save specific protocol data that may be the focus of your
analysis. The exported file is saved as a comma separate value (.csv) file type. This file may be opened for later
analysis in any application that supports .csv format such as Micosoft Excel or Access.

A.1.5 Keeping Track of Events

Automation Server Add Bookmark command will automatically add a book mark to the last frame currently in the
capture buffer.

Consider this scenario. You have set up your automation script but you want to keep track of the specific events,
for example when you start streaming music from your smart phone to a Bluetooth speaker. The

Add Bookmark;String=StartMusicStream

In this scenario the Add Bookmark command may be used with TCL conditional statements to detect and guide
the event actions. The string parameter will be the name on the bookmark for your saved or exported data
capture. When analyzing the automated capture session at a later date you can use the bookmark to localize your
analysis to the event.

A.1.6 Automation Can Save Time and Money

In a carefully considered design, development, or testing environment automation of wireless sniffing and data
capture can save time and money. The Frontline Automation Server gives you the means to save time by ensuring
process are reliably reproduced. This is especially true for situations when you want to run the identical tests on
several products or versions of a product. Being able to compare captured data across design versions is
enhanced when you can run exactly the same process.

Up-front automation script development time is a consideration when setting up an automated sniffing process.
The ComProbe Automation Server Protocol Programmers Guide is delivered with your installation package, and
the latest version is always available for download on FTE.com/support/documents in ComProbe Automation.
Should you need additional assistance with the Automation Server, contact Frontline's technical support team.

Copyright 2017 Frontline Test Equipment, Inc.
Author: John Trinkle

Publish Date: 8 May 2014

The Bluetooth SIG, Inc owns the Bluetooth word mark and logos, and use of such marks is under license.
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